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Preface

Preface

Thank you for purchasing your Topcon receiver, survey product or
accessory (the “Product”). The materials available in this manual (the
“Manual”) have been prepared by Topcon Positioning Systems, Inc.
(“TPS”) for owners of Topcon products. This Manual is designed to
assist owners with the use of software (the “Software”) to be used
with the Product and its use is subject to these terms and conditions
(the “Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE Please study this manual carefully. The benefits this product
provides can be greatly influenced by your applications knowledge.
Always wear the required safety attire (safety shoes, hard hat, etc.)
when operating or around equipment.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your Product. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.

P/N 31-000004-01 vii
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TRADEMARKS HiPer®, Topcon® and Topcon Positioning
Systems™ are trademarks of TPS. Windows® is a registered
trademark of Microsoft Corporation. Product and company names
mentioned herein may be trademarks of their respective owners.

DISCLAMER OF WARRANTY EXCEPT FOR ANY WARRANTIES
IN A WARRANTY CARD ACCOMPANYING THE PRODUCT,
THIS MANUAL, THE PRODUCT, AND ANY ACCOMPANYING
SOFTWARE ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL,
THE SOFTWARE, OR THE PRODUCT. SUCH DISCLAIMED
DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF
TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT,
SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT’S USE.
IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR
DAMAGES OR COSTS INCURRED IN CONNECTION WITH
OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE,
CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER
COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY
FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE
FOR THE PRODUCT.

LICENSE AGREEMENT Use of the Software and any other computer
programs or software supplied by TPS or downloaded from a TPS
website (the “Software”) in connection with a Topcon Product
constitutes acceptance of these Terms and Conditions in this Manual
and an agreement to abide by these Terms and Conditions. The user is
granted a personal, non-exclusive, non-transferable license to use
such Software under the terms stated herein and in any case only with
a single Product or single computer. You may make one (1) backup
copy of the Software. Otherwise, the Software may not be copied or
reproduced. You may not assign or transfer the Software or this
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Terms and Conditions

license without the express written consent of TPS. This license is
effective until terminated. You may terminate the license at any time
by destroying the Software and Manual. TPS may terminate the
license if you fail to comply with any of the Terms or Conditions. You
agree to destroy the Software and manual upon termination of your
use of the Product. All ownership, copyright and other intellectual
property rights in and to the Software belong to TPS. If these license
terms are not acceptable, return any unused Software and the Manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat Confidential
Information of TPS with a degree of care no less stringent that the
degree of care you would use in safeguarding your own most valuable
trade secrets. Nothing in this paragraph shall restrict you from
disclosing Confidential Information to your employees as may be
necessary or appropriate to operate or care for the receiver. Such
employees must also keep the Confidential Information confidential.
In the event you become legally compelled to disclose any of the
Confidential Information, you shall give TPS immediate notice so
that it may seek a protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
License Agreement, Disclaimer of Warranty and limitation of
liability).

SAFETY Improper use of a Topcon Product can lead to injury to
persons or property and/or malfunction of the Product. The Product
should only be repaired by authorized TPS warranty service centers.
Users should review and heed the safety warnings in the manual
accompanying the Product.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.
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About This Manual

Welcome to the PC-CDU Reference Manual.

This manual explains how to install, set up, and use the PC-CDU
software. For best performance of this software, please read all of the
instructions carefully. They were especially designed to help you
correctly install and operate this program. This manual assumes that
you are familiar with GNSS and also have some knowledge of
working with TPS receivers.

The information contained in this manual applies to both PC-CDU
MS and PC-CDU Lite; however, there are some features unique to
PC-CDU MS. For more information about the differences between
the two versions, see “PC-CDU MS and PC-CDU Lite” on page 1-2.

Symbols and Typographic
Conventions

This manual uses the following text conventions.

Example Description

File » Exit Click the File menu and click Exit.

Satellites Indicates the name of a dialog box or screen.

clock offset Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.

Internal Press or click the button or key labeled Internal.

Ctrl+V Indicates shortcut/hot key combinations to press.

Temp Indicates string information (for example, file and

directory names) and operator commands.

The following visual cues describe certain types of information
throughout the manual.

Further information to note about the configuration,
maintenance, or setup of a system.
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About This Manual

Supplementary information that can help you
configure, maintain, or set up a system.

on system operation, system performance,
measurements, or personal safety.

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

=
% Supplementary information that can have an affect

Notification that an action will result in system
damage, loss of data, loss of warranty, or personal
injury.

Screen Captures

This manual includes sample screen captures. Your actual screen can
look slightly different from the sample screen due to the connected
receiver, operating system used, and specified settings.

P/N 31-000004-01 Xi
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Manual Organization

The manual is divided into four chapters and five appendixes. The
table of contents and index provide manual navigation.

Chapter 1: Introduction
* Tells the user about purposes and features of the program.

» Explains how to install and remove PC-CDU. Also provides
information about system requirements and differences
between PC-CDU MS and PC-CDU Lite.

* Shows how to launch and close the program.
Chapter 2: PC-CDU Getting Started

Provides a list of configuration procedures most likely to be
used.

Chapter 3: PC-CDU Software Reference
¢ Describes the content of the main window.

* Provides information describing each tab, field and control
you can access via the program interface.

Chapter 4: Troubleshooting

Helps you in diagnosing, correcting and avoiding problems,
as well as contacting TPS customer support for further help.

Appendix A: PC-CDU Scripts

Introduces readers to the PC-CDU scripts and describes how
to use them.

Appendix B: Settings List
Provides complete list of settings supported PC-CDU.
Appendix C: Installing and Updating the TPS USB Driver

Provides procedures for installing and updating the TPS USB
driver on various operating systems.

Appendix D: Output Period Setup Wizard

Presents the Output Period Setup Wizard, which is used to
adjust the periods for generating raw data and position.

Appendix E: Satellite Navigation Status Codes
Shows the list of available satellite navigation status codes.
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Supplemental Documentation

The table below lists other the manuals that can be useful while using
for configuring a receiver.

For... Read This Document

In-depth information about the GPS Receiver Interface Language
interface language used for managinga | (GRIL) Reference Manual
TPS receiver

A description on how to install/update | FLoader User’s Manual
the firmware in a TPS receiver

A description on how to configure the BTCONF User’s Manual
Bluetooth wireless technology module
in a TPS receiver

A description on how to configure the Modem-TPS User’s Manual
radio modem in a TPS receiver

Operational and procedural The TPS receiver’s Operator’s Manual
information on the TPS receiver

These manuals are available on the GPS+ CD (except the receiver’s
manual) or the TPS GPS website. Note that the GRIL Reference
Manual requires password access: contact TPS for details.
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Notes:
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What's New

What's New with
PC-CDU

The following lists what’s new with PC-CDU as of the publication of
this manual.

= The layout of the Base tab for receiver configuration has changed.
For details on the fields in this tab, see “Base” on page 3-40.

Eﬂ Receiver Configuration @

Gieneral | MINTER | Fsitioning Fiover | Ports | Events | Advanced |

Base Station Coordinates
Py N —— Lat [55 "[43 " [2106536 "[W =]  Get from receiver
" Antenna Reference Point Lnn-lﬁ‘lﬁ' 02458 "[E
Antenna Type: [TPSGR_3 v| At [1e5aaT
RTCM Settings CMR Seltings

Antenna
StationiD:|0 Seral#: | Station 1D: [0 Motian : [Unknawn ]
Hes: |Good =] Setup ID: o | oGa |
Mas. number System Used Lergin: |
of Satelites - |? ¥ GFS ¥ GLONASS GLONASS message T =
Pseudoangs Measurements Sent Measurements Sent
smaathing I & catt Pl @ P2 @ Ca/ll © P W OPAZ

Configuation of Fieceiver Farts |

Ficfiesh tppl |

[il3 Bt | Save | et al parameters to defaults |

= The layout of the WASS/EGNOS tab for positioning
configuration has changed. For details on the fields in this tab, see
“Positioning” on page 3-34.

wass |
¥ Channel 1

setwisas: 120 3| asGPs: |1 %

Interpret message #0 as message: £ [0 =
Use lona Corrections : ¢ Maver © Ifexist & Only

[120 2] aseps: [T 2]

Interpret message #0 as message: £ [0 =
Use lona Corrections : ¢ Maver © Ifexist & Only

¥ Channel #

[ Enable output of “trug" WaAS PRN numbers
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Chapter 1

Introduction

PC-CDU™ js a comprehensive Windows® software product
designed for controlling GPS+ receivers developed by TPS. PC-CDU
uses the GPS Receiver Interface Language (GRIL) to configure
various receiver settings and diagnose receiver performance.

PC-CDU MS (as of the publication of this manual) provides the
following functions:

» Connecting a TPS receiver and a computer via serial, parallel,
USB or Ethernet ports (Direct Connection Mode).

* Internet Server and Internet Client features that provides remote
access to a TPS receiver. These features work when running
PC-CDU in Internet Server Mode or Internet Client Mode on a
computer connected to the Internet.

 Tracking the total number and status of all visible satellites.

* Displaying the receiver’s current position and time in real time.

* Controlling the recording of raw data measurements into the
receiver’s internal memory.

* Downloading collected raw data measurements (log files) from
the receiver’s internal memory onto the computer’s disk drives.

* Recording, in real time, the receiver’s raw data measurements on
the computer’s disk in TPS and RINEX formats. To generate
RINEX files, the executable file “tps2rin.exe” must also be
installed on your computer.

* Displaying, in real time, a graph of the receiver’s current position
and the satellite sky plot.

* Displaying and programming the receiver’s settings (such as Data
Recording Interval, Position Computation Mode, etc.).

* Displaying the current receiver options and loading an Option
Authorization File into the receiver.

* Creating and uploading configuration script files to the receiver.

P/N 31-000004-01 11
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PC-CDU MS and PC-CDU Lite

PC-CDU exists in two implementations: a full-functionality version
called PC-CDU MS and a reduced-functionality version called
PC-CDU Lite. Table 1-1 lists the differences between PC-CDU MS
and PC-CDU Lite.

Table 1-1. Differences Between PC-CDU MS and PC-CDU Lite

Function PC-CDU MS PC-CDU Lite
Remote connection to a receiver via the yes no
Internet
Direct connection to a receiver via an yes no
Ethernet port
Record data on a PC’s disk drive in real yes no
time (“Real-Time Data Logging”)
Graphical presentation of the receiver’s yes no
current position & the satellite sky plot

PC-CDU MS may have a limited lifetime as a full-functionality tool.
After the current version of PC-CDU MS expires, its extended
functions are automatically disabled so that PC-CDU MS turns into
PC-CDU Lite. Table 1-2 provides a more detailed description of the
different scenarios available.

Table 1-2. PC-CDU MS Authorizations

If the Firmware And the

Version Installed on Connected Then...

the Receiver Is... Receiver Is...

2.3 or newer Authorized PC-CDU MS will never expire
and will always work as MS (full
functionality) when connected to
this authorized receiver.

2.3 or newer Not authorized PC-CDU MS will work as Lite
(reduced functionality).

1-2 PC-CDU Reference Manual
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Table 1-2. PC-CDU MS Authorizations (Continued)

If the Firmware Version Installed on the

. Then...
Receiver Is...

2.2p3 or older PC-CDU MS will work as MS
until the expiration date. Once
this date has been reached, the
program changes into Lite mode.

PC-CDU Lite will never turn into PC-CDU MS and never expires.

Installing PC-CDU

Before installing and using PC-CDU, ensure that the system has the
following requirements.

* PC-compatible computer with Intel® Pentium® 100 MHz or
faster

* 5 Mbyte free disk space
* 16 Mbyte RAM or more (32 Mbyte recommended)

* 32-bit operating system, such as MS Windows 95/98/Me/NT/
2000/XP

¢ Color monitor with minimum 640x480 screen resolution

¢ For Internet Server/Client applications, a connection to the
Internet

PC-CDU comes as a ready-to-run executable. When downloading
PC-CDU MS from the Topcon website, a username and password are
required. Follow the instructions at the top of the Software
Downloads web page for obtaining this information.

from the Topcon website. If your version of

\i ; i The procedure below is for downloading PC-CDU
PC-CDU is on a CD, skip to step 5 on page 1-4.

1. Visit the Topcon website and log into the secure site. Navigate to
the GPS software downloads page.

P/N 31-000004-01 1-3
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2. In the PC-CDU MS section of the page, click Click here to
download pcedu_ms.zip to download the compressed file to
your computer. Click Save to continue with the download.

3. Specify the destination (disk drive/folder) for the archive file
(pccdu_ms.zip) and click Save. Wait for the archive file to
download onto your system.

4. On your computer, create a “PC-CDU” folder inside the “TPS”
folder in the Program Files directory. The folder path will be as
follows:

C:\Program Files\TPS\PC-CDU

5. Extract the program into this folder using WinZip® or another
appropriate software. The following files appear in the folder:

¢ Executable file — Pccdu.exe
* Auxiliary binary file — Iptaccess.vxd

6. If desired, create a shortcut for PC-CDU and place it on the
computer’s desktop.

Removing PC-CDU

The simplest way to remove PC-CDU from a system is to delete the
folder in which the executable file (Pccdu.exe) and its components
reside. Also, delete the PC-CDU shortcut, if available.

Before deleting the PC-CDU folder, move any
items you want to keep.
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Starting PC-CDU

When first running PC-CDU, a “pccdu.ini” file is created and stored
in the PC-CDU directory. This file stores user settings and is
automatically updated as changes are made in the program. Settings
and information are recorded using plain text (ASCII), so any text
editor can be used to edit the information as well. Before making any
changes directly to the pccdu.ini file, save a backup copy of the
original to an easily accessible location.

= Keep copies of PC-CDU in separate directories to
maintain unique settings for different purposes.

To start PC-CDU, do one of the following, double-click the
“pcecdu.exe” file or the PC-CDU shortcut.

Once PC-CDU is launched, the Connection Parameters dialog box
displays (Figure 1-1).

[ Connection Parameters
Connection mode

IV“_ Direct " Internst Client £ Intemet Server |
—Part setting:

Port: [coM1 x| Baud rate: [115200 | T Infrared port

[¥ RTS/CTS handshaking

~Program setting
[T Passivemode [~ Manual mode onlp  Timeout [ms]: | 10000 'I

I~ Riestore the receiver's ariginal baud rate on Disconnect

rInternet [ Client - Server ] setting:

Host name: flocalhost TR part: | 5000

Fassward: I

™| Display deta an server. ¥ Log seiver events ™| DHE lookup

T Torned | Cancel |

Figure 1-1. Connection Parameters

This dialog box contains the following parameters needed to connect
a computer and a TPS receiver:
* Connection mode — used to set the type of connection.

— Direct: used when the computer and TPS receiver are directly
connected using a serial, parallel, USB or Ethernet port and a
cable.
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Ethernet ports establish a direct connection between a
computer and a TPS receiver using a cable connection or
similar connection through the Internet. For more
information about communicating via Ethernet, see
“Establishing an Ethernet Connection” on page 1-13.

— Internet Client: used to get remote access to a TPS receiver
via the Internet. The remote receiver must be connected to a
computer, and this remote computer must be running
PC-CDU in Internet Server mode.

— Internet Server: used to provide access to a connected TPS
receiver via the Internet and a remote computer running
PC-CDU in Internet Client mode. Currently, Internet Server
mode only accesses one remote PC-CDU Internet Client at a
time. Both the Internet Server computer and the Internet
Client computer must have PC-CDU running in the
appropriate mode, as well as be connected to the Internet.

* Port settings — used to configure the computer’s communication
port and to set the desired settings of the receiver’s
communication port. These settings are applied after clicking
Connect.

— See the following sections for details on these settings for the
different connection types available with PC-CDU.

— RTS/CTS handshaking: ensures reliable data exchange
between the receiver and computer. Prior to selecting this
option, make sure that 1) both the computer and receiver
support RTS/CTS handshaking and 2) the serial cable being
used allows RTS/CTS handshaking.

— Infrared port: establishes an infrared connection when 1) an
appropriate external infrared adaptor is connected to the
selected serial port on the computer side, 2) the receiver’s
hardware supports an infrared port option, and 3) the Infrared
Port option is enabled in the receiver.

— Rec ID: only available for USB connections, used to select
the receiver, based on its unique electronic ID, to make a
connection with.
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* Program settings — used to apply configuration settings when
connecting to or disconnecting from the receiver.

— Passive mode: prevents PC-CDU from making changes to
receiver parameters. In this mode, the receiver’s pre-set
elevation mask defines the elevation angle for displaying
satellites on the Main window.

When turned off, PC-CDU automatically forces the Terminal
Elevation Mask to -90°, and all tracked satellites displays
(rather than just those above the mask angle). This setting
remains as long as PC-CDU is open. After closing PC-CDU,
the original mask is restored to the receiver. See “General” on
page 3-28 for information on setting the elevation mask.

— Manual mode only: allows PC-CDU to act as input/output
terminal for sending user commands to the receiver and
receiving information from the receiver without connecting to
the receiver.

— Timeout: establishes the number of milliseconds to wait
before trying the next baud rate while establishing a
connection with the receiver through a serial port.

— Restore the receiver’s original baud rate on Disconnect:
determines the receiver port’s original baud rate (before
running PC-CDU) and restores this setting after
disconnecting the receiver from PC-CDU.

* Internet (Client - Server) settings — used to enter Internet
connection parameters for connecting to or disconnected from a
remote receiver.

— Hostname: the name or IP address of the remote computer
running PC-DU Internet Server.

— TCP port: used to set the port needed through which to
connect to the Internet.

— Password: used to protect the PC-CDU server from
unauthorized access. Up to 128 alphanumeric characters may
be used.

— Display data on server: displays satellite information and the
antenna’s current position in the Main window.
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— Log server events: creates a text log file (pccdu_server.log) in
PC-CDU’s working directory. This file contains some
information collected during the communication session
between the PC-CDU server and PC-CDU client. New
information is added to the file after another client connects
to the PC-CDU server.

— DNS lookup: includes the DNS address in the
“pcedu_server.log” file; otherwise, this file includes the IP
addresses only.

Establishing a Serial Port Connection

To establish a connection between a computer and the receiver using
serial ports, follow these steps:

1.

Connect an available receiver port (usually port A) to a
communication port on the computer using a receiver-to-
computer RS-232 serial cable.

Turn on the receiver.

If the receiver does not have power, connect it to a power source.
Refer to the receiver’s documentation for this information.

Start PC-CDU and select the following parameters:

* Port list — select the computer serial port (COM1, COM2,...)
to use for the connection.

* Baud rate — select the desired baud rate for communication
between the receiver port and computer port.

e RTS/CTS handshaking — enable

* Infrared port — enable only if establishing a connection

between the receiver and computer via an infrared adaptor.
See the requirements on page 1-6 for details.

Click Connect. See Figure 1-1 on page 1-5 for an example of the
Connection Parameters dialog box for this connection type.
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Establishing a Parallel Port
Connection

Before connecting the receiver and computer using parallel ports and
the corresponding cable, make sure the following requirements are
met:

* The computer runs under Windows 95, 98 or ME.

* The computer’s parallel port has been configured as ECP or
ECP+EPP.

* The Parallel Port option has been enabled in the receiver.

If run on a Windows N'T/2000/XP computer,
PC-CDU does not allow connection to the receiver
via parallel ports.

To establish a connection between the computer and the receiver
using parallel ports, follow these steps:

1. Connect the receiver’s parallel port (usually marked “Parallel”) to
a parallel port on the computer using the receiver-to-computer
parallel cable.

2. Turn on the receiver.

If the receiver does not have power, connect it to a power source.
Refer to the receiver’s documentation for this information.

3. Start PC-CDU and select the following parameters:
* Direct — enable.

* Port list — select the computer serial port (LPT1, LPT2,...) to
use for the connection.

4. Click Connect (Figure 1-2 on page 1-10).
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[ Connection Parameters
Connection mods
((-‘ Diract © Intermet Clint © Intemet Server ‘
Por setting
Pat [LFT1 =] Beudiee [Facll = Elifreredipr

I | FIS/ET8 Hendshakin

Program setting
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~Internet  Client - Server ] satting

hiEstiamies localhost TERpart 2000

Psswori |

I= | Wispleyidata orserver W | Log seivenevents = | S ek,

Figure 1-2. Parallel Port Connection Parameters

Establishing a USB Connection

Before connecting a USB equipped TPS receiver with the computer’s
USB port, make sure that the USB port option is enabled in the
receiver and that the TPS USB driver is installed on the computer.

Checking for the USB Option

Even if the receiver has a USB port, the option may not be enabled.
To verify whether or not the USB Port option is enabled, use a direct
serial cable connection. Once connected, click Tools » Receiver
options.

* If enabled, “yes” displays in the Current column of the USB Port
option.

* If disabled, “no” displays in the Current column of the USB Port
option.
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Installing the TPS USB Driver

The driver installation procedure varies slightly depending on the
operating system used. For detailed information on the driver
installation for your specific operating system, see the appropriate
section in Appendix C.

The procedure below refers to the USB driver
version 2.0.0.2 or newer.

In general, the installation procedure is as follows:
1. Visit the Topcon website and log into the secure site. Navigate to
the GPS software downloads page.

2. In the PC-CDU MS section of the page, click tps_usb.zip to
download the compressed file to your computer. Click Save to
continue with the download.

3. Specify the destination (disk drive/folder) for the archive file and
click Save. Wait for the archive file to download onto your
system.

4. Extract the following files into a new folder.
* Tpsusbio.inf
* Tpsusb98.sys
* Tpsusbio.sys
5. Connect the receiver to the computer through the supplied USB
cable. Turn on the receiver.

6. The Windows operating system automatically detects the new
hardware device. Follow the on-screen instructions to finish the
installation process.

After Windows finishes installing the driver, you are now able to
connect the receiver and the computer using USB ports.

P/N 31-000004-01 1-11



Introduction

Connecting via USB

A USB connection cannot be established if using a
computer with Windows 95/NT operating system.

To establish a connection with the receiver using USB ports, follow
these steps:

1.

Insert the USB cable into the USB port of the receiver. Plug the
opposite end of this cable into the USB port on the computer.

Turn on the receiver (and the computer, if needed).

If the receiver does not have power, connect it to a power source.
Refer to the receiver’s documentation for this information.

Start PC-CDU and select the following parameters:
* Direct — enable.

* Port list — select the computer’s USB port (USB) to use for
the connection.

¢ Rec ID - select the electronic ID of the receiver to connect
with.

Click Connect (Figure 1-3).

[ Connection Parameters ]
Conmection mods:

’7(-' Direct C Intemet Client © Intemet Server ‘
~Port setting

Por: [UsB  [x]  RecID: [e00DPaisiRk x| I Infiaed ot

[ Progiam setting:
7 Passivemode [T fanual mode only Timesut [ms] | 500 =

I Flestore the rec=iver's oiiainalbaud rate on Dissannect

[Intemet [ Client - Server ) setfing;

Hestrame: localhost TCER part: {5000

Passwrd: |

I= Display datzonserver | Logseivereverts [ DS lackup
Cancel

Figure 1-3. FUSB Connection Parameters
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Establishing an Ethernet Connection

TPS receivers can use the following two Ethernet-based methods for
communication:

* Communication with a receiver directly connected to a computer.

* Communication with a receiver connected to an existing TCP/IP
Ethernet network.

Connecting Directly via Ethernet

Use a direct Ethernet connection to test this connection before
connecting to an active TCP/IP network, or when an Ethernet network
18 unavailable.

Use this method for preliminary tests before using
the receiver on an active TCP/IP network.

Before establishing the connection, make sure you have the
following:

* A computer with an Ethernet card installed and the TCP/IP
protocol configured.

* A TPS receiver with a physically installed Ethernet port and the
Ethernet port option enabled.
* The following cables:
— Ethernet adapter (p/n 14-008032-01)

— an Ethernet cross-over cable (this cable is typically available
from a local computer store or an online computer stores)

—an RS-232 cable (p/n 14-008005-02) to configure the IP
settings of the receiver

The following procedure describes how to connect the receiver
directly to a computer using Ethernet ports. The example in this
procedure uses a protocol with the following settings:

e P address — 192.168.0.1
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* Gateway — 192.168.0.3 (because only two devices are directly
connected and have no connections to another network, the
gateway address can be set to all zeros).

* Subnet mask — 255.255.255.0

You should have already installed an Ethernet card and configured the
TCP/IP protocol on your computer.

1. See “Establishing a Serial Port Connection” on page 1-8 for
connecting the computer and receiver using a serial cable.

2. Once connected, click Configuration » Receiver » Ports »
Ethernet.

3. Select the following IP settings for the receiver:

* [P Address — enter the same value as the computer’s IP
address, but increment the last number by one. The last
number must differ from the computer's IP address but be
within the O to 255 range (for example, 192.168.0.2).

* IP Mask — enter the same number used for the computer.
» Gateway — enter the same number used for the computer.

4. Inthe Telnet Settings area, leave all settings as is, but ensure that
TCP port is set to 8002.

Record the value in the Network Password field (if no password is
needed, leave this field blank).

Click Apply then OK to set the parameters.

Click Tools » Reset receiver to restart the receiver.
Click File » Disconnect.

Connect the Ethernet cables (Figure 1-4 on page 1-15):

© =N

* Insert the seven pin connector of the Ethernet adapter into the
ETHR port of the receiver.

» Connect the other end of this adapter to the Ethernet
crossover cable (either end).

* Plug the second end of the crossover cable into the Ethernet
jack on the back of the computer.
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Receiver Cross-over Cable
Ethernet Adapter

Figure 1-4. Direct Ethernet Connection — Hardware Setup
9. InPC-CDU, click File » Connect and select or enter the
following settings:
* Connection mode — Direct
* Port - ETHR
* TCP port — 8002
* Host name — IP address assigned to the receiver in step 3 on
page 1-14
» Password — the same series of characters specified for the
receiver in step 4 on page 1-14, or leave blank if no password
10. Click Connect (Figure 1-5 on page 1-16).
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Figure 1-5. Ethernet Connection Parameters

After establishing a live connection, the current connection type
(Ethr) and the receiver’s IP address display in the bottom left corner
of the PC-CDU Main window (Figure 1-6).
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001206

I Ethe 19216802

Figure 1-6. PC-CDU Main Window — Ethernet Connection Established

Connecting via an Existing TCP/IP Ethernet
Network

Use this method to connect the receiver to the Internet and to access
the receiver over a local area network (LAN). Before establishing the
connection, make sure the following components are available:

* An operational TCP/IP LAN or a connection to the Internet

* The following cables:
— Ethernet adapter (p/n 14-008032-01)

— straight-through Ethernet cable (this cable is available from a
local computer store or from many online computer stores)
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—an RS-232 cable (p/n 14-008005-02) to configure the
receiver’s IP settings

* A TPS receiver with an installed Ethernet port and the
corresponding option enabled. To verify whether or not the
Ethernet options are enabled using the Option Manager dialog
box in PC-CDU (click Tools » Receiver options).

— “Ethernet Port” must be set to “yes” the Current column.
TCP Connections must range from 1 to 5.

— “FTP Connections” must be set to 1 (for FTP connections
only).

» For more information about receiver options, including Ethernet-
related options, see Table 3-5 on page 3-77.

The following procedure describes attaching the receiver to an
existing network.

When connecting TPS receivers to a network, work

@ closely with the system administrator to ensure
successful connections. Each receiver requires the
following: A unique static IP address whether or not
a Dynamic Host Configuration Protocol (DHCP) is
used on the network, a subnet mask, and a default
gateway.

1. Connect the computer and the receiver using the RS-232 serial
cable.

2. Run PC-CDU. Select appropriate communication settings for
connection via serial port and then click Connect. See
“Establishing a Serial Port Connection” on page 1-8 for details.

3. Click Configuration » Receiver » Ports » Ethernet.

Specify the IP Address, IP Mask, and Gateway settings for the
receiver.

If in doubt about which IP settings are safe to use,
consult your system administrator.
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5.

10.

Configure Telnet Settings and Network Password. The
following settings may be used:

* TCP port — 8002 (default value). This is the port on which the
receiver listens for telnet-like connections. The receiver
allows up to five simultaneous telnet-like connections.

* Timeout — 600 (default value). This parameter sets the
amount of time in seconds the receiver allows an inactive
connection to remain open. After this time, the receiver
terminates the unused connection.

* Network Password — an arbitrary sequence of characters (to
not use a password leave this field blank).

Configure FTP Settings (optional). Use the following settings:

* TCP port — 21 (default value). This is the port on which the
receiver listens for FTP connection. The receiver allows only
one FTP connection at a time.

* Timeout — 600 (default value). This parameter sets the length
of time in seconds the receiver allows an inactive connection
to remain open. After this time, the receiver terminates the
unused connection.

Click Apply then click OK.

Click Tools » Reset receiver to restart the receiver.
Click File » Disconnect.

Connect the Ethernet cables (Figure 1-7 on page 1-19).

¢ Insert the seven pin connector of the Ethernet adapter into the
ETHR port of the receiver.

* Connect the other end of this adapter to the Ethernet straight-
through cable (either end).

* Plug the second end of the straight-through cable into the
Ethernet jack on the LAN hub or switch.
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PC

Receiver

Straigth-thru Cable
Figure 1-7. Receiver on LAN — Hardware Setup

ping command. From the Windows command
prompt or Run dialog box, type: “ping [receiver’s
IP address]” (for example, ping 195.105.138.43). If
the receiver responds, continue with step 11. If it
does not respond, double-check the LAN
connections and addresses.

i : i At this point, check that the receiver responds to the

11. In PC-CDU, click File » Connect and specify the following
settings:

¢ Connection mode — Direct
¢ Port - ETHR
* TCP port — 8002

* Host name — IP address assigned to the receiver in step 4.

P/N 31-000004-01 1-19



Introduction

» Password — the same series of characters specified for the
receiver in step 5 or leave it blank to not use a password.

12. Click Connect (Figure 1-5 on page 1-16).

After establishing the connection and the current connection type
(Ethr), the receiver’s IP address displays in the bottom left corner of
the PC-CDU Main window.

Connecting to the receiver over a TCP/IP network provides the same
functionality as a cable connection. Other functionality includes

transferring files from the receiver over a TCP/IP network using FTP
and connecting up to five remote telnet-like terminals to the receiver.

For transferring raw data files from the receiver to the remote
computer using FTP, see “How to Download Files to a Remote
Computer Using FTP” on page 2-6.

Establishing an Internet Client-
Server Connection

An Internet connection can be used to connect to a remote receiver
connected to a computer running PC-CDU in “server” mode. A
client-server connection allows a remote receiver to be accessed,
maintained, managed, and updated as if the “client” were directly
connected to the receiver.

Internet Server Mode

In Internet Server Mode, the receiver must be directly connected to
the computer running PC-CDU server using one of the cable or
ethernet connections described above. The computer running
PC-CDU must have a live connection to the Internet.

To establish a connection with the receiver using PC-CDU, follow
these steps:

1. Start PC-CDU and select the following settings:
* Internet Server — enable.

* TCP port — enter the TCP port number (if needed); 8000 is
the default.
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» Password — enter the password needed to access the
connected receiver.

* Log server files — enable.
2. Click Connect (Figure 1-8).
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Figure 1-8. Internet Server Connection Parameters

After connecting to the receiver, the main screen and server screen
displays (Figure 1-9).
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Figure 1-9. Internet Server Started

The Server dialog box allows a user running PC-CDU Server to
communicate with the corresponding PC-CDU Client. In addition,
the server screen displays information about the server’s current
status.
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Internet Client Mode

In Internet Client Mode, a remote receiver may be accessed for
monitoring, configuring, and managing the receiver. The computer
running PC-CDU must have a live connection to the Internet.

After establishing a connection to the remote receiver, the user can
control this receiver as if the user’s computer were directly connected
to the receiver, such as send commands to the remote receiver,
download log files from the receiver’s memory, and so on. Before
configuring the PC-DCU client parameters, have the following
information about the PC-CDU server available:

* IP or DNS address
* TCP port number

» Password (if necessary)

IP address (such as, 194.135.59) or its DNS address

\i : / In the Host name edit box, enter either the server’s

(such as, pab.topconps.com).

1. Start PC-CDU and select the following settings:

Internet Client — enable.

Host name — enter the IP address of the computer running

PC-CDU Server

TCP port — enter the TCP port number (if needed); 8000 is
the default

Password — enter the password needed to connect with the
server.

DNS lookup — enable.

2. Click Connect (Figure 1-10 on page 1-23).
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Figure 1-10. Internet Client Connection Parameters

After connecting to the receiver, the main screen and the client screen
display (Figure 1-11).
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Figure 1-11. Internet Client Started

The Client dialog box allows a user running PC-CDU Client on one
end to exchange messages with a user running PC-CDU Server on the
other end. Messages sent from the client to the server are preceded by
the character “>”. Messages sent from the server to the client begin
with the character “<”. The last received message is topmost in the

list.
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Closing PC-CDU

% Disconnecting the receiver from the computer

before exiting prevents conflicts with serial port
management.

To disconnect from the receiver, click File » Disconnect. The
disconnect process results in the following:

* Turning off RTS/CTS handshaking.

» Resetting the receiver control Terminal Elevation Mask to its
original value (only if the Passive mode checkbox has not been
deselected).

» Resetting the baud rate to 115200 if the receiver’s original baud
rate that the receiver has before running PC-CDU exceeded
115200.

* Restoring the original baud rate if the Restore the receiver’s
original baud rate on Disconnect parameter has been selected.

To quit PC-CDU, click File » Exit.

Although the connection is broken if exiting before disconnecting,
conflicts may occur with the serial port because the items in the list
above are still active.
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Chapter 2

PC-CDU Getting Started
Guide

This chapter contains a number of step-by-step instructions that will
walk you through the most frequently used software procedures,
focusing only on the configuration procedures most likely to be used.

Because it is a quick reference, this chapter does not contain a
detailed description of the settings and parameters. For detailed
information about the dialog boxes and fields in PC-CDU, refer to the
corresponding sections in Chapter 3.

How to Connect to the
Receiver

Physically connect the receiver and a computer using either a serial,
parallel, USB, or Ethernet cable.

» See “Establishing a Serial Port Connection” on page 1-8 for a
serial port connection procedure.

* See “Establishing a Parallel Port Connection” on page 1-9 for a
parallel port connection procedure.

» See “Establishing a USB Connection” on page 1-10 for a USB
port connection procedure.

* See “Establishing an Ethernet Connection” on page 1-13 for an
Ethernet port connection procedure.
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How to Navigate through the
Software

Moving through PC-CDU is like moving through any other Windows
program: use the mouse to select desired functions and options; use
the Tab key to move from field to field.

Shortcut keys provide a quick way to perform common functions. If a
menu function has associated shortcut keys, the key combination will
be shown to the right side of the menu item (Figure 2-1).

Receiver Chrl+y Shortcut
Sike Chrl+I KeyS for
Target positio Chrl+T

Menu Items

Radio

Figure 2-1. Example of Shortcut Keys Associated with Menu Items

How to Start Data Logging...

The primary purpose for configuring the receiver is to manage data
logging, either to the receiver’s memory or directly to the computer.

... 10 the Receiver Memory
1. Click File » File Manager.
2. Click the Current log file tab and set the following parameters:

* File name — type name of the file to which the receiver will
log data

* Recording interval — set the data logging interval
* Elevation mask — set the elevation cut-off angle

« Site parameters — click to enter the site name and antenna
details

3. Click OK and then Start. A new log file will be created and the
receiver will start recording data into the file.

For more information, see “Current Log File” on page 3-14.
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How to Start Data Logging...

..On the Computer

Click File » Real-Time Logging.

2. Click the Select output path tab and navigate to and open the
folder in which to download and store log files.

Or, type a new folder in which to download and store files.

3. Select the desired file creation mode, set the following parameters
(Table 2-1), and click Start.

Table 2-1. File Creation Mode Options

If “Single file” selected... If “Multiple files” selected...
* Save to e Prefix
* Recording interval field (data logging | Numbering
interval) « Start Count (if Ascending Count

* Site parameters (click and enter the site | selected)
name and antenna details, then click * New file every

OK) * Overwrite existing files (as needed)
¢ Elevation mask  Autoconvert to RINEX (click Setup
converter to adjust the converter’s
settings)

* Recording interval

* Elevation mask

« Site parameters (click and enter the site
name and antenna details, then click
OK)

¢ Elevation mask

For more information, see “Single File” on page 3-19 and “Multiple
Files” on page 3-20.
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How to Automatically Convert
Real-Time TPS Raw Data Files
to RINEX

While logging receiver raw data files to the computer, PC-CDU can
automatically convert the files from TPS format to RINEX format.
Deleting source files (if raw data files are not required) after a
successful conversion will save computer disk space.

1.
2.

6.

Click File » Real-Time Logging.

Click the Select output path tab and navigate to and open the
folder in which to download and store the original tps log files
and their RINEX counterparts.

Or, type a new folder in which to download and store files.

Select the Multiple files tab, and set the following parameters:

* Prefix * Overwrite existing files (as
* Numbering needed)
o Start Count (if Ascending * Recording interval

Count selected) ¢ Elevation mask

* New file every

Enable the Autoconvert to RINEX and click Setup converter.

Set, if required, the following RINEX converter parameters and
click OK:

* Run by e Marker name
* Observer * Converter Application
* Agency » Exclude GPS and/or Exclude

e Antenna # (serial number) GLONASS
« Antenna type (antenna’s ~ * Exclude L1 and/or Exclude L2

NGS description) * Delete source JPS files...

¢ Comment

Click Start.

Additional options

For more information, see “Multiple Files” on page 3-20 and
“Converter to RINEX Setup” on page 3-22.
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How to Stop Data Logging...

How to Stop Data Logging...

Once the data logging session has completed, stopping the data
logging will prevent files from being erased or the receiver’s/
computer’s memory from becoming full.

... 10 the Receiver Memory

1. Click File » File Manager.
2. Click the Current log file tab and click Stop.

...On the Computer
Click File » Real-Time Logging and click Stop.

How to Configure Automatic
File Rotation Mode

Automatic file rotation will close and open new files in the receiver
memory, logging raw data to these files according to the user-
specified schedule. AFRM may delete the earliest files when no free
memory remains to make space for new data logs.
1. Click Configuration » Receiver.
2. Select the Minter tab.
3. In the File Creation mode area, select AFRM.
4. In the Automatic File Rotation Mode (AFRM) parameters area,
set the following parameters and click Apply:
* Period * Files (total)
* Phase * Automatically remove old files

5. To start data logging in AFRM mode, use the MINTER’s FN
button as you usually do for recording a single raw data file.

For more information on the AFRM mode, see to “MINTER” on
page 3-31.
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How to Download Files to a
Computer Using File Manager

When logging data to the receiver, files will need to be downloaded
for post-processing and to manage the receiver’s memory (through
file deletion). This procedure downloads files to a computer directly
connected to the receiver.

1. Click File » File Manager.

2. Select the Download path tab.

3. Navigate to and open the folder in which to download and store
files.

Or, type a new folder name and click Create to create a new
folder in which to download and store files. Open this new folder.

4. Select the Download files tab and select the file(s) to download.
5. Click Download.

6. Once the files have been successfully downloaded, continue with
other operations.

How to Download Files to a
Remote Computer Using FTP

When logging data to the receiver, files will need to be downloaded
for post-processing and to manage the receiver’s memory (through
file deletion). This procedure downloads files to a remote computer
connected through an FTP site.

1. Configure your Ethernet-enabled receiver as shown in
“Connecting via an Existing TCP/IP Ethernet Network™ on
page 1-16.

2. From a computer on which you want the files to be stored, open a
Web browser (for example, Internet Explorer).

3. In the Address bar of the browser, type the IP address of the
receiver to connect with (for example, ftp://63.106.139.235).
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How to Delete Files from the Receiver

4. Enter a User Name and the Password intended for access. Click
Login.

5. Once the access has been verified, a list of log files in the receiver
displays. Select the files to download and right-click within the
selected area. Click Copy To Folder on the pop-up menu.

2./ - Miciosoll Inteivet Explores
Flo Bt View Fovoster  Took  Help -
SaBack = - (5] | P Semch |3y Foldes 1P| L5 B X o3| [
Addess | §) .12 12 ) =] 6o | [La®
S rr— T TN EETEE
L 2 DONGTIZE  DONOTIZSg DONOTIZE DONDIIZE  DONDIIZS
%@ Could ot login to the FTP server with the user name and 12 ﬁ ﬁ ﬁ ﬁ ﬂ
DaSSWDV’d SDEEIFIEd‘ - DOROTIZS DONOIZE DONOIIZSm DONDIZS DONDTTZS
FTP Server: LN .
e | i B O
s R CONNREES) (NSRS CIEIREER
N o
After wou login, wou can return to this FTP server easily :. ﬁ] ﬁ] k]
by adding it ko your Favorites List. o DONOTIZS DOROTIZ%: DONDTIZS
Cogy
™ Lagin Anonymausky IV save Password _m] _:u] _.‘ﬁ] Dl
" e DOROTIERE DONOTIEE DONG1YEN
Properties
# & & (4
IIIIl.-"IH!h IIIIl.-"IH!I. IIII.NIIHN flll‘NIIIli\ LLTIARE LY ;I

Copses the selected dems io this computer.

Figure 2-2. Login As Dialog Box and Copy Log Files

Navigate to and open the folder in which to download and store
files. Click OK and wait until all the selected files copy to the
computer.

Once the files have been successfully copied, continue with other
operations.

How to Delete Files from the
Receiver

Deleting files from the receiver’s memory creates space for new files.

1.
2.
3.

Click File » File Manager.
On the Download files tab, select the file(s) to delete.

Click Delete and Yes at the confirmation dialog box. PC-CDU
deletes the selected files.

Once the files have been successfully deleted, continue with other
operations.
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How to Recover Deleted Files

Before recovering a deleted file, note the following important
recommendations:

* Do not record any new raw data files to the internal memory of
the receiver from which the file(s) was deleted. Recording new
files may overwrite (and permanently delete) the deleted file(s).

* Do not initialize the file system. This procedure permanently
erases all files inside the receiver.

* Do not try to remove the receiver’s Compact Flash card and read
its contents with a card reader.
1. Click File » Manual Mode.

2. In the command line at the top of the Manual Mode dialog box,
type %%set, /par/dev/blk/a/removed,on and click
Send command.

3. Wait while the receiver re-mounts its file system (during this
process the REC LED blinks orange).

4. Once the file system is successfully re-mounted (the REC LED
stops blinking), close the Manual Mode dialog box and click
File » File Manager.

5. Select the desired file and click Download.
In this mode, only the deleted file(s) will display.

6. After successfully downloaded the deleted file, restore the file
system to its normal state using one of the following procedures:

* Click Exit on the File Manager dialog box and open the
Manual Mode dialog box. In the command line, type
%Y%set,/par/dev/blk/a/removed, off and click
Send command.

¢ Click Exit on the File Manager dialog box, then click
File » Disconnect. Finally, power cycle the receiver.

7. Wait while the receiver re-mounts its file system (during this
process the REC LED blinks orange).

8. Once the file system is successfully re-mounted, the REC LED
will stop blinking.
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How to Create a Receiver Configuration File

How to Create a Receiver
Configuration File

Creating and saving a receiver configuration file makes it easy to
apply quickly a pre-set configuration.
1. Click Configuration » Receiver and click Save.

2. From the Save setup to a script dialog box, navigate to and open
the folder in which to save the file.

3. Enter the name of the configuration file to be created.
. Select the extension for the file (usually “.tpc”).
5. Click Save.

In the Configuration file, PC-CDU will store only
the current settings in the Receiver Configuration
dialog box and its sub-tabs.

How to Load the Configuration
File to the Receiver

Loading a saved configuration helps to quickly prepare the receiver
for surveying.

1. Click File » Manual Mode.

2. In the bottom-left corner of the Manual Mode dialog box, click
Load script.

3. The Script file dialog box displays. Select the desired
configuration file and click Open. The filename displays in the
command line.

4. Click Send command. The file begins loading. Once the
>Done! string appears, the loading has completed and the
settings are applied to the receiver.

Avoid loading the configuration files other than
those created specifically for the selected receiver.
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How to Enable WAAS Satellites

WAAS satellites provide error-corrected signals for improving GPS

positioning.
1. Click Configuration » Receiver.
2. Select the Positioning tab then the WAAS tab and set the following
parameters:
* Channel 1 — enable * Interpret message #0 as
* Set WAAS - select the message # — select 2
WAAS satellite PRN * Use Iono Corrections — select
code Only
* as GPS —selectthe GPS ¢ Enable output of “true”
satellite PRN code WAAS PRN numbers —
enable
3. [Ifrequired, repeat step 2 for the second channel.
4. Click Apply.

For details on enabling satellites, see “Positioning” on page 3-34.

How to Configure a Base
Station for Broadcasting...

The Base station broadcasts messages that contain correction
information to Rover receivers. Topcon receivers support industry
standard RTCM and CMR message formats.

...RTCM Messages

1.
2.

In the Configuration menu, select the Receiver item.

Click the Base tab and select whether the using the phase center
L1 or antenna reference point for geodetic coordinates. Also
select the type of antenna.

2-10 PC-CDU Reference Manual



How to Configure a Base Station for Broadcasting...

3. Enter the latitude, longitude, and altitude (ellipsoidal height)
coordinates of the antenna position in the selected datum using
one of the following methods.

¢ If the Reference Geodetic Coordinates are known, enter the
coordinates.

* Click Get from receiver to use the current antenna position
(that is, the most recent position produced by the receiver).

4. Enter the following settings to include in RTCM messages:

* the station ID for the * enable pseudo-range
reference receiver smoothing
* the health status of the Base ¢ the serial number and
receiver setup ID for the receiver
 the maximum number of * the system(s) used
satellites « the type of
measurement(s)

5. Click the Ports tab. On the Serial tab, set the following
parameters for the port from which to generate RTCM messages
and click Apply then OK:

* Input — select Command * Baud rate

* Output — select one of the e RTS/CTS - enable if
RTCM message types modem supports

e Period hardware handshaking

For details on the Base tab and Ports tab settings, see “Base” on
page 3-40 and “Ports — Serial” on page 3-46.
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..CMR Messages

Click Configuration » Receiver.

2. Click the Base tab and select whether the using the phase center
L1 or antenna reference point for geodetic coordinates. Also
select the type of antenna.

3. Enter the latitude, longitude, and altitude (ellipsoidal height)
coordinates of the antenna position in the selected datum using
one of the following methods.

¢ If the Reference Geodetic Coordinates are known, enter the
coordinates.

* Click Get from receiver to use the current antenna position
(that is, the most recent position produced by the receiver).

4. Enter the following settings to include in CMR messages:

* the station ID for the * the message type to
reference receiver associate with

* ashort, long, and COGO GLONASS
description of the object being measurements
surveyed * the type of

* the state of the Base station measurement(s)

(static, kinematic, unknown)

5. Click the Ports tab. On the Serial tab, set the following
parameters for the port from which to generate CMR messages
and click Apply then OK:

* Input — select Command * Baud rate
* Output — select one of the * RTS/CTS - enable if
CMR message types modem supports

e Period hardware handshaking

For details on the Base tab and Ports tab settings, see “Base” on
page 3-40 and “Ports — Serial” on page 3-46.
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How to Configure Rover
Station for Accepting...

The Rover station receives messages that contain correction
information from the Base station. Topcon receivers support industry
standard RTCM and CMR message formats.

-.RTCM Messages in DGPS mode

Click Configuration » Receiver.
2. Click the Rover tab, set the following parameters and click
Apply:
* Positioning Mode — enable DGPS (Code Differential).
» Multi-base — adjust settings if using two to five Base stations.
* Use the default values for the remaining settings.

3. Click the Ports tab. On the Serial tab, set the following
parameters for the port on which to accept RTCM messages and
click Apply then OK:

¢ Input — select RTCM * RTS/CTS - enable if
modem supports

* Output — select None )
hardware handshaking

e Baud rate

For details on the Rover tab and Ports tab settings, see “Rover” on
page 3-43 and “Ports — Serial” on page 3-46.
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-.RTCM Messages in RTK mode

Click Configuration » Receiver.
2. Click the Rover tab, set the following parameters, and click
Apply:
* Positioning Mode — enable RTK Fixed.
* Use the default values for the remaining settings.
3. Click the Ports tab. On the Serial tab, set the following

parameters for the port on which to accept RTCM messages and
click Apply then OK:

* Input — select RTCM * RTS/CTS - enable if
modem supports

* Output — select None )
hardware handshaking

e Baud rate

For details on the Rover tab and Ports tab settings, see “Rover” on
page 3-43 and “Ports — Serial” on page 3-46.

..CMR Messages

1. Click Configuration » Receiver.
2. Click the Rover tab, set the following parameters, and click
Apply:
* Positioning Mode — enable RTK Fixed.
* Use the default values for the remaining settings.
3. Click the Ports tab. On the Serial tab, set the following

parameters for the port on which to accept CMR messages and
click Apply then OK:

* Input — select CMR * RTS/CTS - enable if
modem supports

* Output — select None )
hardware handshaking

e Baud rate

For details on the Rover tab and Ports tab settings, see “Rover” on
page 3-43 and “Ports — Serial” on page 3-46.
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How to Set Raw Data & Position Update Rates to 20 Hz

How to Set Raw Data &
Position Update Rates to 20 Hz

This procedure will set the receiver to output measurement data and
position information at 20 Hz.

1.
2.

6.

Click Tools » Receiver options.

Make sure that the “Position update rate (Hz)” and “Raw data
update rate (Hz)” options display 20 in the Current column, then
click Exit.

Click Configuration » Receiver.

Click the Advanced tab then the Raw Data Management tab, set
the following parameters, and click Apply:

* Raw Measurement Update Rate, Update Rate — set to 50 ms.
* Position Update Rage, Update Rate — set to 50 ms.

Click Refesh and examine the values in the Current Update Rate
fields, they should display 50.

Once verified, click OK.

When requesting any data recording or output with a period—that is,
a recording or output not directly supported by the current state of the
receiver—PC-CDU will launch the Output Period Setup Wizard. This
wizard will perform the same steps described above. For details on
the wizard, see Appendix D.
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How to Enable a 1 PPS Output

For precise time information for synchronization or time transfer,
enable 1PPS output. 1PPS signals provide a precise time reference for
external devices.
1. Click Configuration » Receiver.
2. Click the Events tab, set the following parameters, and click
Apply:
* PPS A Enabled e« Period of ‘marked’ pulses (if required)

* Period » Edge
¢ Offset (ms) e Ref. Time
* Offset (ns) * Tied with Ref. Time

3. Repeat step 2 to enable the PPS B output (if required).

For details on setting the output, see “Events” on page 3-55.

How to Enable an Event
Marker Input

To have the receiver precisely record the time that an external event
occurs, enable event marker input. The source of events may be an
aerial camera, sounding equipment, etc.

1. Click Configuration » Receiver.

2. Click the Events tab, set the following parameters, and click
Apply:

* Event A Enabled * Ref. Time

* Clock Synchronization (leave * Tied with Ref. Time
default)

* Edge

3. Repeat step 2 to enable the Event B input (if required).

For details on setting the event marker, see “Events” on page 3-55.
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How to Enable an External Frequency

How to Enable an External
Frequency

This procedure will enable an external frequency source connected
with the receiver’s External Frequency connector.
1. Click Configuration » Receiver.

2. Click the Advanced tab then the External Frequency tab, set the
following parameters in the Frequency Source area, and click
Apply:

* Source — set to External

» External Frequency Source Parameters, Ext. freq. signal
amplitude or rate — set to a value from 2 to 40 MHz
depending on the frequency supplied by the external
frequency source.

3. Click Refesh and examine the fields Ext. frequency source status
and Ext. freq. signal amplitude, they should display locked and
ok, respectively.

4. Once verified, click OK.

For details on enabling an external frequency source, see “Advanced —
External Frequency” on page 3-62.

How to Output Position in a
Pre-defined Datum

Pre-defined datums are those embedded in the receiver firmware. TPS
receivers contain more than 200 pre-defined datums.
1. Click Configuration » Receiver.

2. Click the Positioning tab, select the desired datum ID from the
Current Datum drop-down list, and click Apply.

datum, use either NMEA messages (such as GGA)

% To view or log the receiver position in the selected
or TPS proprietary ASCII messages (such as NP).
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How to Output Position in a
User-defined Datum

Selecting a user-defined datum will set up the receiver to compute a
position using defined ellipsoid and transformation values.
1. Click Configuration » Receiver.

2. Click the Positioning tab and click Datum Parameters to set the
following parameters:

¢ Current Datum — select USER.

* Enter the corresponding values in the Reference Ellipsoid
parameters and Transformation parameters fields.

3. Click Apply then OK.
4. Click Apply on the Positioning tab.

datum, use either NMEA messages (such as GGA)

@ To view or log the receiver position in the selected
or TPS proprietary ASCII messages (such as NP).

For more details on these settings, see “USER Datum Parameters” on
page 3-38.

How to Restore Receiver
Default Settings

To restore the receiver’s default settings, do one of the following:

* Click Configuration » Receiver. Click Set all parameters to
defaults.

¢ Click Tools » Clear NVRAM.

any data stored in its nonvolatile memory, including
receiver parameters, ephemeris and almanac data,
and receiver position. No raw data files will be
deleted.

@ Clearing the NVRAM causes the receiver to delete
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How to Check Firmware
Version

You may need to know the firmware version of the GPS receiver in
certain situation, such as troubleshooting with TPS customer support
or determining which new firmware to upload.

1. Click Help » About. The About PC-CDU dialog box displays.
2. Record the Firmware version field and click OK when done.

[ About PC-CDU X]
PC-COU for Windows 95/98/ME/NT/2000/P
Wersion 2.1.14 MS (Build: Detober 14, 2004) #
Status ; Authorized
Copyright © Topeon Positioning Systems , 2000 - 2008 PC-CDU
Hip./ /v, bopeonaps.com
Receiver model ODYSEEY_E =
ceiver D)

Firmware wersion. 2.4 Sep,02,2004 — GNSS Receiver

(R = E— : :
hainboard version: E_GGD_2 Fl rmware Ver5|on
Piih size 2048KB

Power Board bu=3 =42

Power supply (V) 120

lAntenna input ext

Ext Ant DC status:  off

=
Savetofle | Repot | Fiefiesh | o |

Figure 2-3. Check GPS Receiver Firmware Version

How to Check Receiver
Options

Receiver options enable or disable the various features available for
the receiver. Options can be purchased or leased.

1. Click Tools » Receiver options. The Option Manager dialog box
displays and contains the following information:
* Option name — a name/description of the option.
e Current — the current status of the option.
* Purchased — if the option is purchased or not purchased.
* Leased — if the option is leased or not leased.

» Expiration date — the date a leased option will be disabled, if
applicable.

2. When finished, click Exit to close this dialog box.
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How to Load New OAF to
Receiver

The Option Authorization File (OAF) contains the permissions
needed to enable (through a purchase or lease) the features available
for the receiver.

1.
2.
3.

Click Tools » Receiver options.
Click Load at the bottom of the Option Manager dialog box.

Navigate to the location of the new Option Authorization File.
OAFs have .tpo or .jpo extensions and are unique to each receiver.

Select the appropriate file and click Open. The new receiver
options will load onto the receiver and the Option Manager table
will update.

When finished, PC-CDU will restart the receiver to activate new
values for the options.

How to Disconnect from the
Receiver

Disconnecting from the receiver before exiting PC-CDU will prevent
management issues with the port PC-CDU used to access the receiver.

1.
2.

Click File » Disconnect.
Click File » Exit.
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Chapter 3

PG-GDU Software
Reference

This chapter provides detailed reference information on the Main
window, dialog boxes, tabs, parameters, and settings found
throughout the PC-CDU software interface.

Elements of the Main Window

After PC-CDU has established a connection between the computer
and receiver, the Main window displays (Figure 3-1). This window
has three areas: the Menu bar, the Satellites and Position area, which
is the largest part of the window, and the Status bar.

[ PC-CDU to EGI_OEM ID:QB6WEI2SOLC (=]

Menu Bar _E Fie Configuation Tooks Flots Help

— GPS Satellites (1) [Geo f|xvz | Target| GLONASS Satelites (5)
# | EL] az|calpi[pefac] Tcf ss| Lat 550 42713.3801"N snlfn| EL] az|cal P pr2lec] 1cf 85
0 B W 46 B 3/ 70 237 ooy LOWITIIORATE nar s iay Ty a0 a1 22 13 mor
B %o o& ® 07 0o O IR 07 04 13- 20 44 43 F ¥ 157 00+

5

Al 1623141 m

06 70+ 262 53 45 45 7P 151 FIMG Pos. 1. 1353 m 03 06 41+ 76 50 50 48 77 19 0D+

. 07 18+ 270 42 24 24 77 32 O+ Ppever 000SRmde 23 03 33- 78 43 47 40 40 260 OO+

Satellite& 10 30+ 104 46 31 31 77 63 O+  ppop 12340 24 02 76+ 3] 52 52 46 45 155 OO+
20 15 212 W 19 18 7?8 0k (standalane)

Position Area 23 7- 3E0 40 18 18 7 45 OO+
20 22 A1 45 25 36 7 50 D R

/W 20 46 R BT NG O
o oh 1M & a1 41 7 i o Decsiverdse1411.2005

N M- 202 48 3 I 46 121 ope Cockoffset +0.0248 pom

Osc. offset: +0.0248 ppm
Tracking time: 220410

Status Bar —|_ COM4, 115200 TR
Figure 3-1. Main Window

Menu Bar

The Menu bar extends across the top of the Main window and
contains five menus (File, Configuration, Tools, Plots, and Help)
through which to access program functions. Alternatively, you can
use the shortcut keys (if available). The menu options are discussed in
more detail in later sections.
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Satellites and Position Area

The Satellites and Position area comprises of two panels, the GPS
Satellites panel on the left and the GLONASS Satellites on the right.
Between the two panels is the Geo|XYZ|Target box. The panels
display basic tracking information (parameters) for locked satellites.
These tracking parameters are described in Table 3-1. The
Geo|XYZ|Target box displays the antenna’s current position (if
available) and time-frequency parameters.

Table 3-1. Tracking Parameters Displayed in the Satellites Panels

Column Description

# GPS SV PRN. If the character “*” is shown next to PRN in
the column, this means that almanac data are unavailable for
the corresponding satellite.

Sn GLONASS SV Orbital Slot Number. If the character “*” is
shown next to Sn in the column, this means that almanac data
are unavailable for the corresponding satellite.

Fn GLONASS SV Frequency Number.

EL Elevation angle in degrees. The signs “+” and “-”
immediately following the elevation angle indicate that the
corresponding satellites are either ascending or descending,
respectively. If a satellite is at maximum elevation, it is
marked with “A”.

AZ Azimuth in degrees.

CA Signal-to-Noise Ratio (C/No) in the C/A channel [dB*Hz].
P1 Signal-to-Noise Ratio (C/No) in the P1 channel [dB*Hz].
P2 Signal-to-Noise Ratio (C/No) in the P2 channel [dB*Hz].
2C Signal-to-Noise Ratio (C/No) in the GPS L2C and

GLONASS L2 C/A channel [dB*Hz].

TC Time elapsed since the last loss-of-lock in the C/A channel
for the corresponding satellite. This time is given in minutes
or, if the symbol “:” is specified in the column, in seconds.
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Table 3-1. Tracking Parameters Displayed in the Satellites Panels (Continued)

Column

Description

SS

Satellite navigation status. For a complete description of the
satellite navigation status structure, see Appendix D on

page D-1. If a satellite is not used in position computation, its
SS flag will be set to “-”. Otherwise “+” will be displayed.

The satellites panels have the following functionality:

* Double question marks (??) will display in the cells of a column
when parameters are unavailable for the satellite.

* Click the column’s heading to sort data in descending/ascending

order.

The Geo|XYZ|Target box has the following tabs (Figure 3-2):

* Geo — displays the current position of the receiver's antenna and
the time-frequency parameters describing the behavior of the
receiver's local oscillator.

* XYZ — displays the position of the antenna in Cartesian
coordinates.

* Target — displays various navigational information.

vz | Tergat] Geo Target| Geo | w2 [Taget]
Lat: 55° 42'60.3108" N . 2BR3556 4508 Lat: 55° 42' 50.8500" N
Lon: 37° 35' 36.7704" E Y. 2196939.9428 Lon: 37° 35" 36.1450" E
Al 2349105 m 2 52467640301 ETT: 5333m
ek L0663 m/s Vel 0.0359 m/s NTT: 15.747 m
RMS Pos: 4.4327 m RMS Pos: 3.2058 m DTT: 16843 m
RMS Vel 0.0443 mis RMS Wel 0.0321 m/s CTT: 20°50°11.30"
PDOP: 1.9580 FDOP: 13928 FDOPF: 1.7288

(standalone) [standalone] [standalne]

Receiver time: 10:27:19 Fieceiver time: 10:54:10 Fieceiver time: 14:52:11
Receiver date: 11.04.2003 Receiver date:11.04 2003 Receiver date:11.04. 2002
Clock offset: +0.0080 ppm Clock offset; +0.0033 ppm Clock offset: +0.0013 ppm
Osc. offset: -2.7020 ppm Osc. offsat: -2 7066 ppm Osc. offset: -2.7026 ppm
Tracking time: 00:26:58 Tracking time: 00:53:49 Tracking time: 04:51:50

Figure 3-2. Geo|XYZ|Target Tabs

Table 3-2 on page 3-4 provides a description of each of the values in
these tabs.
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Table 3-2. Elements of the Geo|XYZ|Target Tabs

Field Description

Geo tab related fields®

Lat Geodetic latitude of the receiver antenna.

Lon Geodetic longitude of the receiver antenna.

Alt Ellipsoidal height of the receiver antenna.

XYZ tab related fields

X Earth-Centered-Earth-Fixed WGS-84 X coordinate of the

receiver antenna.

Y Earth-Centered-Earth-Fixed WGS-84 Y coordinate of the
receiver antenna.

V4 Earth-Centered-Earth-Fixed WGS-84 Z coordinate of the
receiver antenna.

Target tab related fields

Lat Geodetic latitude of the target or of the receiver’s antenna.

Lon Geodetic longitude of the target or of the receiver’s antenna.

ETT Easting-to-Target in the local system with the origin at the
receiver.

NTT Northing-to-Target in the local system with the origin at the
receiver.

DTT Distance-to-Target.

CTT Course-to-Target.

Geo and XYZ tabs common fields

Vel (Magnitude of the) velocity (m/s).

RMS Pos RMS position error (m). More precisely, this is the square root
of the trace of the position error covariance matrix.

RMS Vel RMS velocity error (m/s). More precisely, this is the square root
of the trace of the velocity error covariance matrix.
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Table 3-2. Elements of the Geo|XYZ|Target Tabs (Continued)

Field Description
Geo, XYZ, and Target tabs common fields
PDOP Position Dilution of Precision.

Solution type

Standalone, Code differential, RTK float, or RTK fixed.

LQ

This field reflects the status of the received differential messages
and contains the following information:

¢ Data link quality in percentage

* Time (in seconds) elapsed since the last received message

* Total number of received correct messages

* Total number of received corrupt messages

LQ

(continued)

If the receiver is not (for some reason) receiving differential
corrections or if none of the ports has been configured to receive
differential corrections, the LQ field will either be empty or it
will look like this: 100%(999,0000,0000). Currently the values
for this field are obtained from the [MS] message.

Receiver time

This field shows the receiver's current time within the day. This

value is taken from the message [~~]b. For more information
about [~~], refer to the GRIL Reference Manual.

Receiver date

This field shows the receiver's current date as specified in the
corresponding [RD] message.

Clock offset

This field describes the time derivative of (T, - T,), where T,
designates the receiver time and T, designates the receiver
reference time. For more information about T, and T,,, refer to

the GRIL Reference Manual. This parameter is obtained from
the [DO] message and is expressed in parts per million (ppm).

Osc. offset

The parameter describes the difference between the VCO's
nominal and quiescent frequencies. It is derived from the
message [OO] and is expressed in ppm.

Tracking time

This field shows the time elapsed since the last complete loss-of-
lock event in the receiver's C/A channels as specified in the

corresponding [TT] message.

a. These geodetic coordinates are always computed in WGS-84.
b. Currently, the message [~~] reports the time within day in GPS time
scale only.
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The Geo|XYZ|Target box has the following functionality

* To set the target coordinates equal to the current receiver
coordinates, double-click on the Lat or Lon field of the Target tab.

¢ To reset the timer to 00:00:00, double-click somewhere in the
hour:min:second area.

Status Bar

The Status bar provides auxiliary information while using PC-CDU.
This information includes the connection status, current
communication settings, various types of messages (for example,
error messages) and time since the connection to the receiver has been
established.
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Quick Menu Reference

The following graphs show the menu structure for the five PC-CDU
menus. The remaining sections in this chapter describe these menus,
options, and parameters in detail.

(%]

<

2

= |Connect| |Disconnect "File Manager” Real-Time Logging”ManuaI Model
5

=

[}

%

@ [Connection File Manager | | Real-Time Logging | | Manual Mode'—
® |parameters

<

a

® |Download files| |Single file |

i {Current log file| [Multiple files I

= |Download path| |Select output path|

3

X

3 'ISite Configurationl Converter to - |Script file|—
57 RINEX Setup Tog file

g Select output path | |

3 (for RINEX converter)

=

(%)
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L

(2]
§ |Recelver| |S|te| |Target position
2 RFM96
(%]
(0]
3
m |Receiver Site |Target Positionl RFM96
& | Configuration ] |[Configuration Configuration
5]
S
General
MINTER |Connect |
9 Positionin
o
& HBase
Rover
Ports

Advanced —l
|Anti-|nterference |Seria| |Save setup

Datum Multipath Reduction Parallel to a script

Parameters Loop Management Modem
External Frequenc USB
[Options [TCP

Sub-Dialog Boxes
& Sub-Tabs

(%]

§

§ |Initializefi|esystem| |Clear NVRAMl |Reset Receiverl |Receiveroptions
5

=

(]

%

& [Initialize file systeml |Clear NVRAMl |Reset Receiverl |Option Manager
g

<

a

g

< 3 Select options
23 file

2o

(%)
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File Menu

The File menu contains options for connecting with/disconnecting
from the receiver, managing the download and real-time logging of
data files, putting the receiver in Manual Mode, and exiting the
program.

Connect

The Connection Parameters dialog box contains parameters for
establishing a connection between the receiver and a computer.

[ Connection Parameters (]
Connection mode
|7r-‘ Direct ' Itemet Clent O Intemet Server |
[~ Port setting:
Por: [COM1 > Baudrate: [115200 | I Infrared port

¥ RTS/CTS handshaking

~Program setting
[T Passivemode [~ Manual mode only — Timeout [ms]: | 10000 'I

™ Restore the receiver's original baud rate on Disconnest

[ Intermet [ Client - Server ] zetting:

Hst ez flocalhost TR port: | 2000

Fassword; I

™| Display dataariserver [ Logserver events I~ | DHE lookup

" Tonnedt ™}

Cancel |

Figure 3-3. Connection Parameters

See “Starting PC-CDU” on page 1-5 for more information on the
parameters available for connection.

Disconnect

The Disconnect menu option closes the connection between a
receiver and computer.

m Disconnecting the receiver from the computer
iy before exiting prevents conflicts with serial port
management.

See “Closing PC-CDU” on page 1-24 for more information.
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File manager

The File Manager dialog box manages data logging and log files
collected with a TPS receiver.

Download Files

The Download files tab displays files for download to a computer or
deletion from the receiver’s memory.

Diownioad Hiss | Cunent o fie | Dewnload path |

Total memory: 15802320 bytss Fres memary: 10081512 bytes
Mane Size | Dats | Time
5_floor 100057 14.04.2003 151740
base 1631011 15.04.2003 73522
eph 80707 31022003 121013
static 391385 14.04.2003 15.27.22
fest 3316593 14.04.2003 16:4%03

Save tor C:h

I I™ Exclusive mode
Using: [Cunertport (COM1) =] Block size: [512bytes 7]
Dowrload | Delete | Fefiesh | Edt |

Figure 3-4. Download Files
The upper portion of the Download files tab has the following fields:

¢ Total memory — the total amount of memory available in the
connected receiver.

* Free memory — the amount of memory currently available in the
connected receiver.

The primary portion of the Download files tab has the following
fields:

* Name — the name of the log file.

* Size — the size of the log file.

* Date — the date the log file was recorded.
* Time — the time the log file was recorded.

* Download status — during a download session, indicates the
following status of the file(s) being downloaded:

— Blue icon: during download, indicates that the file is in the
queue for downloading.
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—Red icon: during download, indicates that the file is currently
being downloaded.

— Green icon: during download, indicates that the file was
successfully downloaded.

The lower portion of the Download files tab has the following fields:

* Save to — the path and location on the computer to which files will
be downloaded. Use the Download path tab to select the location.

» Exclusive mode — when enabled, increases the speed of data
transfer, especially if a baud rate of 115200 or higher has been
set. Using this option will disable most processes running inside
the receiver (including the satellite tracking process) in order to
ensure the highest possible file transfer speed. PC-CDU will
automatically close the current log file before downloading.

When disabled, the current log file can be downloaded without
being closed. This means that the download process will proceed
until the “end-of-file” point has been reached; however, new data
will continue to be logged to the file. This can cause the following
when downloading a file:

— Occasionally cause the download indicator to display values
greater than 100%.

— Cause the last record in the downloaded file to be corrupt.

* Using — the computer port used for downloading files (the same
port used to connect with the receiver and computer).

* Block size — the amount of data, in bytes, to download at a time.

The buttons on the Download files tab have the following functions:

* Download — begins the download process for selected log files. A
download path must be specified before beginning the download
process. See “Download Path” on page 3-16 for details.

* Stop — stops the download process.

* Delete — deletes the selected log files. Inadvertently deleted log
files can be retrieved if the receiver has not been initialized or its
NVRAM cleared.

» Refresh — reloads the list of log files.
* Exit — closes the File Manager dialog box.
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To select log files for downloading or deletion, use one of the
following methods:

* For adjacent files, click the first file. While holding the Shift key,
click the last file. All files between the two selected files will also
be selected.

* For a non-adjacent files, click the first file. While holding the
Ctrl key, click each desired file.

When downloading log files from a receiver, the files will retain their
original names and PC-CDU checks the destination folder for existing
files of the same name. If the destination folder already contains a file
with the same name as a file being downloaded, PC-CDU will ask to
overwrite the existing file or append new data to the existing file.

* If overwriting a file, the new file will replace the current file.

* If appending a file, the contents of the new file will be added onto
the contents of the existing file.

_ﬂ'r Typically, only use the Append option if the
iy download process has been interrupted and is now
: resuming.

PC-CDU

The file

5_floor.jps
alieady srists, Do you want to averwits the K o1 append ta it?

Append Cancel

Figure 3-5. Overwrite Confirmation Message

The status bar at the bottom of the Download files tab displays error
and other messages on the download status of log files.
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Current Log File

The Current log file tab displays current files and has fields for
creating new files.

[ File Manager ]

Download files  Cumert Iog file | Downlozd path |

Total memory: 15802320 bytss Fres memary: 10081512 bytes
Mane [ Size | Dats | Time: |
5_floor 100057 14.04.2003 15:17.40
base 1631011 15.04.2003 73522
eph 80707 31022003 121013
static 391385 14.04.2003 15:27.22
fest 3316593 14.04.2003 16:45.03

Current file: <none> Size: 0 bytes

File name: [rew_file Fecording intervat: [1.00 (seconds)
Site paiameters Elevaionmask: |5 (degiess]

Delete | Fefiesh | Eat | G |

Figure 3-6. Current Log File

The upper and primary portions of the Current log file tab have the
same fields as the Download files tab. See “Download Files” on
page 3-11 for details.

The lower portion of the Current log file tab has the following fields:

Current file — the name of the file that data is being logged to.
Size — the size of the current log file.

File name — either the entered name of a new file or the name of a
selected file (double-click the file to select it for this field).

Recording interval — the time in seconds between logging
recording. If the receiver does not support the entered interval, the
Output Period Setup Wizard will launch (see Appendix D for
details).

Site parameters — opens the Site Configuration dialog box. See
“Site Configuration” on page 3-15 for details.

Elevation mask — the minimum angle above the horizon, in
degrees, for satellites from which the receiver will record data.

The bottom row of buttons on the Current log file tab have the same
functions as those on the Download files tab. See “Download Files”
on page 3-11 for details.
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Site Configuration

The Site Configuration dialog box applies antenna parameters to the
pccdu.ini file for data logging purposes.

[ Site Configuration B

[ Site Parameters

Site: Name: Top_25
Antenna Status, Fixed =

[Antenna Parameters

Antenna Height (m], [159 I Slant
AniennaType: | TPSCR3_GGD -

¥ Send parameters automatically

TUHRTT] Sendtareceiver|  Cancel |

\
Figure 3-7. Site Configuration

* Site Name — the name of the jobsite (up to 20 alphanumeric
characters).

* Antenna Status — the status of the antenna; either fixed or moving.

* Antenna Height — the height of the antenna measured from the
survey marker to the measuring mark on the antenna (either ARP
or SHMM).

* Slant — if selected, indicates that the height of the antenna was
measured at a slant (to the slant height measurement mark).
When not selected, indicates a vertical measurement (to the
antenna reference point).

* Antenna Type — the type of antenna.

* Send parameters automatically — sends site and antenna
parameters to the receiver each time a log file is created.

* OK - copies the settings to the pccdu.ini file and closes the dialog
box. After clicking Start on the File Manager dialog box, these
settings will be enabled and inserted into the newly created log
file (unless Send parameters automatically has been disabled).

* Send to receiver — sends new site parameters to the receiver log
file and the pccdu.ini file during logging.

* Cancel — closes the dialog box without saving the settings.
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Download Path

The Download path tab displays the destination path and folder in
which to download files.

[ File Manager ]

Downioad fies | Current log fle  Download path |

GPS+GLN jps
GPS+GLN +options jps
GPS +GLN+optionsT.jps
GPS+GLN-+options2 jps
GPS +GLN-+options3.jps
GPS+GLNT jps

GPS +oplions. jps
GPS+options.jps
GPSonly s

GPSorlyT jps
pauld070000.jps

| | time: logging

[=c1 =
New folder: Create |

Figure 3-8. Current Log File

* Left panel — contains the computer’s hard drive directory and
associated folders. Use the directory tree to navigate to the
desired location in which to download log files.

* Right panel — displays the files currently in the selected folder.

¢ Drive selection — selects the drive that contains the location in
which to download files.

* New folder — specifies the name of a new folder.

¢ Create — creates a folder with the entered name on the selected
drive.

Files will be stored in the last specified download path.
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Real-Time Logging

The Real-Time Logging dialog box starts/stops logging data directly
to a computer connected to a TPS receiver.

Ed Real-Time Logging

!

ultiple fles | Select output path |

Save to; |Sitetps
Output path: DATPS files with Meteo data
GPS Satellites (10) GLONASS Satellites (4)
# [ el az|calm[pelzc] 1c] Receiver Position sn [ Fn | EL] az] cal P pafac] 1c]
o % 2 ¥ 1313 5 % 20008717194 for g7 27. 102 43 41 42 77§

2 S- 4R 2827 Y. ZIGMSIEI7 |08 06 30- 42 47 47 43 M 5
Z  G2472096857 |23 03 10- 74 B ¥ 2 M 0§
5

Vel 00083 mds 24 02 B1- 58 54 52 45 47

04 17 46 42 2 12 T
05 50 148 82 41 41 T
06 47+ 256 43 40 40 77

W13 120 4 2 2 7 PDOP. 14235

s ! Receiver date:  15.11.2008
. 7

2 14 B0 | 451 361 3617 Receiver time:  11:56:55

2 X+ 2 45 2B X T
30 77 223 55 46 46 7
3 3+ 36 46 34 35 46

Elapsed time: 00:00:00
Fieceived,

Recording interval: [1 [senonds] Site parameters | [ Stat Edt | Elevstonmask: [ (degrees)

v o on v anaon

Figure 3-9. Real-Time Logging

* GPS Satellites — displays information on signals from GPS
satellites. See “Elements of the Main Window” on page 3-1 for
more information.

Receiver Position — along with information from the Geo tab (see
“Elements of the Main Window” on page 3-1 for more
information), the following log file details display:

— Elapsed time: the amount of time that has passed since the
current log file opened. The time is reset to 00:00:00 for each
new file.

— Received: the size of the log file in bytes. Click Stop to view
the final size of the log file.

GLONASS Satellites — displays information on signals from
GLONASS satellites. See “Elements of the Main Window” on
page 3-1 for more information.

Recording interval — the time in seconds between logging
recording. If the receiver does not support the entered interval, the
Output Period Setup Wizard will launch (see Appendix D for
details).

This setting only affects files recorded in this mode.
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* Site parameters — opens the Site Configuration dialog box. See
“Site Configuration” on page 3-15 for details.

* Start/Stop — starts or stops recording data to the file. When
stopping data logging, the file will also be closed.

» Exit — closes the dialog box.

* Elevation mask — the minimum angle above the horizon, in
degrees, for satellites from which the receiver will record data.
This setting also affects the Terminal Elevation Mask setting (see
“General” on page 3-28 for further information on this setting).

ﬂT In real-time data logging mode, enable the RTS/
CTS handshaking checkbox and set the baud rate to
115200 or higher when connecting the receiver and
computer.

[WARNING )

ﬂT Unlike downloading recorded log files from the
receiver onto the computer, real-time data logging
does not use error detection/correction protocol in
the course of the data transfer. As a result, some
messages in the created TPS files may be corrupt
(due to the serial port overrun or similar problems);
that is, some of the transferred bytes may be lost on
the computer end.

[WARNING )
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Single File

The Single file tab displays satellite and log file information, as well
as applies file parameters to a single file during real-time data logging
to the computer.

Ed Real-Time Logging El

Multiple files | Select output path |
Save to; |Sitetps
Output path: DATPS files with Meteo data

GPS Satellites (10) GLONASS Satellites (4)
# | el az|calm|r2| 2] 1c] Receiver Position sn (Fn | EL| az] ca] P P2]ac] 1c]
m 9. 2% 3 13 13 7 5 % 285067117134 o1 o7 27+ 102 43 41 42 7?5
02 5. 74 52 42 42 7 5 Y- 21994538107 o3 05 30- 42 47 47 43 %7 5
04 17~ 46 42 22 22 7 5 7 BM472098857 (23 03 10- 74 3B 7 2 M 5
05 50~ 148 52 41 #1 T 5 ver  00083mds 24 02 Bl- 56 54 52 45 47 5
0 1 T @ oo o FOUF 1

+ -

3 e B 45 3 35 o> 5 Hecsherdeer 15112006
%5 ofe 12 45 o8 20 20 5 Recewvertime  11:56:58
M 7 228 55 46 46 7P 5 Elasedtime  00:00:00
A F+ 6 46 34 B 4 5 Aeceived
Recording intervak [1 {seconds) _Site paramaters | [_Stan Exit_ | Elevationmask: |5 (=)

Figure 3-10. Real-Time Logging — Single File

Along with the fields and button discussed in “Real-Time Logging”
on page 3-17, the Single file tab has the following fields:

* Save to — the name of the file in which to log data. By default, this
name will be the same as the name entered in the Site
Configuration dialog box.

e Output path — the location in which files will be saved. See
“Select Output Path” on page 3-24 for selecting this location.
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Multiple Files

The Multiple files tab displays satellite and log file information, as
well as applies file parameters to a multiple files during real-time data
logging to the computer.

Real-Time Logging, EI
Single fle Muliple fies | Select autput path |

Prefiz: |Site Numbering: | Ascending Count v | Mew file every |1 hours  w| [V Autoconwert to RINEX
Cunent file: Start Count: |0 Jv Owensrite existing files Setup converter

Dutput path: D:ATPS fies with Meteo data
GPS Satellites (10) GLONASS Satellites (4)

# | el az|calm|r2|ac] 1] Receiver Position sn (Fn | EL| az] ca] P P2]ac] 1c]

m 8. 29 3 16 15 77 7 % 28506714035 o1 o7 28+ 100 42 41 42 7?7

02 5. 74 53 42 42 P 7 Yo 21994534727 o3 05 30- 42 47 45 43 % 7
04 16~ 46 39 19 19 P 7z 547037153 (23 03 8- 74 38 37 W A7
05 49~ 148 51 40 40 P 7 ver  00%Imis 24 02 53 58 54 53 45 45 7
06 48+ 256 52 41 M1 P 7 ppop 1a42n

M 14+ 120 40 20 20 P 7 .

3 i B 45 3 3§ o» gy Hecsherdeter 15112006

%5 o7e T2 45 a a o 7 Recewvertime  11:53:21

WM 7 224 54 46 46 7?7 Elasedtime  00:00:00

A 3+ 34 45 34 B 45 7 Received

Edit | Elevationmask [ degrees)

Recording interval [1 {seconds) _Site parameters |

Figure 3-11. Real-Time Logging — Multiple Files

Along with the fields and button discussed in “Real-Time Logging”
on page 3-17, the Multiple files tab has the following fields:

* Prefix — the beginning part of the name for each file. By default,
the site name entered in the Site Configuration dialog box will be
used.

* Numbering — the numbering scheme for file names. This number
will be added to the prefix of the file name.

— Date & Time: YDDDHHMM; where “Y” is the last digit of
the current year, “DDD” is the day of the year, “HH” is the
hour in the receiver time scale, and “MM” is the minutes in
the receiver time scale.

The date and time used for the filename corresponds to the
first epoch recorded into the file

— Ascending Count: the numeric portion of the file name will

vary between 0000 and 2°' 1. This number will increase by
one with each file. (Selecting this option enables Start
Count.)
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New file every — the interval between closing one file and
opening the next file. Note that files may be shorter than the
interval entered in these fields.

— Enter an integer to measure the interval.
— Select the unit of time (day, hour, or minute).
Autoconvert to RINEX — automatically converts new TPS files to

RINEX after closing the file. Some agencies and third-party
software only process RINEX files.

-ﬂT The “tps2rin.exe” file is required for the
xId  Autoconvert to RINEX function to work properly.

Current file — the name of the current file being recorded.

Start count — enabled when Ascending Count selected, the first
number to use for file counts. This number is added to the prefix
to create file names.

Overwrite existing files — writes over existing files that have the
same name as new files. A warning will display after clicking
Start.

Real-Time Logging [<]
@ Al files with such names as Site000.ps, Site000T.jps ete.

resicing in the folder E-4c-s-dbhaw._data
will be ovenwniten withaut waming, Cantinue?

Yes No
[ e ]

Figure 3-12. Overwrite Existing Files?

Setup converter — accesses setup options for the tps2rin.exe
converter. For more information, see “Converter to RINEX
Setup” on page 3-22.

Output path — the location in which files will be saved. See
“Select Output Path” on page 3-24 for selecting this location.

Figure 3-13 on page 3-22 shows an example of recording multiple
files. The graph shows a time scale divided into intervals equal to the
period specified in the New file every fields. After clicking Start, the
file records the time and file name and begins logging data. Once the
time interval has been reached, the file will be closed and a new file
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will open. The time duration of the second and all following files will
equal the selected file period.

After clicking Stop, PC-CDU will close the last file. Because the end
of the time interval may not have been reached, the last file can be
shorter than previous files.

- .,
. \

Duration of first file

i

; Duration of second file Duration of last file :
: — i
E | 1 1 1 1 1 1 A
B I T T T T T T »
i

i

i 0h0OOM00s  n 2n 3n 4n (i-1)n i+1

-+- = opening of first file
+ X = closing of last file

i
i
i
i
i
i
i
i
i
i

\ n = period specified in “New file every”

AN T

Figure 3-13. Generation of Multiple Files

Converter to RINEX Setup

The Converter to RINEX Setup dialog box applies options to the
tps2rin.exe converter for the TPS file-to-RINEX data conversion.

[ Converter to RINEX Setup ']
Propettie:

Runby:  [Operator

Observer,  [Surveyor
Agency  [TPS
Antenna # [0032 Antenna type: [TOP_CR3_GGD

Comment: | This comment will appear in the RINEX fies

Marker name:  [AUG

Marker number; [002

[~ Convarter

Application: |C:ARINEX convertertps2iin.eve Erowse
I™ Exclude GPS ™ Exclude L1

I™ Exclude GLONASS ™ Exclude L2

I™ Delete source JPS files after successful conversion

Addional options: |

UK I Cancel |

Figure 3-14. Converter to RINEX Setup

Information entered here will be included in the header of the
corresponding RINEX files.

* Run by — name of the person or agency launching the converter.
» Observer — name of the person collecting the data.

* Agency — name of the agency responsible for collecting the data.
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¢ Antenna # — serial number of antenna. This number twill be
copied into the RINEX files.

* Antenna type — description of antenna (use only antenna names
approved and standardized by NGS). This description will be
copied into the RINEX files.

* Comment — further notes about the job. Any text entered here will
appear in the header of each RINEX file to be generated.

* Marker name — survey marker name.
* Marker number — survey marker identification number.
* Application — the full path to the “tps2rin.exe” file.

* Browse — opens Windows Explorer for navigating to and
selecting the “tps2rin.exe” file.

* Exclude GPS and Exclude GLONASS — during the conversion,
leaves out all raw data measurements/ephemeris data
corresponding to GPS and/or GLONASS satellites from the
resulting RINEX files.

* Exclude L1 and Exclude L2 — during the conversion, leaves out
all L1 and/or L2 raw data measurements from the resulting
RINEX files.

* Delete source JPS files after successful conversion — remove the
original *.tps files once the conversion to RINEX format
successfully completes. Deleting source files (if raw data files are
not required) after a successful conversion will save computer
disk space.

» Additional options — applies any of the command-line switches
available for the RINEX converter to modify the converter’s
behavior. For more information about the switches, refer to the
Free Software section on the TPS GPS website
(http://www.topcongps.com/software/tps2rin.html).
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Select Output Path

The Select output path tab displays the path (disc and folder) where
logged raw data will be stored.

EdReal Time Logging ]
Single e | Muliple fies ~ Select autput path |
5 T

= Frogram Files
[= Topeon

I F) HiPet Pro Plus Lite 09-04

&= c: [new volume] =1
Mew folder: Ea |

Figure 3-15. Real-Time Logging — Select Output File

* Left panel — contains the computer’s hard drive directory and
associated folders. Use the directory tree to navigate to the
desired location in which to download log files.

» Right panel — displays the files currently in the selected folder.

¢ Drive selection — selects the drive that contains the location in
which to download files.

* New folder — specifies the name of a new folder.

¢ Create — creates a folder with the entered name on the selected
drive.

Files will be stored in the last specified download path.
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The Manual Mode dialog box provides an interface to manually send
commands to a connected receiver and view the responses. For a
complete list of commands TPS receivers support, refer to the GRIL

Reference Manual.

Become familiar with the GRIL Reference Manual
@  before sending commands via Manual Mode.

[ Manual Mode

M8 [=] 3

L]

oo,
oo,
oo,
oo,
oo,
oo,
oo,
oo,
oo,
oo,
oo,

o.

o.

o
o
o
o
o.
o
o
o
o

oo,
.00,
.00,
.00,
.00,
oo,
.00,
.00,
.00,
.00,
oo,

REO23%%/msy/ nmea={ GGA={1.
REOD19%% GLL={1.
REOD19%% GNS={1.
REOD19%% GRI={1.
REOD19%% G3a={1.
REOD19%% G3T={1.
REOD19%% G3V={1.
REOD19%% HDT={1.
REOD19%% RMC={1.
REOD19%% ROT={1.
REOD19%% WTG={1.
REOD19%% ZDa={1.
REO1B%% P_ATT={1.00,0.0

Send command | Stop all messages

o
o
o
o
o
o,
o
o
o
o
o
0

Clear window

00,0.00,0,0x0},
,0x0},
,0x0},
,0x0},
,0x0},
,0x0},
ox0},
,0x0},
,0x0},
,0x0},
,0x0},
,0x0},
L0, 0%0%

=

ol

Exit Disconnect | Startlogging |

Load script Path: E:he-s-dbiScripts for base and rover

Edit script

Figure 3-16. Manual Mode (with Sample Commands/Responses)

* Command line (and drop down box) — the currently entered
command to send to the receiver. The drop-down box contains the
last 20 command lines entered since connecting with the receiver.

* Main window — displays commands sent to the receiver and

responses from the receiver.

¢ Send command — sends the entered/selected command to the

receiver.

* Stop all messages — stops outputting messages from the receiver
to the current terminal.

¢ Clear window — clears all messages from the main window.
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 Exit — closes the dialog box.

* Disconnect — disconnects the computer and receiver and keeps
any configuration changes.

* Start logging — copies the current Manual Mode session’s
commands and responses to a file on the computer.

» Load Script — sends a pre-recorded script file to the receiver. The
location of a loaded script displays next to the button.

>~ Script files make sending commands to the receiver
a quick process.

 Edit Script — creates/modifies a script file of commands.

Exit
Closes PC-CDU.

Simply closing PC-CDU does not disconnect the
receiver from the computer. For serial port
management, click File » Disconnect before
exiting.
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Configuration Menu

The Configuration menu contain options for configuring the receiver
as a Base or Rover, configuring the receiver’s ports, configuring raw
data logging, configuring the internal and an external antenna, and
entering target coordinates.

Receiver

The Receiver Configuration dialog box displays the receiver’s
current configuration, as well as provides fields and settings for
editing a configuration for a job.

| MINTER | Posiioning| Base | Raver | Parts | Events | Advanced|

[~ Pawer
"Elevalmn mask [degrees) Pawer 1 Waltages [voltsh——

Termninal Elevation Mask : 5 Mode Auta B Extermal: |11.°

Current Mode = |=0

ntenna "Antenna Status [read onlyl—— OnBoard: [ 1

" Intemal Bt e |'Ex. Charge——— Battery &+ [7.53
€ External Mode s T
Ext DC Status : [nomal l__l Battery B« |3.17

* Aulo Speed
T [Celsius dearees} Curerthoge: [T || Charge [15 |
Board temperature
Cunent [amp): [0.616 OnPorts: [6.52
~Power output modes——— [~ Tum on/off Slots——
Parts : On - ¥ Slot 2 (C]
[ Slat 3 )
Slots On || ® slam

¥ Enable Low Power Mode

Refiesh | gl

OK_| Est | Save | Setal parameters to defauls |
[

Figure 3-17. Receiver Configuration
Buttons common to all tabs include the following:

* Refresh — updates the current tab with the latest information from
the receiver.

* Apply — sends configuration settings from the current tab to the
receiver without closing the dialog box.

* Ok - sends configuration settings from all tabs to the receiver and
closes the dialog box.

* Exit — closes the dialog box without saving changes (since the last
time the Apply button was used).
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» Save — saves the current receiver configuration to a script file.

Save setup to a script
Savein | L) PCLDU =l & & ek B

HiPer Pro Flus Lite 03-04

File name:  [wssHiPerPio Save N
Save s type: [PC-COL Seript =l Cancel

Figure 3-18. Save Setup to a Script

* Set all parameters to defaults — returns all settings to factory
defaults.

General

The General tab contains basic antenna and power parameters
common to all receiver configurations.

[ Receiver Configuration
[General | MINTER | Positoning | Base | Rover | Ports | Events | Advanced|

Elevation mask [degrees| sl Er——
{Telmma\E\EvatiunMask. 5 Mode: Auto - Extemal: W
t
r— e T — Gt g OnEBoard: [71
© Intemal Fr | —
Curent Input: =+ =l
€ Exterl ( ® e bode [ =] || Botewa: [0
5 Ext, DC Status - [romel
@ ars Speed [ =] Batews: 17
; d (Eeioekmas] l— Curent Mode: |b Charger: |219
oard temperature
’ Current (4mg): 1676 OnPars: [6:59
~Pawer autput modes | [ Tum an/off Slots |
Poits : an - ¥ Slat 2 (C)
W Skt 3]
Slats on 1 || & sets )
[# Erisbls Lo Posssr Mods
Refiesh | ooy

Ok I Ezit Save St all parameters to defaults

Figure 3-19. Receiver Configuration — General

* Elevation mask (degrees) — the minimum angle above the
horizon, in degrees, for satellites from which the receiver will
record data.

* Antenna — selects the antenna type used with the connected
receiver, either Internal, External, or Auto.

¢ Antenna Status — shows the actual antenna the receiver uses.
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— Current Input: either “int” for internal antenna or “ext” for
external antenna.

— Ext. DC Status: shows if the external antenna draws DC
power; either “off”” for no power, “normal” for normal power,
or “overload” if the antenna draws higher power than
expected or a short circuit occurs in the antenna or antenna
cable.

» Temperature — shows the receiver board's current temperature in
degrees of Celsius.

» Power — selects and shows the source of power.

— Mode: sets the desired power source for the connected
receiver (may vary depending on the connected receiver).

Auto — receiver will automatically select the power
source.

Mix — receiver will automatically consume power from
the source with the highest voltage.

Battery A — receiver will consume power only from
battery A.

Battery B — receiver will consume power only from
battery B.

External — receiver will use an external power supply.
Prefer A —receiver will use the batteries in sequence: first

A, then B, A, B, and so on. In this case, battery B will last
1 to 2 hours longer.

Prefer B — receiver will use the batteries in sequence: first
B, then A, B, A, and so on. In this case, battery A will last
1 to 2 hours longer.

— Current mode: shows the current power source.

For the GR-3 receiver, this field shows “Extbat” if
the receiver consumes power from the battery
charging cradle.
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» Charger — applies charging settings for the battery.

— Mode: the battery charging mode (may vary depending on the
connected receiver).

* On — receiver automatically detects and charges both
batteries.

* Off — receiver will not charge the batteries.
* Charge A —receiver will charge only battery A.
* Charge B — receiver will charge only battery B.

* Auto — receiver will automatically detect and charge the
detected batteries.

— Speed: sets the speed for a battery charge cycle (not available
for all receiver models); either “Normal” of “Fast”.

— Current mode: displays the battery currently being charged.
— Current (Amp): displays the actual battery charging current in
Amperes.

* Power output modes — only applicable to Odyssey, Odyssey-E,
and HiPer family receivers, governs power output to ports and
slots.

— Ports A, B: available for the Odyssey receiver, turns power
on/off for ports A and B.

— Port C: available for the Odyssey receiver, turns power on/off
for port C.

— Ports: governs power output on the serial ports.

* On — when the receiver is turn on, the power board power
all available serial ports. If the receiver is turn off, no
power will be sent to the ports.

* Off — power will not be powered, even if the receiver is
turned on.

* Always — all serial ports will be powered even if the
receiver is turned off.

— Slots: governs power output to the receiver’s internal slots.

¢ On — when the receiver is on, all internal slots will
receiver power. If the receiver is turned off, no power will
be sent to the slots.
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* Off — internal slots will not be powered, even if the
receiver is turned on.
* Always — all internal slots will be powered even if the
receiver is turned off.
* Voltages — the current power voltage state of the external power

supply (only if connected), receiver board (actual voltage),
batteries, charger (internal charger), and ports (first pin of each

port).
* Turn on/off Slots — only applicable to Odyssey-E, HiPer, and
GR-3 family receivers, enables the corresponding internal slots.

* Enable Low Power Mode — enables the receiver’s processor for
low power consumption.

MINTER

The MINTER tab contains receiver parameters that correspond to
MINTER operation and to data logging.

[ Receiver Configuration
General MINTER| Positoning | Base | Fover | Patts | Events | Advanced |

P 00| [seconds) E—
Elevaton ek frLogfie:  [5 (éearees) ((-‘ ED e W (Bt s
e e B T

e e (G Stallc  Kinemaliz

Files Creation mode Data recording auto-start
[ﬁ Log file  AFRM ‘ ’7(? 0ff © On © Always

[Automatic File Rotation Mode [4FRM) parameters

Fesfod [ses] [ 3600 Files {tat= ;. [0

Phase (sec]; [0 Files {remain] [0

I= Automaticall remaye old fies

Rehiesh Aprly

Exit Save | Setal parameters to defaults
I

Figure 3-20. Receiver Configuration — MINTER

» Recording interval — specifies the interval to use for logging data
after pressing the FN key. This parameter applies to both Log file
and AFRM modes. If an incorrect recording interval is set for the
connected receiver, the Output Period Wizard will start (see
Appendix D for details). Values are 0 to 86400 seconds; the
default is 1 second.
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* Elevation mask for Log file — specifies the minimum angle for the
satellites whose data will be logged after pressing the FN key.
The default is 5 degrees.

* File name prefix — specifies the prefix added to data files after
pressing the FN key. Log files have a “<prefix><month><day>
<sequential alphabet letter>" format. The prefix can be up to 20
characters long; the default is “log”.

* Always append to the file — specifies the name of an existing file
to append new data to. The file name can be up to 20 characters.

* File Creation mode — determines the process for creating new
files after pressing the FN key.

— Log file: if enabled, closes the current log file; if disabled,
opens a new log files.

— AFRM: if enabled, disables this mode; if disabled, enables
this mode.

» Automatic File Rotation Mode (AFRM) parameters — closes
current files and opens new files (file rotation) according to the
entered parameters.

— Period (sec): specifies the time duration for log files created
in AFRM mode. Values are 60 to 86400; the default is 3600.

— Phase (sec): specifies the constant time shifts of log files
created in AFRM mode. Values are 0 to 86400; the default is
0 (zero).

— Files (total): specifies the total number of files to create
before turning off AFRM mode (not including the first file

created). Values are O to [231—1]; the default is O (zero). A
zero value will create an unlimited number of log files.

— Files (remain): specifies the number of files remaining before
AFRM mode turns off.

— Automatically remove old files: when no memory remains,
automatically removes the earliest log file. The receiver will
erase the file with the earliest time/date. The default is
disabled.
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* FN Key mode — programs the receiver’s reaction to the FN key.

— LED blink mode switch: switches the receiver between
standard and extended information modes.
In standard mode, the STAT LED shows tracking
information.
In Extended Information Mode (EIM), the STAT LED shows
the status of different internal modules and algorithms. Refer
to the receiver’s Operator’s Manual for details.

— Occupation mode switch: switches the receiver between static
and kinematic survey modes. A message will be inserted into
the log file indicating this switch.

* Initial data collection dynamic mode — specifies the starting
occupation type, either Static or Kinematic. For Static mode, the
log file will indicate “STOP”; for Kinematic mode, the log file
will indicate “GO, TRAJECTORY™.

* Data recording auto-start — programs how the receiver will
behave in the event of power failure. If Always enabled, the
receiver will automatically start logging data to a new or existing
file in the following situations:

— After turning on the receiver using the power key.

— After resetting the receiver (using PC-CDU or the Reset key).

— After taking the receiver out of sleep mode.

Table 3-3 describes receiver behavior and data logging in the
event of power failure (“specified file” refers to the file name
entered in the Always append to file field).

Table 3-3. Receiver Behavior Due to Power Failure

Before Enabled Radio Button Results

Power

Failure Off On Always
Data logged Datalogging will | Receiver will Receiver will resume
to file not resume when | resume data data logging to the
specified. power is restored. | logging to the same file when power

same file when
power is restored.

is restored.
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Table 3-3. Receiver Behavior Due to Power Failure (Continued)

Before Enabled Radio Button Results

Power

Failure Off On Always
Data logged Datalogging will | A new log file A new log file will
to default file. | not resume when | will open when open when power is

power is restored. | power is restored | restored and data will
and data will log log to this file.
to this file.

Data logging No file will open | No file will open | A log file with this

not started with this name. with this name. name will open and
and file Datalogging will | Data logging will | datalogging will start
specified. not start when not start when after power is

power is restored. | power is restored. | restored.

Data logging Datalogging will | Data logging will | A log file with a

is off and no not start when not start when default name will

file specified. | power is restored. | power is restored. | open and datalogging
will start after power
is restored.

Positioning

The Positioning tab contains parameters that correspond to elevation
and PDOP masks, the satellites to track, and the measurements to use
in position computation.

[ Receiver Configurati ]
General | MINTER {Pasi Base | Rover | Parts | Events | Advanced |
~Positioning Mods: ~Enable Solution Satelite
 Standalone el e Satelites hacked Satelites used in pos
€ DGPS (Code Differential) || I DGPS ¥ GPS 7 GLONASS | | W GPS[V GLOMASS
= FTK Flaat I# | AT Floal
 RTK Fired ¥ | RITK: Fised GFS | GLonass | wass)
Positioning Masks———— ~Pastioning System— [ e P e e P = PR )
Elevation mask |5— ¥ GPS P P P
[degres] - v v ¥ W BF M #BF
PDOP mask:  |30.00 [# GLONASS WP NFE P 198 B 28"
¥ RAIM Enabled Messurements ey || 42 P RF VAR F 2P F
alam:  [Nonmecoan =] & CA/L AT TR K T P T T A I
e on-precision ;Eﬁﬂ SR UFF 2F F WF
e it 1] [FF5E gl IF R 15F % BFF AF
iV v 6V ¥ ANV ¥ 2
Current Datum - - '
et Batm | Ll leneLonzetion Alltalock | None tolock]  Allto use | Nane to use|
Datum Porameters | 17 T1oPe Lenzction

Advanced Poslioning Getiings. || Rehesh | [ Aecl |

[0k | e Save | Set all parameters ta defaults |
I

Figure 3-21. Receiver Configuration — Positioning
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* Positioning Mode — selects a positioning mode for the receiver.

* Positioning Masks — specifies the elevation positioning mask for
position computation and PDOP mask for disabling position
computation.

— Elevation mask: the minimum angle above the horizon, in
degrees, for satellites from which the receiver will record
data. The default is 5 degrees.

— PDOP mask: the receiver will not compute positions over the
corresponding epochs while PDOP exceeds the entered
threshold value. The default is 30.

* RAIM Enabled — (Receiver Autonomous Integrity Monitoring)
the receiver continuously checks whether or not signals received
from satellites are usable. If a fault is detected, this parameter will
exclude the satellite(s) from positioning calculations.

— Alarm: specifies the alarm limit mode. “Non-precision” has
an alarm limit of 0.3 nmi, “Terminal” has an alarm limit of
1.0 nmi, “En route” has an alarm limit of 2.0 nmi, and
“Manual” sets a user-defined alarm limit.

— Alarm limit: specifies the threshold value for the horizontal
radial error; RAIM will detect errors equal to or greater than
the entered value.

Editable only available if “Manual” selected from the Alarm
drop-down list, a range of 10.0 to 10000.0 meters can be
entered. The default is 555.6 and corresponds to Non-
precision approach.

e Current Datum — selects the datum to use in position
computation. The default is WGS 84.

Currently, TPS receivers support more than 200 datums. Refer to
the GRIL Reference Manual for a list of supported datums.

NMEA messages (such as, GGA, GLL, etc.) can be used to view
the receiver position when computed in a datum other than WGS
84. Position-related TPS messages (for example, PV) always
contain coordinates computed in WGS 84.

* Datum Parameters — opens the USER Datum Parameters dialog
box for view and edit ellipsoid and transformation parameters.
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Only user-defined and P90! datums can be edited. See “USER
Datum Parameters” on page 3-38 for more information.

* Enable Solutions — selects the type of solution to use for Rover
receivers.

— Standalone: for a Rover receiver run in differential mode,
reports the current standalone position if a DGPS (or RTK)
position is unavailable in the current epoch.

— DGPS (Code Differential): for a Rover receiver run in RTK
Float or RTK Fixed mode unable to obtain an RTK solution at
the current epoch, outputs the current code differential
position.

If enabled and DGPS solution cannot be obtained, enable
Standalone to have the receiver output single-point positions
for the unavailable differential positions.

This mode requires the Base (Reference) receiver to
broadcast DGPS (not RTK) messages and the Rover receiver
to receiver these messages. If either of these requirements are
not met, enabling DGPS (Code Differential) will have no
effect.

* Positioning System — enables using either or both GPS/
GLONASS satellite systems during position computation. The
corresponding Satellites used in pos. parameter must also be
enabled.

* Measurements Used — not available for single-frequency
receivers, selects the code measurement to use when computing
the receiver’s standalone position. This parameter applies only to
absolute position computation.

¢ JTono-Correction — pseudoranges will be corrected for ionosphere
(based on the model defined in ICD-GPS-200, Revision C) before
being used in position computation. This parameter applies only
to absolute position computation.

1. P90 is the datum ID for the GLONASS reference frame PZ-90 (PZ
stands for Parametry Zemli or “Parameters of the Earth”).
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If both Iono-Free and lono-Correction fields are selected, the
Iono-Free parameter overrides the lono-Correction parameter.s

* Topo-Correction — pseudoranges will be corrected for
troposphere before being used in position computation. This
parameter applies only to absolute position computation.

* Satellites tracked — enables tracking either or both GPS/
GLONASS satellite systems.

* Satellites used in pos. — enables using either or both GPS/
GLONASS satellite in position computation.

* GPS, GLONASS, and WAAS - specifies the satellites to track
and use for position computation.

Table 3-4 on page 3-37 describes the fields and parameters on
these tabs.

The GPS and GLONASS tabs have the following common
selections:

— All to lock and All to use — selects all satellites.

— None to lock and None to use — deselects all.

Table 3-4. Descriptions of GPS, GLONASS, and WAAS Tabs

GPS tab

pin|lock|use| pmlock|use| prajlock use) pm)lock u:

¢ prn — pseudo-random noise code numbers for GPS
satellites.

=i . L -
i B e e T lgck indicates tl}at the satellite is enabled/
(PP WR R BF R %R disabled for tracking.
IFF NF P R B 2R P L o .
b up e ar b me g | | use—indicates that the satellite is enabled/disabled
5F P BRF 2F P BF F for using in position computations.
e R PY ol el il 1] ol
IFE BR R AR R AR R
Yl R T ol T il - ol
Alltalock | Nonetolock| Allto use | Nore to uss|
GLONASS tab * Frequency Channel Number — displays the fcn
(BLONASEY column
Satellite Murnbs H
= Fiseuaniy Chorrel Nunber € Sl Nuber * Slot Number — displays the sat column
fonlackluse! fenllockluse| fenlloekduse| fenllockluse| | | @ fen/sat — the frequency channel numbers or the slot
I1FF PP BFF BEF .
EE SE R UEE AR numbers for GLONASS satellites.
3P s 15k 2k | e Jock — indicates that the satellite is enabled/
IFF NWFF BFF 2FF . .
SV NF W 1IFF BFF disabled for tracklng.
EFMV 12 F 1BF F uF

Alltalock | Nenetolock] Alltause | Noneto use|

* use —indicates that the satellite is enabled/disabled
for using in position computations.
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Table 3-4. Descriptions of GPS, GLONASS, and WAAS Tabs (Continued)

WAAS (EGNOS) tab

A WAAS/EGNOS-enabled
receiver will simultaneously
track two WAAS or two
EGNOS satellites. Each
satellite is allocated its own
channel.

was |
¥ Channel 1

setwiaas: (120 3] asEps: |1 %

Interpret message B0 as message: # [0 =
Use lono Canections: ¢ Never ¢ If exist & Only

¥ Thannel 2
setwiaas: (120 3] asEps: |1 %

Interpret message B0 as message: # [0 =
Use lono Canections: ¢ Never ¢ If exist & Only

[ Enable output of "tue” Wass PRN numbers

* Channel 1 and Channel 2 — specifies the settings

for receiving WAAS (EGNOS)? satellite signals.
¢ Set WAAS (EGNOS) — associates a WAAS
(EGNOS) PRN with a GPS PRN.

* as GPS — the GPS PRN to associate the WAAS/
EGNOS PRN with.

* Interpret message #0 and message # — disables
message 0 (zero).

* Use Iono Corrections — applies an ionosphere
correction mode.

— Never: ignores any iono corrections.

— If exist: all acquired satellites will be used in
position computation, even if iono correction
are unavailable.

— Only: only satellites with available iono
corrections will be used in position
computation. This is the default.

* Enable output of “true” WAAS PRN numbers —
WAAS satellites will be indicated with their true
PRN numbers in satellite indices messages rather
than associated with a GPS PRN number.

a. WAAS satellites with PRNs 122 and 134 or EGNOS satellites with

PRNs 120 and 131.

USER Datum Parameters

Accessed from the Positioning tab, the USER Datum Parameters
dialog box contains fields for editing ellipsoid and transformation

parameters.

[ USER Datum Parameters X

Cunent Diatum

[~ Transfomation parameters

Reference Datum : |\W/34 =

Translationd:  |-145 [l

USER >
Translationdy:  |-63.0 [l

TranslationdZ:  |183.0 [m]
Ricfercnce Elipsoid parameters Hetation Fi o0 -
Elipsoid D U- Riotation Fiy +0.00000 1]
Semimaiorais:  [6375260 | [ml| | RoraionFe +0.00000 "]
Iverss flstering: |236.257223563 — +0.00000
ok | Cencel | meresh |ETTEER

Figure 3-22. USER Datum Parameters
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* Current Datum — selects pre-defined datums or allows setting
user-defined and PZ-90 datums.

» Reference Ellipsoid parameters — defines the ellipsoid.

— Ellipsoid ID: the two-letter identification code for the
ellipsoid. Display “U-" for user-defined ellipsoids.

— Semi-major axis: only available for “User” or “P90” datums,
the length in meters of the semi-major axis of the ellipsoid;
This value has a 6300000.0 to 6500000.0 range.

— Inverse flattening: only available for “User” or “P90” datums,
the reciprocal of the ellipsoid flattening (dimensionless). This
value has a 280.0 to 310.0 range.

» Transformation parameters — only available for “User” or “P90”
datums, applies transformation settings to the selected datum.

— Reference Datum: only available for “User” datums, the
datum relative to the user-specified transformation
parameters.

— Translation dX: the shift value along the X axis used to relate
the origins of a pre-defined or user-defined datum and the
selected reference datum. Ranges are from -10000.0 meters
to +10000.0 meters.

— Translation dY: the shift value along the Y axis used to relate
the origins of the two datums. Ranges are from -10000.0
meters to +10000.0 meters.

— Translation dZ: the shift value along the Z axis used to relate
the origins of the two datums. Ranges are from -10000.0
meters to +10000.0 meters.

— Rotation Rx: the rotation angle around the Y axis used to
relate the orientation of the two datums. Ranges are from -60"
to +60".

— Rotation Ry: the rotation angle around the Y axis used to
relate the orientation of the two datums. Ranges are from -60"
to +60".

— Rotation Rz: the rotation angle around the Z axis used to
relate the orientation of the two datums. Ranges from -60" to
+60".
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— Scale: the scale factor used to account for any changes in
scale between the two datums. Ranges are from -1000 ppm to
+1000 ppm.

* OK - saves changes and closes the dialog box.

* Cancel — closes the dialog box without saving changes.
» Refresh — reloads/updates the setting on the dialog box.
* Apply — saves changes without closing the dialog box.

Base

The Base tab contains parameters for configuring the receiver as a
reference station.

Eﬂ Receiver Configuration g|
Gieneral | MINTER | Fsitioning © | Fawer | Pants | Events | Advanced |

Base Station Coordinates

Py N —— Lat [55 "[43 " [2106536 "[W =]  Get from receiver

(" Antenna Reference Point Lorc[37 "[33 ' [4na4me "[E -

Antenna Type: [TPSGR_3 ~| At [1e5aa7

RTCM Settings CMR Seltings

Antenna

StationiD:|0 Seral#: | Station 1D: [0 Motian : [Unknawn ]

Hes: |Good =] Setup ID: o | oGa |

Mas. number System Used Lergin: |

of Satelites - |? ¥ GFS ¥ GLONASS GLONASS message T =

Pseudoangs Measurements Sent Measurements Sent

smaathing I @ catd P @ PA2 @ Ca/ll © P W OPAZ

Configuration of Fieceiver Farts |
Ficfiesh tppl |

[0k ] Est | Save | Setal paameters to defauls |

Figure 3-23. Receiver Configuration — Base

* Base Station Coordinates — enters geodetic coordinates of the
base antenna’s L1 phase center or antenna reference point
depending on the selected option and specifies the antenna type.
The geodetic coordinates should be in WGS-84.

— Lat: the latitude of the antenna in degrees, minutes, seconds;
the hemisphere (N or S) in which the antenna resides; the
datum that corresponds to the entered coordinates.

— Lon: the longitude of the antenna in degrees, minutes, and
seconds; the hemisphere (E or W) in which the antenna
resides.
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— Alt: the height of the antenna above the ellipsoid, in meters.

— Antenna Type: the antenna type identifier used in RTCM 3.0
and CMR formats.

— Get from receiver: sets the base station coordinates to the
most recent position the receiver produced.

* RTCM Settings — applies parameters to RTCM messages.

— Station ID: assigns a separate station ID to each reference
station working in the area. The values can be 0 (zero) to
1023; the default is zero.

This ID allows the Rover receiver to easily identify the
reference station from which it receives RTCM messages.

— Health: defines the status of the Base receiver (“Good” for
normal operation, “Bad” for abnormal operation, or the
health status “Unknown”).

— Max. number of Satellites: the maximum number of satellites
allowed for use in RTCM messages types 18 through 21; 0
(zero) indicates that all available satellites will be included in
these RTCM messages.

For RTK systems with a modem baud rate of less than 9600
bps, restrict the number of satellites used in these messages.
This will limit the amount of data the Base transmits to the
Rover and prevent data link overload.

If the number of satellites in view exceeds the value entered,
these RTCM messages will include data only from satellites
with a higher elevations. Also, the number of satellites
included in RTCM messages will not exceed the value
entered.

— Pseudo-range smoothing: smoothed pseudo-ranges will be
used in RTCM message types 19 through 21.

— Antenna, Serial #: an antenna serial number. Applies to
RTCM 3.0 only.

— Antenna, Setup ID: informs the user about any change at the
base station that affects the antenna phase center variations.
Applies to RTCM 3.0 only.
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— Systems Used: the satellite systems included in RTCM
message types 18 through 21.

— Measurements Sent: the measurements types to include in
RTCM message types 18 through 21.

Currently, C/A measurements will always be included
(corresponds to single-frequency receivers). For dual-
frequency receivers, P/L1 and P/L2 measurements can be
included.

* CMR Settings — applies parameters to CMR messages.

— Station ID: assigns a separate station ID to each reference
station working in the area. The values can be 0 (zero) to 31;
the default is zero.

This ID allows the Rover receiver to easily identify the
reference station from which it receives CMR messages.

— Short ID: a short description (feature code?) of the object
being surveyed to include in CMR message type 2.

— Long ID: a long description (feature code) of the object being
surveyed to include in CMR message type 2.

— COGO: a coordinate geometry (feature code) description of
the object being surveyed to include in CMR message type 2.

— Motion: determines the motion status of the Base station
(“Unknown” for an undetermined motion state, “Static” for a
motionless receiver, or “Kinematic” for a receiver in motion).

— GLONASS message: specifies which message types (any
unused message type between 3 and 7) will be associated
with GLONASS measurements.

— Measurements Sent: the measurements types to include in
CMR message.

Currently, C/A measurements will always be included
(corresponds to single-frequency receivers). For dual-
frequency receivers, P/L1 can be selected instead and P/L2
measurements can be included.

2. Feature code is an alphanumeric code used to describe an object to be
surveyed.

3-42 PC-CDU Reference Manual



Configuration Menu

* Configuration of Receiver Ports — displays the Ports tab. See
“Ports” on page 3-46 for more information.

* Advanced Base Settings — not available for this version of
PC-CDU.

Rover

The Rover tab contains parameters for configuring the receiver as a
Rover station.

[ Receiver Configuration
General | MINTER | Positoning | Base [Fover| Patts | Events | Advanced |

Postlioning Mod Enable Soltion
 Standalons  ATK Float ¥ Standalone ¥ ATK Fioat
 DGPS (Code Difterential] & ATK Fised I~ GRS ¥ ATK Fised
; RTK Parameter
' RTKmode [ Dynamics | | Ambiguiy fising level
£D Corrections
Coneetions Usage | | s, age(see) " ’7(‘ Extiapolation ’7(‘ Static ’7‘“ Low

& Medium
v HiEerest Jona Corresions & Dela :
|E P RRLEE c
i mar. age (sec| 00 High

& Kinematic

I= Use [ona Careetions Measuements Lse Base Conections
P CALT 2 PAT [ P2 | ool r B [1.00

& Corrections
= Posifions

I~ Best Souice: [ 4ny T I Useoldref. condinates  Souree: [&ny 7]

CMR Settings
GLONASS message 3 Reset RTK Engine

Configuration of Receiver Ports

Advaricsd Pover Settings | Rsfesh | Appy |

Exit Save | Setal parameters to defaults
I

Figure 3-24. Receiver Configuration — Rover

* Positioning mode — selects the positioning mode for the receiver.
See “Positioning” on page 3-34 for more information on these
settings.

* DGPS Parameters — applies multi-base and various correction
parameters.

— Multi-base: activates settings for applying parameters specific
to jobs that use more than one Base.

— Correction usage: determines which Base the Rover will use
differential corrections from. Either the Nearest station, Mix
for up to 5 stations simultaneously to average differential
Corrections from the stations or average computed Positions
from the stations, or Best for the station that transmits the
most precise position estimates and the solution has the least
RMS error.
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If selecting Nearest, disable Mix and Best. If selecting Mix,
disable Best.

— CD Corrections max. age (sec): sets the maximum age (in
seconds) of code differential corrections used for position
computation. Values are from 1 to 1200; the default is 10.

If the age of corrections exceeds the value specified, the rover
will compute a stand-alone position.

— Iono Corrections max. age (sec): specifies the maximum age
(in seconds) of the ionosphere corrections used for position
computation.

— Use Iono Corrections: both ionosphere corrections from
RTCM message type 15 and differential corrections from
RTCM message types 1 and 31 (or 9 and 34) will be used in
position computation.

— Source: not available in Multi-base mode; the port from
which the receiver will use differential corrections for
position computation.

* Enable Solutions — selects the type of solution to use for Rover
receivers. See ‘“Positioning” on page 3-34 for more information
on these settings.

* RTK Parameters — applies parameters for RTK surveys.

— RTK mode: determines whether or not to extrapolate the Base
station’s carrier phase measurements when computing the
rover's current RTK position.

If Delay selected, the RTK engine will compute either a
delayed RTK position (for the epoch to which the newly
received RTCM/CMR message corresponds) or the current
stand-alone position (while waiting for new RTCM/CMR
messages coming from the base).

— Dynamics: defines the current action of the Rover receiver,
either Static or Kinematic.

— Ambiguity fixing level: governs the RTK engine when
determining whether or not to fix ambiguities. Low, Medium
and High correspond to the indicator's 95%, 99.5% and
99.9% states, respectively. The higher the specified
confidence level, the longer the ambiguity search time.
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* Measurements Used — the measurement types used for position
computation.

* Use old ref. coordinates — during an RTK survey, the Rover
receiver will immediately begin using the existing reference
coordinates rather than waiting for updated reference coordinates
from the Base.

'ﬂT Use care when setting this parameter. If the position
of the Rover has changed and a new session has
begun, the Rover could be using old reference
coordinates from a different Base. In this case,
position blunders will occur until the Rover receives
a message with the correct reference coordinates.

[WARNING )

* GLONASS messages — only applicable if using CMR differential
messages, assigns the message type for GLONASS
measurements. Both the Base and Rover must use the same
message type.

» Base corrections period (sec) — sets the differential correction
update interval. Before entering a value, know the exact rate at
which the reference station broadcasts differential correction
data.

This interval will only be used if the receiver is run in Delay
mode.

The interval also provides more reliable synchronization between
the Base station and Rover receiver.

* Source — the port from which the receiver will use differential
data for position computation in RTK mode.

* Reset RTK Engine — reloads the RTK engine. All previously
obtained estimates (estimated position, variance-covariance
matrix, etc.) will be discarded and the RTK engine will start over.

* Configuration of Receiver Ports — displays the Ports tab. See
“Ports” on page 3-46 for more information.

* Advanced Rover Settings — not available for this version of
PC-CDU.
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Ports

The Ports tab contains parameters for configuring the various ports
available on the receiver.

[ Receiver Configuration
General | MINTER | Positoning | Base | Fover [Pails | Events | Advanced |
Seisl | Parslel| Modem | USB | Ethernet| TCP |
. Input: | Command - Baudate: | 115200 |~
Serial &
Output: [Hene =] Period fsec) I~ RTS/CTS
. Input: | Command - Baudrate: [115200
Serial B
Output: [None =] Period fsec) [ RTS/CTS
. Input: | Command - Baudrate: [115200
Serial
Output: [None =] Period fsec) [ RTS/CTS
Serial D Input: | Command i Baudrate: |115200 =
= Inirened Dutput: [Mone ~| Peiiod isec) [ RTS/CTS
Refiesh Aprly
OK_| Est | Save | Setal parameters to defauls |

Figure 3-25. Receiver Configuration — Ports (with Serial Sub-tab)

The following six sections describe the fields on these tabs.

Ports - Serial

Accessed from the Ports tab, the Serial tab (Figure 3-25) specifies
data the receiver’s serial ports (A, B, C, and D) will transmit/receive.
* Input — specifies the type of data to input on the selected port.

— None: the port will reject any incoming data.

— Command: the port is in command mode and will recognize
user-sent commands.

— Echo: the port is in echo mode and will redirect all incoming

data to an output stream, either another port or the current log
file.

— RTCM 2.x: the receiver recognizes and decodes RTCM
version 2.1, 2.2, and 2.3 messages accepted on the
corresponding port.

— RTCM 3.x: the receiver recognizes and decodes RTCM
version 3.0 messages accepted on the corresponding port.
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— CMR: the port is in Compact Measurement Record (CMR)
messages input mode.

— TPS: the port is in TPS messages input mode.

— Omni: OmniStar VBS will used to produce DGPS solution
type.

* Output — specifies the type of data to output on the selected port.

— None: the port outputs nothing.

—DGPS RTCM {1,31,3}: the port outputs RTCM message
types 1, 31, and 3.

— DGPS RTCM {9,34,3}: the port outputs RTCM message
types 9, 34, and 3.

— RTK RTCM {18,19,22,3}: the port outputs RTCM message
types 18, 19, 22, and 3.

— RTK RTCM {20,21,22,3}: the port outputs RTCM message
types 20, 21, 22, and 3.

— RTK RTCM {18,19,23,24}: the port outputs RTCM message
types 18, 19, 23, and 24.

— RTK RTCM {20,21,23,24}: the outputs RTCM message
types 20, 21, 23, and 24.

— RTK RTCM3 GD min: the port outputs RTCM message types
1003, 1006, 1008. These messages provide minimum service
operation for precision GPS RTK on L1 & L2.

— RTK RTCM3 GD full: the port outputs RTCM message types
1004, 1006, 1008. These messages provide full service
operation for precision GPS RTK on L1 & L2.

— RTK RTCM3 GGD min: the port outputs RTCM message
types 1003, 1011, 1006, 1008. These messages provide
minimum service operation for precision GPS and
GLONASS RTK on L1 & L2.

— RTK RTCM3 GGD full: the port outputs RTCM message
types 1004, 1012, 1006, 1008. These messages provide full
service operation for precision GPS and GLONASS RTK on
L1 & L2.
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— RTK CMR {10,0,1}: the port outputs CMR message types
10,0, 1.

—RTK CMR+ {10,0,9}: the port outputs CMR + message types
10, 0, 9.

— RTK TPS min: the port outputs TPS message types RT, SI, rc,

cp, 2r, 2p, BI, ET. These messages provide the minimum
adequate message set for an RTK system.

— RTK TPS max: the port outputs TPS message types RT, SI,
rc, cp, DC, EC, 2r, 2p, D2, E2, BI, ET. These messages
provide the complete message set for an RTK system.

— User Defined: the port outputs user-specified data. That is, an
an arbitrary message set has been defined that will be
outputted through the port.

* Period (sec) — enter interval at which the receiver will generate
differential messages (in seconds).

To change the period for RTCM message types 3, 22, and
CMR message type 1, use the “em” command while in
Manual Mode. Refer to the GRIL Reference Manual for
details.

If an incorrect message output interval has been entered, the
Output Period Setup Wizard will being. See Appendix D for
more information.

* Baud rate — the rate at which the receiver will transmit messages
to a modem or any other device connected to this port.

* RTS/CTS - enables/disables hardware handshaking for the port
(if enabled, the modem must support this mode).

* Infrared — only available for port D, enables an infrared
connection between the receiver and an external device via this
port. Only use this mode if the following conditions have been
met:

— The external device is compatible with the receiver’s infrared
interface (for example, CDU-1).

— The receiver’s hardware supports the infrared port.

— The “Infrared Port” option has been enabled in the receiver.
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Ports - Parallel

Accessed from the Ports tab, the Parallel tab specifies data the
receiver’s parallel port will transmit/receive.

[ Receiver Configuration
General | MINTER | Positoning | Base | Fover Potts | Events | Advanced |
Serisl [ Paislel] Modem | USB | Ethermet| TCP |
Parallel  Input |:Ummand =l Output |NW =l Period [sec)
Refiesh el
OK_| Est | Save | Setal parameters to defaulis |
I

Figure 3-26. Receiver Configuration — Ports with Parallel Sub-tab

The Input, Output, and Period settings on this tab are the same as
those seen on the Serial tab, but configures the parallel port. See
“Ports — Serial” on page 3-46 for information on these settings.
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Ports - Modem

Accessed from the Ports tab, the Modem tab configures the receiver’s
internal radio modem for Legacy and Odyssey receivers with an
internal Spread Spectrum modem.

[ Receiver Configuration
General | MINTER | Positoning | Base | Fover Ports | Events | Advanced |

Sersl | Parsllel {Modem | Us8 | Ethernet| TCP |

teral gt | LT — = trtenar e O Ex
b : F
eI e g Hiades 7 =l Bowen ¢ HGHE) Low

Pertd(seelk

Rehesh EEly

Exit Save | Setal parameters to defaults
I

Figure 3-27. Receiver Configuration — Ports with Modem Sub-tab
* Internal Modem — specifies data the receiver’s modem will
transmit/receive.

The Input, Output, and Period settings on this tab are the same as
those seen on the Serial tab, but configures the modem port. See
“Ports — Serial” on page 3-46 for information on these settings.

* Type — sets the operation mode, either “Receiving” or
“Transmitting”.
* Mode — specifies the method used to transmit data.
— Off: the internal modem is turned off.

— FHSS: the internal modem is a frequency-hopping spread
spectrum modem type.

— DSS: the internal modem is a direct-sequence spread
spectrum modem type.

* Antenna — the type of antenna the modem uses, either Internal or
External.

¢ Power — the transmission mode for an internal modem (the
amount of power to use for transmission), either High or Low.
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Ports - USB

Accessed from the Ports tab, the USB tab specifies data the receiver’s
USB port will transmit/receive.

[ Receiver Configuration
General | MINTER | Positoning | Base | Fover Potts | Events | Advanced |
Sersl | Parslel| Modem (USE | Ethernet | TCP |
use Input IEnmmar\d =l Output INnne =l Period [sec)
Refiesh oy
Exit Save | Setal parameters to defaults
I

Figure 3-28. Receiver Configuration — Ports with USB Sub-tab

The Input, Output, and Period settings on this tab are the same as
those seen on the Serial tab, but configures the USB port. See “Ports —
Serial” on page 3-46 for information on these settings.
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Ports - Ethernet

Accessed from the Ports tab, the Ethernet tab configures Ethernet,
Telnet, and FTP communication settings.

These settings are only available when the connected receiver has the
Ethernet option enabled.

[ Receiver Configuration

Sersl | Parsllel| Modem | USB  Ethemet | TcP |

waning. Mewly applied settings will be activated only after receiver reset,

IPSettings | | TeletSettings FTF Setting:
IF &ddress:  [192168.0.2 TCP Port: 5002 TCP Part 21
IP Mask: 255 255 255.0

Timeout (s} [600 Timeaut (sk [500

Gateway,  |1921680.3

Network Password: |

Rehesh Al

Exit Save | Setal parameters to defaults
I

Figure 3-29. Receiver Configuration — Ports with Ethernet Sub-tab

For any of these settings, contact the system
D administrator about which settings are safe to use.

* IP Settings — specifies the IP addressing parameters for a
connected receiver.

— IP Address: a unique identifier for the receiver on a TCP/IP
network. An IP address comprises four numbers from 0 to
255 and separated by periods. The receiver’s default IP
address is “192.168.2.2”.

— IP Mask: a mask used to determine what subnet the receiver
belongs to. The default mask is “255.255.255.192”.

— Gateway: the IP address for the gateway used to communicate
with devices on another network. The default gateway is
“192.168.2.1”.

* Telnet Settings — configures the connected receiver to act as a
telnet server. Up to five remote devices (telnet clients) can
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simultaneously connect to the telnet server receiver over a TCP/IP
network. Once a connection has been established, the telnet
clients can control the telnet server receiver as if through a direct
connection.
— TCP Port: the TCP/IP port the telnet server monitors for the
connection. The default port number is 8002.

— Timeout: the amount of time in seconds that must elapse
before an inactive connection will be terminated. The default
timeout is 600 seconds.

* FTP Settings — configures the connected receiver to act as an FTP
server. One remote device (FTP client) can connect to the FTP
server over a TCP/IP network for downloading raw data files.

— TCP Port: the TCP/IP port the FTP server monitors for the
connection. The default port number is 21.

— Timeout: the amount of time in seconds that must elapse
before an inactive connection will be terminated. The default
timeout is 600 seconds.

* Network Password — used in Telnet and FTP configurations, the
password that the client must enter to access the server. The
password can be up to 15 alphanumeric characters.
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Ports - TCP
Accessed from the Ports tab, the TCP tab specifies data the receiver

will transmit/receive over a TCP/IP network.

These settings are only available when the connected receiver has the

Ethernet option enabled.

Eﬂ Receiver Configuration g|
General | MINTER | Positioning | Base | Fiaver Forls | Events | Advanced |

Serial | Parallel| Modem | USE | Ethemet TCP |

TEFA  Input [Command | Ouput [DGPSRTEM {83430 ~|  Period(s): [1.00

TEFB  Input [Command | Ouput [RTKRTCM (20212231 ~|  Period(s): [1.00

TCFC  Input [Command | Ouput [RTKRTCMIGGD I |  Period(s): [1.00

TCFD  Input [Command | Ouput [RTKCWR- {1009  ~| Period(s): [1.00

TCFE  Input [Command | Output [RTKTPS max | Period(s): [1.00

0K | Est | Save | Setal paameters to defauls |

Figure 3-30. Receiver Configuration — Ports with TCP Sub-tab

The Input, Output, and Period settings on this tab are the same as
those seen on the Serial tab, but configures the TCP ports. See “Ports
— Serial” on page 3-46 for information on these settings.
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Events
The Events tab configures the 1PPS signal and Event marker settings.

[ Receiver Configuration

General | MINTER | Positoning | Base | Fover | Pats  Events | Advanced |

¥ PPS A Enabled

il | FFSB Enabiled

Feriod: [1000 [ms) @ Period ms] @

Offset; [0 1 e — M) Rt Te—————

o ) | €GPS & UTCus || | Ofiser fns) [ £/GRS £ UTCus

Period of marked pulses: | & GL0 C UTEs |1 oo ied pulses Galn Gt
0 5] [ Tiad with Ref. Time M) [ Tied with Rief. Time

[ Event & Enabled

Clock Synchionization |

Statug; |off
Repeat Spnchionization

Edg
& Rise ¢ Fall

(Rl Time
 GPS & UTCus
GO ¢ UTCsu

(i | Event B Enatied

Edge
© Rise & Fall

Clock Syrchronization
Status :
Fiepeat Synchonization)

[Ref. Time
© GRS UTCus
OGO TGy

[V Tied with Ref Tims

I Tied with Fief Time

Refiesh | dpply

Exit Save | Setal parameters to defaults
I

Figure 3-31. Receiver Configuration — Events

* PPS A Enabled and PPS B Enabled — enables the receiver to
generate 1PPS signals, as well as modify the settings related to
the selected 1PPS signal.

— Period: determines the rate of generating 1PPS signals via the
corresponding output connector.

— Offset (ms) and Offset (ns): the milliseconds and/or
nanoseconds to use for PPS signal offsets in reference to the
selected reference time grid.

— Period of ‘marked’ pulses: specifies the period of the marked
1PPS signal in milliseconds.

— Edge: synchronizes the edge (rising or falling) of the 1PPS
signal with the specified reference time.

— Ref. Time: selects the reference time that the 1PPS signal will
be synchronized with; either GPS system time, GLONASS
system time, UTCus (UTC USNO) system time, or UTCsu
(UTC SU) system time.

— Tied with Ref. Time: the receiver synchronizes the 1PPS
signal with the chosen reference time. Otherwise, 1PPS will
synchronize with either the receiver's internal clock or with
an external reference frequency applied to the receiver.
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If synchronizing with an external reference frequency, the
Source field on the Advanced tab and External Frequency
sub-tab must be set to “External”.

¢ Event A Enabled and Event B Enabled — enables the receiver to
measure and log event times, in the specified reference time, with
high accuracy.

— Clock Synchronization: the receiver executes a one-time
synchronization of its one-millisecond cycle grid with the
corresponding edge of the event signal.

— Status: indicates whether or not the receiver clock is actually
being synchronized with the event signals. “On” means that
the synchronization has been done successfully.

— Repeat Synchronization: manually performs a
synchronization.

— Edge: measures the time of either the rising edge or falling
edge of the input event signal.

— Ref. Time: selects he reference time that the event reception
time will be synchronized with; either GPS system time,
GLONASS system time, UTCus (UTC USNO) system time,
or UTCsu (UTC SU) system time.

— Tied with Ref. Time: the receiver measures the event
reception time in the selected chosen reference time,
regardless of the computed receiver clock offset.
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Advanced

The Advanced tab contains parameters for configuring the various
ports available on the receiver.

[ Receiver Configuration
General | MINTER | Positioning | Base | Rover | Ports | Events £

Anli-nterfarencs | Multipath Reduction | Loop Management | Extemal Frequency | Raw Dats Management | Dptions |

&ntidnterference
 of

GRS L1/L2

" GLOMASS L1/L.2

" GPS/GLONASS L1
" GPS/GLONASS L2
& Auto

Refiesh Apply

OK_| Est | Save | Setal parameters to defauls |
[

Figure 3-32. Receiver Configuration — Advanced (with Anti-Interference Sub-tab)

The following six sections describe the fields on these tabs.

'ﬂT Be sure to understand the settings on these tabs
before making changes. Applying incorrect
Advanced tab settings can cause the receiver to run
improperly.

If needed, click Set all parameters to defaults to
return the settings to factory defaults.
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Advanced - Anti-Interference

Accessed from the Advanced tab, the Anti-Interference tab
(Figure 3-32 on page 3-57) enables suppression of narrow-band
interference.

Anti-interference is only available for JPS_3, JPS_4_x, Euro_x,
E_GGD, and EGGDT_x receiver board versions, where “x” stands
for the board revision number.

Use the following assessments to determine the presence of
interference:

* When the number of tracked satellites is fewer (by 2 or greater)
than the number of satellites in view.

* When the signal-to-noise ratio (C/NO) in the C/A channel for the
satellites having elevations above 30 degrees does not exceed 40
dB/Hz.

* When the information about interferences indicates that the
“Jamming Suppressor” has detected interference signals within
the specified band. Also, the strength of aggregate in-band
interference is characterized as high or hard.

In Manual Mode, use the “em,,jps/JI” command to view this
information.
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Advanced - Multipath Reduction

Accessed from the Advanced tab, the Multipath Reduction tab
contains settings for the mitigation of the multipath phenomenon.

[ Receiver Configuration
General | MINTER | Positioning | Base | Rover | Parts | Events ©Advanced

Antinterference  Multipath Reduction | Loop Management | Extemal Frequency | Raw Dats Management | Options |

[¥ Code multipath reduction
[¥ Carrier multipath redustion

Refiesh Aol

OK_| Est | Save | Setal parameters to defaulis |
I

Figure 3-33. Receiver Configuration — Advanced with Multipath Reduction
Sub-tab

* Code multipath reduction — recommended setting for receivers
(Base/Reference and Rover) in DGPS mode on jobsites that
contain multipath.

e Carrier multipath reduction — recommended setting for receivers
(Base/Reference and Rover) in RTK mode on jobsites that
contain multipath.
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Advanced - Loop Management

Accessed from the Advanced tab, the Loop Management tab contains
settings for configuring the receiver’s capability of searching,
acquiring and tracking the GPS+ satellite signals.

[ Receiver Configuration

Antinterference | Multipsth Reduction  Loop Management | Estemal Frequency | Flaw Data Management | Options |

PLL bandwid: [0 gy | EnsbleCoDp Trackingloop
L et F ¥ Static Mods

Banduidth of individusl PLL 5.0 Hz)
Guided loop bandwidth: 05 [Hz)

Bandwidth of common PLL 250 [Hz)

- e |08
L4 code guided loop bandwidth Ha]
[¥ Enable Adaptive Guided Loops ¥ Enable Common Loop for L2
[¥ Enable P/LT and P/L2 tracking
Rehesh Al

Exit Save | Setal parameters to defaults
I

Figure 3-34. Receiver Configuration — Advanced with Loop Management Sub-tab

-fﬂ' The defaults are recommended for most receiver
II®  configurations.

* PLL bandwidth — governs the noise bandwidth of the guiding
phase lock loops. Values are from 2 to 50 Hz; the default is 25 Hz.

* PLL order — alternates the guiding and common lock loop order.
Values are 2 and 3; the default is 3.
Using a 2nd order PLL can adversely affect satellite signal
tracking in some cases.

* Guided loop bandwidth — governs all guided loops except C/A
DLLs. Values are from 0.1 Hz to 10 Hz; the default is 0.5 Hz.

* C/A code guided loop bandwidth — specifies the bandwidth of the
receiver's C/A group delay lock loop. Values are from 0.1 Hz to
50 Hz; the default is 0.8 Hz.

» Enable Adaptive Guided Loops — when enabled, the receiver will
adjust the guided loops bandwidths depending on the actual
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strengths of the signals tracked; the weaker the signals, the
narrower the bandwidths.

» Enable P/LL1 and P/L2 tracking — adjusts tracking settings for the
receiver.
For single-frequency receivers or L1 only antennas, disable this
setting.

* Enable Co-Op tracking loop — improves tracking characteristics
of TPS receivers in hostile environments.

— Static Mode: the receiver will acquire satellites with lower
signal-to-noise ratios and reduce the reacquisition time for
the satellite signals after a temporary loss of lock.

Only enable this setting if the receiver’s antenna remains
completely stationary throughout the survey. Any movement
may result in losing the satellite lock.

— Bandwidth of individual PLL: sets the bandwidth for one
PLL. Available values are 2 to 20 Hz; the default is 5.0 Hz.

— Bandwidth of common PLL: sets the bandwidth for a set of
PLLs. Available values are 2 to50 Hz; the default is 25.0 Hz.

* Enable Common Loop for L2 — allows the antenna to continue L2
phase tracking in dynamic applications despite antenna rotation
around its axis.
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Advanced - External Frequency

Accessed from the Advanced tab, the External Frequency tab contains
settings for configuring the reference frequencys; either a high-
stability external frequency or the receiver's internal crystal oscillator.

[ Receiver Configuration

Antinterference | Multipsth Reduction | Loop Management Extemal Frequency | Fiaw Dats Management | Dptions |

i~ Frequency Source

Source
[F Intemal € Ewtemnal

Extemal Frequency Source Parameters

Ext. frequency value (MH2): [10
Ext, frequency source status ; |off

Ext. freq, signallamplivdes|off

- Dseillstor Offset Reduction
& Ot
 Freq. Locked

 Fren and Tims Locksd
Risfrssh (el
Exit Save | Setal parameters to defaults

Figure 3-35. Receiver Configuration — Advanced with External Frequency
Sub-tab

* Source — specifies the reference frequency input that the receiver
will use. Switching from Internal to External may result in
temporary loss of lock to satellites.

— Internal: the receiver uses the internal oscillator.
— External: the receiver uses an external frequency. Enables the
External Frequency Source Parameters fields.

* Ext. frequency value — the nominal external frequency value.
Values are from 2 to 40 MHz; the default is 10 MHz.

» Ext. frequency source status — shows whether or not the external
frequency is being used.
— off: the receiver is using the internal crystal oscillator.

— wait: the receiver is waiting for the external frequency lock
because the external frequency oscillator is disconnected, the
amplitude of input signal is too low, or the actual external
frequency is different from that specified in Ext. frequency
value.

— locked: the receiver is using the external frequency.
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 Ext. freq. signal amplitude — an estimate of the external frequency
signal amplitude.

— off: the internal oscillator is being used.

— low: the external frequency signal's amplitude is lower than
needed.

— ok: the external frequency signal's amplitude meets the specs.

* Oscillator Offset Reduction — governs the behavior of the internal
crystal oscillator.

— Off: the oscillator frequency offset reduction mode is turned
off.

— Freq. Locked: the receiver will adjust the internal oscillator's
frequency until the measured frequency offset is reduced to
ZEer0.

Using incoming satellite signals, the receiver will force the
internal oscillator to generate a very stable 20 MHz frequency
signal. This frequency output is available via the
corresponding receiver output pin.

Use the GEO tab and Clock offset field on the Main Screen to
monitor the offset reduction. After selecting Freq. Locked the
value in Clock offset starts to reduce and soon (usually in a
few minutes) it will become equal to zero, while in contrast
Osc. Offset will not change much.

Enabling this parameters guarantees that the receiver's 20
MHz output will have long-term stability, but not necessarily
short-term stability. To ensure that both of these
characteristics are sufficient, enable Enable Co-op tracking
on the Loop Management sub-tab.

— Freq. and Time Locked: the receiver will adjust the internal
oscillator's frequency and the internal clock until the
measured frequency offset is reduced to zero and the clock is
fully synchronized with the specified reference time scale.

P/N 31-000004-01 3-63



PC-CDU Software Reference

Advanced - Raw Data Management

Accessed from the Advanced tab, the Raw Data Management tab
contains settings for specifying the frequency at which the receiver
will update raw measurements and positions, as well as settings that
affect signal processing.

General | MINTER | Positoning | Base | Raver | Pants | Events [Advanced ]

AntiInterference | Multipath Fieduction | Loop Management | Extemal Frequency  Riaw Data Management |Uplmns|

- Raw Measurement Updats Rate

Update Rate 100 fms)
Curent Updats Rate:  [100 mg)

~ Position Update Rats

Update Rate 100 fms)
Curent Updats Rate:  [100 mg)

Cods smoothing interval 300 | [5)
Doppler smonthing method : 2

Narinal lano smocthing interval - [E0 (3]

Minimum lona smoothing interval - |30 [s] Refiesh Bl
OK_| Est | Save | Setal parameters to defauls |

Figure 3-36. Receiver Configuration — Advanced with Raw Data Management
Sub-tab

* Raw Measurement Update Rate — determines the raw data update
period.
— Update Rate: the time in milliseconds for the update rate.
— Current Update Rate: the update actually being used.
* Position Update Rate — determines the receiver position update
period.
— Update Rate: the time in milliseconds for the update rate.
— Current Update Rate: the update actually being used.
* Code smoothing interval — specifies the interval over which
pseudoranges are smoothed using the corresponding carrier phase
measurements. Values are from O (zero) to 900 seconds. Zero

designates that carrier phase measurements will not be used for
smoothing pseudo-ranges.
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* Doppler smoothing method — the method used for smoothing
Doppler measurements. Values range from 1 to 3 and correspond
to the following descriptions; the default is 2.

— 1: Receiver outputs raw (unsmoothed) Doppler. Instantaneous
and rather noisy Doppler measurements.

— 2: Doppler is computed using two consecutive carrier phase
measurements, CarPhase[i] and CarPhase[i-1], where i stands
for the current epoch. Doppler measurements are less noisy
than in the first case.

— 3: Doppler is computed using three consecutive carrier phase
measurements, CarPhase[i], CarPhase[i-1] and CarPhase[i-
2], where i stands for the current epoch. Doppler
measurements obtained in this mode are least noisy.

* Nominal Iono smoothing interval — specifies the nominal
ionospheric correction smoothing interval over which raw
ionospheric corrections are smoothed. Values range from 0 (zero)
to 900 seconds; the default is 60 seconds.

When enabled, this setting assumes that the receiver has been
working for some time and has already obtained enough raw
ionospheric corrections to perform such smoothing.

* Minimum Iono smoothing interval — specifies the minimum
smoothing interval for the receiver to filter raw ionospheric
corrections before the corrections can be used in position
computation. Values range from 0 (zero) to 900 seconds; the
default is 30 seconds.
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Advanced - Options

Accessed from the Advanced tab, the Options tab contains settings
turning on and off the temporary dual-frequency option.

[ Receiver Configuration
General | MINTER | Positoning | Base | Fover | Parts | Events Advanced |

Cinderell
 On  Off

Refiesh Apply

OK_| Est | Save | Setal parameters to defauls |
I

Figure 3-37. Receiver Configuration — Advanced with Options Sub-tab

* On — enables the receiver to run as a dual-frequency
GPS+GLONASS unit for 24 hours every other Tuesday (known
as “Cinderella”).

Visit the Cinderella Option page on the TPS web site
(http://www.topcongps.com/software/cinderella.html) to
schedule Cinderella days.

» Off — disables the Cinderella option.
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Site Configuration

The Site Configuration dialog box applies antenna parameters to the
pccdu.ini file for data logging purposes.

[ Site Configuration ]

[ Site Paramaters

Site: Mame: Top_25
Antenna Status: Fixed 2

[Antenna Parameters

Antenna Height (m], [159 I Slant
AniennaType: | TPSCR3_GGD -

¥ Send parameters automatically

TUHRTT] Sendtareceiver|  Cancel |

\
Figure 3-38. Site Configuration

* Site Name — the name of the jobsite (up to 20 alphanumeric
characters).

* Antenna Status — the status of the antenna; either fixed or moving.

* Antenna Height — the height of the antenna measured from the
survey marker to the measuring mark on the antenna (either ARP
or SHMM).

* Slant — if selected, indicates that the height of the antenna was
measured at a slant (to the slant height measurement mark).
When not selected, indicates a vertical measurement (to the
antenna reference point).

* Antenna Type — the type of antenna.

* Send parameters automatically — sends site and antenna
parameters to the receiver each time a log file is created.

* OK - copies the settings to the pccdu.ini file and closes the dialog
box. After clicking Start on the File Manager dialog box, these
settings will be enabled and inserted into the newly created log
file (unless Send parameters automatically has been disabled).

 Send to receiver — sends new site parameters to the receiver log
file and the pccdu.ini file.

* Cancel — closes the dialog box without saving the settings.
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Target Position

The Target position dialog box contains fields for entering target
coordinates.

[l Target position 9 [=]
Lat[55 [z '[soszes W =
e el N B

TORT]  Gethomiscsiver | Cancel |
|

Figure 3-39. Target Position

* Lat — the latitude of the antenna in degrees, minutes, and seconds;
the hemisphere (N or S) in which the antenna resides; the datum
that corresponds to the entered coordinates.

* Lon — the longitude of the antenna in degrees, minutes, and
seconds; the hemisphere (E or W) in which the antenna resides.

* Ok — associates the entered coordinates with the target position
and closes the dialog box.

* Get from receiver — sets the target position to the most recent
position the receiver produced.

* Cancel — closes the dialog box without applying the coordinates.
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Configuration Menu

For receiver’s equipped with an RFM96 radio modem, the RFM96

Configuration dialog box.

@HFMHB Configuration
(Eanfiguraton |
Serial No: 1356010
RF Channel Fiadio Link Setting
[0 (#64.5500,462.5500) x| | Link rate: 00 )
Fietries: 3 |
 DTEDEE Serial Interface—| of =
Baudrate:[30000 =] | |Scrambling:  [on =]
Paity.  [None x| ||Digisquelch:  [Low =]
Ear: [0 || |csMamoniter: [on =]
DTE DCE protocol mud
[Fast aspnc r BREAK to Command
Addresse
’VLD:a\ Destination |
Disconnect | FRefresh | coph | Set defauls |

Figure 3-40. RFM96 Configuration (After Connection)

The Connect tab establishes a connection between PC-CDU and the

Connect
RFMO96 radio modem.
Connect |

Modem connected to port:  |C 'I
Connect to modem at bitate: [aule =]

"Ennneclmr\ type:

Connection type
& Search for madem © Fower eyele ‘ ’Vr‘ Search for modem & Fower cycle
Tuin the modem power off (or slide the modem from the
receiver). Then tum the modem power on [or slide the
modem into the receiver)
Stop Exit Correct | St | Exit
|Looking for modenn. . (111

[ RFM36 Configuration ]
Connest |

Modem connected to port:  |C =
Corriect to modem atbitratz | A0 |+

Figure 3-41. RFM96 Configuration — Connect

* Modem connected to port — the receiver port that the radio
modem is connected to. Usually port C for the Legacy, Legacy-E,
Legacy-H, Regency and HiPer family receivers, and port B for

the Odyssey family receivers.
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* Connect to modem at bitrate — sets the baud rate with which the
modem and receiver will communicate. Usually 38400 bps, but to
have the receiver automatically detect the baud rate, select
“Auto”.

¢ Search for modem — searches for a connected radio modem after
clicking Connect. Sufficient for most RFM96 models.

* Power cycle — polls the radio during a power cycle and
establishes a connection. The dialog box also displays
instructions for this process.

Use this setting if the radio is not found, and after checking
receiver-to-computer connections (cable/wireless and PC-CDU),
then click Connect.

* Connect — connects to the detected RFM96 radio modem.
* Stop — stops searching for/connecting to an RFM96 modem.

* Exit — closes the dialog box without connecting to an RFM96
modem.

Configuration

The Configuration tab (Figure 3-40 on page 3-69) contains settings
for configuring an RFM96 radio modem.

* RF Channel - the radio’s frequency channel.

* DTE-DCE Serial Interface — applies various data transfer and
communication parameters to the serial interface.

— Baud rate: the data transfer rate used for communication with
the local DTE device.

— Parity: checks data to ensure its validity during
communication with the local DTE device.

— EOT: sets the end-of-transmission character or timeout value
used to determine when a message is complete and ready to
transmit. This parameter only applies when the DTE-DCE
protocol of the radio-modem is configured for Transparent,
Fast Asynch, or TrimTalk mode.
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» Radio Link Settings — the settings for sending corrections data via
an RFM96 radio modem.

— Link rate: the rate at which data is transmitted over the RF
link.

For Pacific Crest radios, use 9600 bps to minimize power
consumption and to maintain the radio transmitter at a low
TX duty cycle.

If needed, use 4800 bps in order to maintain reliability in
difficult transmission circumstances (long range or heavy
fade conditions).

— Retries: the number of retries the modem should attempt if a
remote modem does not respond or a corrupted data packet
causes a negative acknowledgment from the receiving
modem.

Only use this setting when the modems are in packet mode or
operation, or when the modems are in transparent mode with
a designated destination address other than 255.

— FEC: (Forward Error Correction) the receiving modem will
correct burst and single bit errors in the incoming data
stream.

When enabled, an additional 4 bits per byte of data is
transferred over the RF link. This effectively reduces the data
throughput in proportion to the overhead bytes.

Leave FEC enabled unless the data throughput requirements
make the overhead unacceptable.

— Scrambling: enables/disabled data scrambling for secure
transmission.

For optimal operation of the GMSK modulation, data should
be scrambled. When enabled, the radio modem scrambles and
unscrambles the data on transmission or reception via an
exclusive-OR operation with a pseudo-random bit stream.

Do not disable Scrambling unless the DTE performs data
scrambling and produces a data stream with approximately
the same number of 1's and 0's.
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— Digisquelch: the receiving modem attempts to decode the

radio information only in conditions where the radio signal is
of a certain power level.

Adjusting the sensitivity to an RF carrier allows the radio
modem to be configured to ignore weak signals, or signals
from unintentional radiators (computer CRT's, etc.) which
would otherwise interfere with reception.

* High — the best range of reception.

¢ Moderate — minimize interference from other

transmissions. Results in poorer reception of weak
signals and lower range.

Low — minimize interference from other transmissions.
Results in poorer reception of weak signals and lower
range.

Off — the radio modem loses its ability to receive signals
and becomes a transmitter. This will cause the radio
modem to transmit over other broadcasts, and is
generally not recommended, especially at higher power
levels where the broadcast will interfere with co-channel
users.

— CSMA monitor: sets the mode for checking for a clear

transmission frequency.
* On — the modem will check for clear TX frequency. If the

TX frequency is busy, the modem waits a random time
period and repeats the check. When the TX frequency is
clear, transmission will commence.

* Off — transmission will commence without first checking

for clear TX frequency.

* DTE-DCE protocol mode — the operation protocol for data
transfer; either Transp. w/EOT time out, Transp. w/EOT
character, Packet, Auto-repeater, or Fast async.

— Break to Command: if enabled, a BREAK condition on the
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RS-232 interface will cause the radio-modem to switch into
command mode.
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¢ Addresses — the address for the radio modem.

— Local: the identifier of the radio modem connected to the
computer through PC-CDU.

In packet switched and addressed transparent operation, each
modem should be assigned a unique address. Packets may be
sent to a specific address, or broadcast to a group of modems.
Values are from 0 to 254.

Do not use address 255, it is reserved as the broadcast
address.

— Destination: used only in transparent mode, the address to
transmit data to.

* Disconnect — disconnects the RFM96 configuration wizard from
the radio modem and returns to the Connect tab.

* Refresh — reloads the settings on the RFM96 Configuration
dialog box.

* Apply — applies settings to the radio modem without exiting the
dialog box.

* Set defaults — sets the default radio modem settings on the
RFM96 Configuration dialog box.

Configuration Software for more information on
these settings and how they relate to the radio
modem.

\i : / Refer to the help section of the RFM96 Modem
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Tools Menu

The Tools menu contains options for managing the receiver’s file
system, internal memory, and options.

Initialize File System

Initializing the file system of a connected receiver will erase all of the
receiver’s data files. This process requires two confirmations before
beginning, and may take several minutes depending on the receiver’s
memory size.

: : : This operation wil erase all the files inside the receiver

First confirmation to ) e et iy o e memoy s

ikl H D lly wish tinue?

initialize file system SHSHIESH RS CATE

Yes No
[ Initializing Receiver File System
This is your last chance to cancel
Second confirmation to initializing the receiver's file system.
e . . _> Press Start to continue with
initialize file system initializing,
e Cancel
[ Initializing Receiver File System [
Ready!
960 of 1960 Please. wait!
Fila System Information | Initialization ANNNENNNNNNNENNNNNEEEN
“ersion 3000103 i 1593 of 1960
Elock size 16376 bytes In progress ’E—I
Blocks 1953 A
Total memary 32080584 bytes [
Free memaory, 32080584 bytes
Ead blocks o
Write werify: fast
Physical Memary Information itiali H
ok 2ivn 512 byt 44— Initialization complete
Blocks for files: B2720
Fhysical memory: 32112640 bytes
=
Refiesh | Saverofie [ 06
\

Figure 3-42. Initializing the File System

When the receiver’s memory is initialized, information on the file
system and physical memory displays.

¢ Refresh — reloads the information.

* Save to file — saves the files system and physical memory
information to a text file.

* Ok — closes the dialog box.
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Clear NVRAM

The receiver’s Non-Volatile Random Access Memory (NVRAM)
holds data required for satellite tracking, such as ephemeris data,
almanac data, and receiver position. The NVRAM also keeps the
current receiver’s settings, such as active antenna input, elevation
masks and recording interval, and information about the receiver’s
internal file system.

Even though clearing the NVRAM is not a common (nor normally a
recommended) operation, there are times when clearing the NVRAM
can eliminate communication or tracking problems. Clearing the
receiver’s NVRAM can be interpreted as a soft boot in your computer.

Clearing the NVRAM of your receiver will not delete any files
already recorded in the receiver’s memory. However, it will reset the
receiver’s parameters to factory default values.

In addition, the NVRAM keeps information about the receiver file
system. Note that after clearing the NVRAM, the receiver's STAT
LED will flash orange for a few seconds indicating that the receiver is
scanning and checking the file system.

Clear NVRAM

Alter clearing NVRAM th recsiver wil rsquire
some fime to re-callect data needed to track satelltes.
Push OK to proceed, Cancel to abott

Cancel

Figure 3-43. Clear NVRAM

After clearing the NVRAM, the receiver will require some time to
collect new ephemerides and almanacs (around 15 minutes).
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Reset Receiver

Resetting the receiver is similar to a computer re-boot, but without
going through a power cycle. This process will leave all files intact.

Reset Receiver

Alter resatting the receiver will eauire
some fime to re-callect data needed to track satelltes.

Push OK to proceed, Cancel to abort

Cancel

Figure 3-44. Reset Receiver

After a receiver reset, the receiver will require a few seconds to a few
minutes to begin tracking satellites and logging data.

Receiver Options

The Option Manager dialog box displays current and available
options for the receiver, the status of the receiver’s options, and loads
a new OAF to the receiver.

[ Option Manager [T x]
Option name Cunent | Purchased | Leased Esp.date | =
GPS ves ves o
GLONASS ves ves o
L1 ves ves o
L2 ves ves o
Cinderella ves ves o
Position update rate [Hz] 20 20 0
Raw data update rate [Hz] 20 20 0
Code differertial Bass ves ves o
Code differertial Fiover ves ves o
RTK Base ves ves o
RTK Rover (Hz] 20 20 0
Mernory (MB] 9% 9% 0
Co-Op Tracking ves ves o
1-PPS Timing Signal 2 2 0
Event Markers 2 2 a —
In-Band Int. Rejection 1 a
Multipath Reduction ves ves o
Frequency Input ves ves o
Freq. Lock and Output ves ves o
Serial Part & (Kbps) 160 160 0
Serial Part B (Kbps) 160 160 0
Serial Part C (Kbps) 160 160 0
Serial Port D [Kbps] 160 160 0
Infrared Part ves o
Parallel Port yes no
Sp.5p. Freq. Hop. yes no
Sp.5p. Direct yes no
RAIM yes no
Datums support yes yes no
Magnetic azimuth yes yes no
Geoid height ves ves no ia|

i Load | Siop | Edt |
4

Figure 3-45. Option Manager

» Options table — the list of available options. See “Option
Manager” on page 3-77 for more information.

* Refresh — updates the information in the options table.
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* Load — loads a new OAF. See “Select Options File” on page 3-87
for more information.

* Stop — terminates loading an OAF.

» Exit — closes the dialog box.

Option Manager

The options table in the Option Manager dialog box (Figure 3-45)
has the following columns:

* Option name — the name/description for the option.

* Current — shows if the option is in force at the present or not.
 Purchased — if the option is purchased or not.

* Leased — if the option is leased or not.

» Expiration date — the date the leased option will be disabled, if
applicable.

Since Options can be both purchased and leased, the Current column
of the option displays the currently effective value. Option values can
be the following:

e -1 or “----” — the firmware version does not support this option.
* 0 — the receiver option is disabled.

* positive integer — the option is enabled with a specified value.
* yes or no — the option is either enabled or disabled.

Table 3-5 lists all options available for a TPS receiver.

Table 3-5. Receiver Options

Option Name Description Values
GPS Enables/disables the use of GPS yes — enabled
satellites. no — disabled
GLONASS Enables/disables the use of yes — enabled
GLONASS satellites. no — disabled
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Table 3-5. Receiver Options (Continued)

Option Name

Description

Values

L1 Enables/disables the receiver to yes — enabled
track the L1 carrier frequency and | no — disabled
use the C/A-code measurements
for position computation.

L2 Enables/disables the receiver to yes — enabled
track the L2 carrier frequency and | no — disabled
use the P-code measurements on
L1 and L2 for position
computation.

Cinderella Enables/disables the Cinderella yes — enabled

option. This option turns a single
frequency, GPS receiver into a

dual-frequency, GPS+GLONASS
receiver for 24 hours every other

Tuesday at GPS midnight?.

no — disabled

Position update

Displays the maximum allowable

0,1,2,5, 10, 20.

rate (Hz) position update rate for 0 (zero) means the
autonomous and code differential | option is disabled.
positioning. Measured in Hertz.

Raw dataupdate | Displays the maximum allowable 0,1,2,5, 10, 20.

rate (Hz) raw measurement update rate. 0 (zero) means the
Measured in Hertz. option is disabled.

Code Enables/disables the receiver to yes — enabled

differential Base

be configured as a DGPS Base.
This option is obsolete and
remains for compatibility.

no — disabled

Code Enables/disables the receiver to yes — enabled
differential be configured as a DGPS Rover. no — disabled
Rover This option is obsolete and

remains for compatibility.
RTK Base Enables/disables the receiver to yes — enabled

be configured as an RTK Base.
This option is obsolete and
remains for compatibility.

no — disabled
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Table 3-5. Receiver Options (Continued)

Option Name Description Values

RTK Rover (Hz) | Enables/disables the receiver to 0,1,2,5, 10, 20.
be configured as an RTK Rover 0 (zero) means the
with the desired RTK position option is disabled.
update rate. Measured in Hertz.
This option is obsolete and
remains for compatibility.

Memory (Mb) Displays the maximum amount of | 0 — disabled

storage space for raw data files.
Measured in Mbytes.

1...6256 — enabled for
specified memory space

Co-Op Tracking

Enables/disables the use of the
Co-Op tracking feature.

yes — enabled
no — disabled

1-PPS Timing
Signal

Enables/disables the receiver to
output 1 PPS signal.

0 —no 1 PPS output
1 —single 1 PPS output
2 —dual 1 PPS output

Event Markers

Enables/disables the receiver to
accept event marker inputs.

0 — no event marker
input

1 — single event marker
input

2 — dual event marker
input

In-Band Int. Enables/disables the receiver to 0 — disabled
Rejection use Jamming Suppressor. 1 — enabled outside
USA
2 —enabled for USA
only
Multipath Enables/disables the use of a yes — enabled
Reduction special signal processing no — disabled

technique that significantly
reduces the effects of multipath.

Frequency Input

If enabled, allows the receiver to
operate with an external high-
stability frequency source.

yes — enabled
no — disabled

Freq. Lock and
Output

Enables the receiver to generate a
very stable 20 MHz frequency.

yes — enabled
no — disabled
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Table 3-5. Receiver Options (Continued)

Option Name

Description

Values

Serial Port A Enables/disables communications | 0 — port disabled
(Kbps) through port A and displays the 9 - 9600
maximum available baud rate at 19 - 19200
which the receiver communicates | 38 — 38400
with an external device. Measured | 56 — 56700
in Kbits per second. 115-115200
230 - 230400
460 — 460800
Serial Port B Enables/disables communications | 0 — port disabled
(Kbps) through port B and displays the 9 -9600
maximum available baud rate at 19 - 19200
which the receiver communicates | 38 — 38400
with an external device. Measured | 56 — 56700
in Kbits per second. 115-115200
230 - 230400
460 — 460800
Serial Port C Enables/disables communications | 0 — port disabled
(Kbps) through port C and displays the 9 - 9600
maximum available baud rate at 19 - 19200
which the receiver communicates | 38 — 38400
with an external device. Measured | 56 — 56700
in Kbits per second. 115-115200
230 - 230400
460 — 460800
Serial Port D Enables/disables communications | 0 — port disabled
(Kbps) through port D and displays the 9 -9600
maximum available baud rate at 19 - 19200
which the receiver communicates | 38 — 38400
with an external device. Measured | 56 — 56700
in Kbits per second. 115-115200
230 - 230400
460 — 460800

Infrared Port

Enables/disables communications
through an infrared port.

yes — enabled
no — disabled

Parallel Port

Enables/disables communications
through a parallel port.

yes — enabled
no — disabled
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Table 3-5. Receiver Options (Continued)

Option Name

Description

Values

Sp.Sp. Freq.
Hop.

Allows use of the internal Spread
Spectrum modem in frequency
hopping mode. For the Legacy
and Odyssey only.

yes — enabled
no — disabled

Sp.Sp. Direct

Allow use of the internal Spread
Spectrum modem in spread
spectrum mode. For the Legacy
and Odyssey only.

yes — enabled
no — disabled

RAIM

Enables/disables Receiver
Autonomous Integrity
Monitoring.

yes — enabled
no — disabled

Datums support

Enables/disables the receiver to
output position information in a
datum other than WGS 84 or
PE-90.

yes — enabled
no — disabled

Magnetic
azimuth

Enables/disables the receiver to
output the magnetic course.

yes — enabled
no — disabled

Geoid height

Enables/disables the receiver to
use an embedded low-accuracy
geoid model with RMS of about
3m.

yes — enabled
no — disabled

Way Point
Navigation

N/A

always disabled

WAAS

Enables/disables the receiver to
use the WAAS service.

yes — enabled
no — disabled

OMNISTAR

Enables/disables the receiver to
use the OmniSTAR VBS satellite
differential service.

yes — enabled
no — disabled
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Table 3-5. Receiver Options (Continued)

Option Name

Description

Values

RTCM Output

Allows the receiver to output
RTCM messages.

0 — RTCM output
disabled

1 - DGPS RTCM
output enabled

2 — RTK RTCM output
enabled

3 - DGPS&RTK
RTCM output enabled

RTCM Input

Allows the receiver to accept
RTCM messages via a certain
number of ports. The value
represents the number of ports
from which the receiver is able to
simultaneously accept RTCM
messages.

0 — RTCM input
disabled
1,2,3,4,5-RTCM
input enabled on the
indicated number of
ports.

RTCM3 Output

Allows the receiver to output
RTCM 3.0 messages.

0 —RTCM 3.0 output
disabled

1 - DGPS RTCM 3.0
output enabled

2 —RTK RTCM 3.0
output enabled

3 - DGPS&RTK
RTCM 3.0 output
enabled

RTCM3 Input

Allows the receiver to accept
RTCM 3.0 messages via a certain
number of ports. Currently can be
setto O and 1.

0 —RTCM 3.0 input
disabled

1 - RTCM 3.0 input
enabled on a port.

CMR Output Allows the receiver to output 0 — CMR output
CMR messages. disabled
1 — CMR output
enabled
CMR Input Allows the receiver to accept 0 — CMR input disabled
CMR messages 1 — CMR input enabled
JPS Output Allows the receiver to output TPS | 0 — TPS output disabled

messages.

1 — TPS output enabled
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Table 3-5. Receiver Options (Continued)

Option Name

Description

Values

JPS Input Allows the receiver to accept TPS | 0 — TPS input disabled
messages via a certain number of | 1,2, 3,4, 5—TPS input
ports. The value represents the enabled on the indicated
number of ports from which the number of ports.
receiver is able to simultaneously
accept TPS messages.

DGPS mode Enables/disables the receiver to yes — enabled
run in DGPS (Code Differential) no — disabled
mode.

RTK mode (Hz) | Enables/disables the receiver to 0 — disabled

run in RTK mode at a specified
rate. Values are given in Hertz.

1 —enabled @ 1 Hz
2 —enabled @ 2 Hz
5 —enabled @ 5 Hz
10 — enabled @ 10 Hz
20 — enabled @ 20 Hz

Carrier Phase

Enables/disables true carrier

phase output.

« If the option is enabled, true
carrier phase is output.

« If the option is disabled, integral
Doppler is output for true carrier
phase. In this case the RTK
mode option will not be fully
available because only float
solutions can be obtained when
RTK using integral Doppler for
true carrier phase.

In TPS receivers other than

JGG20 and HEGG, this option is

always enabled.

yes — enabled
no — disabled

Ethernet Port Enables/disables the receiver to yes — enabled
communicate over Ethernet. no — disabled

TCP Enables/disables the receiver to 0 — disabled

Connections establish a certain number (5 1,2,3,4, 5 —number of
max.) of simultaneous Telnet-like | enabled Telnet
connections. connections.
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Table 3-5. Receiver Options (Continued)

Option Name Description Values
FTP Enables/disables the receiver to 0 — disabled
Connections establish an FTP connection (1 1 — enabled
maximum).
USB Port Enables/disables communications | no — disabled
through the USB port. yes — enabled
ADU Enables/disables the receiver to 0 — disabled
act as an attitude determination 1 — enabled for heading
unit. and pitch computation
2 —enabled for heading,
pitch, and roll
computation
CDU Support Enables/disables the receiver to no — disabled
be connected to a CDU-1 device. yes — enabled
Reserved For internal purposes only. no — disabled
Authorization Enable/disables the receiver to be | 0 — not authorized
authorized to work with a number | 1st bit (decimal 1) —
of programs. This is a bit-field authorized for Pinnacle
option, where each bit 2nd bit (decimal 2) —
corresponds to a specified authorized for PC-CDU
software. MS
3rd bit (decimal 4) —
authorized for
TopNET+
A combination of these
values is also available.
RTK distance Determines the maximum 0 — disabled
[x100m] allowed distance in hundreds of 511 — enabled without

meters between the reference and
rover stations. If the distance
between the reference and rover
stations exceeds the specified
limit, the receiver will not provide
the RTK position.

restriction

1...510 —enabled for the
specified distance (for
example, 120 means 12
km).
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Table 3-5. Receiver Options (Continued)

Option Name

Description

Values

Corrections
inputs

Enables/disables the
corresponding port to be set to
any differential data input mode.
This is a bit-field option, where
each bit corresponds to a specified
port.

0 — differential data
inputs disabled on all
ports

1st bit (decimal 1) —
serial port A enabled for
differential data input
2nd bit (decimal 2) —
serial port B enabled for
differential data input
3rd bit (decimal 4) —
serial port C enabled for
differential data input
4th bit (decimal 8) —
serial port D enabled for
differential data input
A combination of these
values is also available.

Latitude 1

Specifies the latitude of the upper
left corner of the rectangle area
within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

from -90 to 90

Longitude 1

Specifies the longitude of the
upper left corner of the rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

from O to 360

Latitude 2

Specifies the latitude of the lower
right corner of the rectangle area
within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

from -90 to 90
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Table 3-5. Receiver Options (Continued)

Option Name

Description

Values

Longitude 2

Specifies the longitude of the
lower right corner of the rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

from O to 360

Lat_Lon
checksum 1

Checksum of the Latitudel,
Longitudel, Latitude?2,
Longitude?2 options. Refer to the
GRIL Reference Manual for
details on how the checksum is
calculated.

from O to 511

0 — indicates that the
receiver is disabled to
compute its position
and output raw data
measurements

Latitude 3

Specifies the latitude of the upper
left corner of the second rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.

from -90 to 90

Longitude 3

Specifies the longitude of the
upper left corner of the second
rectangle area within which the
receiver can produce the position
information and output
measurement data.

Measured in degrees.

from O to 360

Latitude 4

Specifies the latitude of the lower
right corner of the second
rectangle area within which the
receiver can produce the position
information and output
measurement data. Measured in
degrees.

from -90 to 90
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Table 3-5. Receiver Options (Continued)

Option Name Description Values
Longitude 4 Specifies the longitude of the from O to 360
lower right corner of the rectangle
area within which the receiver can
produce the position information
and output measurement data.
Measured in degrees.
Lat_Lon Checksum of the Latitude3, from 0 to 511
checksum 2 Longitude3, Latitude4, 0 — indicates that the
Longitude4 options. Refer to the receiver is disabled to
GRIL Reference Manual for compute its position
details on how the checksum is and output raw data
calculated. measurements
mmGPS Enables/disables the receiver to no — disabled
use mmGPS. yes — enabled
Open mmGPS Not used at this time. n/a

a. Cinderella activates only if the receiver hardware supports GLONASS
and the L2 frequency.

Select Options File
Receiver options have either a *.tpo or *.jpo extension.

Select options file 2] x]
=l & & cF B

Look in: [ 59 HiPer Dptions

B

File name: — [SFTYLRI4M D10 Dpen |
Fies of type:  [Options files [ ~tpo: % jpo ) =l Cancel

Figure 3-46. Select Options File

* Look in — the directory/folder in which the OAF resides on the
computer.

* Open — loads the selected OAF to the connected receiver.

* Cancel — terminates the process and closes the dialog box.
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Plots Menu

The Plots menu contains options for configuring and view satellite
positions in relation to the current position of the receiver, as well as
the position information.

Scatter

The Scatter dialog box displays the receiver’s trajectory/position in
real time.

[# Scatter HIPER ID:8QIIIABPCSG 8 [=] B

Ayvg, Lat 55" 42'60.6607" N |RMS Pos hor 29219 m  |RMS Vel hor: 0.0292 m
Avg Lore 37 35'34 46B5°E  |RMS Pos ver 36519 m  |RAMS Vel ver 00365 m
Avg, Al 1985643 m RMS Pos:  46770m  |RMS Vel 0.0468 m

Total 1733 Standalone: 100% Code dift:0%  RTKfloat 0%  RTK fixed: 0%
Maw ETT:-3422m Max NTT: -2848m Avg ETT:0003m  Awg NTT: 0.000m

Clear all points | Fit all points

Figure 3-47. Scatter <Receiver ID>

To set the parameters to use for the scatter plot and status bar, see
“Configuration” on page 3-94 and the Plots Configuration dialog
box for details.

* Scatter plot — displays the current receiver position, as a red point,
relative to the position specified in the Target position dialog box
(see “Target Position” on page 3-68 for specifying this position).
The scatter plot is updated each second, unless a lower position or
raw data update rate has been specified.
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* Status bar — displays position information for the connected
receiver.

— Avg. Lat, Avg. Lon, and Avg. Alt: the average latitude,
longitude and ellipsoidal height of the receiver’s position over
the entire set of obtained position estimates.

— RMS Pos hor, RMS Pos ver, and RMS Pos: the horizontal,
vertical, and total position RMS errors. The total position
RMS error is the square root of the trace of the position error
variance-covariance matrix.

— RMS Vel hor, RMS Vel ver, and RMS Vel: the horizontal,
vertical, and total velocity RMS errors. The total velocity
RMS error is the square root of the trace of the velocity error
variance-covariance matrix.

— Total: the number of position estimates for each of the four
solution types.

— Standalone, Code, RTK float, and RTK fixed: the percentage
that this solution type contributes to the 7otal number of
position estimates.

—Max ETT and Max NTT: the maximum Easting to Target and
Northing to Target in the local system with the origin at the
receiver.

— Avg. ETT and Avg. NTT: the average Easting to Target and
Northing to Target in the local system with the origin at the
receiver.

The status bar is updated each second, unless a lower position or
raw data update rate has been specified.

* Clear all points — removes all plotted points from the scatter plot.

» Fit all points — changes the scale of the scatter plot to display all
plotted positions currently gathered with PC-CDU.

* Target to average — sets the target position equal to the average
receiver’s position.

The scatter plot and status bar will continue to update with current
information, even after closing the dialog box, until the receiver is
disconnected from PC-CDU.
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Satellites

The Satellites dialog box displays a graphic representation of satellite
positions, DOP information, and the satellites’ signal-to-noise ratios.

[# Satellites HIPER 1D:8QIIABPCSG 9 [=] B3

GI9---___
GDOP: 1501 47
FDOF: 1.242
HDOP: 0663
YDOP: 1.045
14=10+4
Elevation mask

= Gl G5 G7 G116G146G196206226G256G31 R3 R4 R5 R21
(@l F M FFMEFREFERERFENREREF

Figure 3-48. Satellites <Receiver ID>

* Satellite plot — displays elevation angles and satellite location.

— Concentric circles: represents the elevation angle above the
horizon in 10 degree increments. The outermost circle
corresponds to 0 degrees above the horizon; the center of the
sky plot represents 90 degrees above the horizon.

— Dotted circle: the position/angle of the elevation mask. See
“Elevation Mask Form” on page 3-92 for more information.
(In Figure 3-48, the elevation mask is set to 5 degrees.)

— GPS and GLONASS satellite icons: displays the type of
satellite begin tracked, the direction of travel for the satellite,
and the satellite’s ID (Figure 3-49 on page 3-91). The color of
the satellite icon corresponds to the colored bars in the
signal-to-noise ratio histogram.

In PC-CDU, GPS/WAAS satellite IDs begin with a “G”;
GLONASS satellite IDs begin with an “R”.
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See “Satellite Pop-up” on page 3-92 for details on viewing
basic tracking information for individual satellites.

GPS/WAAS satellite\>(f e // Direction of travel

satellite D — | [~ GLONASS satellite

Figure 3-49. GPS and GLONASS Satellite Icons

* DOP characteristics — displays Dilution of Precision information.

— GDOP: the Geometrical Dilution of Precision (3 position
coordinates plus clock offset in the solution).

— PDOP: the Position Dilution of Precision (3 coordinates).

— HDOP: the Horizontal Dilution of Precision (2 horizontal
coordinates).

— VDOP: the Vertical Dilution of Precision (height only).

— Number of satellites in view: the total number of satellites in
view, including the number of GPS and GLONASS satellites.

(In Figure 3-48, 10 GPS satellites are in view and 4
GLONASS satellites are in view for a total of 14 satellites.)

* Signal-to-noise ratio histogram — displays the continuously
updated signal-to-noise ratio (C/N)) in the C/A channel for
tracked satellites.

— Histogram bars — displays the corresponding satellites PRN
(for GPS and WAAS) or slot number (for GLONASS). The
bar’s color corresponds to the satellite’s icon color in the
satellite plot.

— Satellite checkboxes: enables/disables the corresponding
GPS, GLONASS, and WAAS satellite for position
computation.

In PC-CDU, GPS/WAAS satellite IDs begin with a “G”;
GLONASS satellite IDs begin with an “R”.
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* Elevation mask — the minimum angle above the horizon, in
degrees, for satellites that the receiver will use for position
computation. See “Elevation Mask Form” on page 3-92 for more
information.

* Clear data — clears the current data from the dialog box;
equivalent to a refresh of data. As the receiver continues to track
satellites, new information will display on the Satellites dialog
box.

Elevation Mask Form

The ElevationMaskForm dialog box describes a minimum angle
above the horizon, in degrees, for satellites that the receiver will use
for position computation.

[ ElevationMaskForm B
Elevation mask for position computation: [15 (dearees]

Cancel

Figure 3-50. ElevationMaskForm

* Elevation mask for position computation — applies an elevation
mask angle in degrees above the horizon.

* Ok — applies/saves this setting and closes the dialog box.

* Cancel — closes the dialog box without applying an elevation
mask.

Satellite Pop-up

The satellite pop-up displays basic tracking information for the
selected satellite. This information is similar to that seen on the Main
screen.

Click and hold a satellite to view the pop-up.

GT1 G11
EL A7 CA P1 P2 55
B3 223 52 17 17 0

CA data uzed for position
computation

Figure 3-51. Basic Tracking Information Satellite Pop-up

3-92 PC-CDU Reference Manual



Plots Menu

Position

The Position dialog box displays continuously updated graphs that
show the difference between latitude/longitude of the receiver
position and latitude/longitude specified in the Target position dialog
box over a user-defined time interval.

[ Position HIPER ID:801IIABPCSG JH [=] B3

B Latitude

30m

wm Longlitude:

= S
1] 130 Os

30m

Figure 3-52. Position <Receiver ID> (<receiver type>)

To set the intervals used on these graphs, see “Configuration” on
page 3-94 and the Plots Configuration dialog box for details.

» Horizontal axis — displays the time interval (in seconds) over
which PC-CDU computes the differences.

— The time interval range, over which the differences are
displayed, varies between O seconds (the current moment in
time) and a value entered in the Time interval parameter.

— The interval between values along the axes corresponds to the
value entered in the Time step parameter.

For example, the graphs in Figure 3-52 show a range of values
from 0 seconds to 360 seconds with an interval of 20 seconds.

* Vertical axis — displays the difference (in meters) between a
particular position of the receiver and a fixed position of a target.

— The range of deviations that can be viewed is set using the
Max. deviation parameter.
— The interval between values along the axes corresponds to the
value entered in the Deviation set parameter.
For example, the graphs in Figure 3-52 show the range of
deviations from 0 meters to 30 meters with an interval of 10
meters.
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Configuration

The Plots Configuration dialog box configures the settings used to
display information in the Scatter and Position dialog boxes.

[ Plots Configuration B

 Points color Scatter
Standalone O memm 300000 | [m) [¥# Standalone

Code differential [l ¥ Code differential
RTK float Tick interval: |2.0000 [m]  RATK float

RTK fixed 1

~Positior Gerers!

Time interval  [380 Is] Valuestokeep: [3800
M. devistior: [00000 {mn, O or sute)

W Show aid

Time step: 20 (&)
Deviaiion step: [12.0000 ] e | e

[¥ Showaid [ Connectpoints @ RTK fixed

Figure 3-53. Plots Configuration

* Points colors — applies specific colors to Standalone, Code
differential, RTK float, and RTK fixed points displayed in the
Scatter dialog box.

To change the color, click the color box next to the point type.
Click the desired color or define a custom color, then click Ok.
* Scatter — applies settings and parameters used to display
information in the Scatter dialog box.
— Plot Width: specifies the length of the axes on the plot.

— Tick Interval: specifies the tick size (in meters) between the
adjacent concentric circles (that is, interval between adjacent
values on the axis).

— Show grid: shows/hides the circle grid from the plot.

— Connect points: if disabled, plots positions as discrete points;
if enabled, plots positions as a trajectory.

— Standalone, Code differential, RTK float, RTK fixed:
specifies the type of solution to display on the plot.

Use a unique color for each solution type.
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* Position — governs the display of information on the graphs in
Position dialog box.

— Time interval: specifies the length of the x axis (in seconds).

— Max. deviation: specifies the length of the y axis (in meters).
Zero (0) means that the vertical axes will always be scaled
automatically according to the maximum deviation value
within the currently displayed time interval.

— Show grid: shows/hides gridlines for the graphs.
— Time step: specifies the time (in seconds) between adjacent
vertical gridlines.

— Deviation step: sets the distance (in meters) between adjacent
horizontal gridlines.

* General — sets the circular buffer size for managing computer
memory during long graph monitoring sessions.

— Values to keep: determines the size of a circular buffer used to
store the positions of the receiver’s antenna. The default value
is 3600.

When the buffer is full, the new values overwrite the oldest
values. This circular buffer is used to save computer memory
consumption when the graphs have been monitored for a long
time (continuously during several hours, days, etc.).

* Apply — saves/applies the settings and closes the dialog box.

* Cancel — closes the dialog box without applying changes.
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Help Menu

The Help menu contains options for viewing software information
and receiver specifics.

About

The About PC-CDU dialog box displays software version and
receiver information (after establishing connection).

[ About PC-CDU x|

PC-COU for Windows 95/98/ME/NT /2000/%P
Wersion 2.1.14 MS (Build: October 14, 2004)
Status : Authorization check.
Copyright © Topeon Positioning Spstems . 2000 - 2004 PC-CDU
hitpe /v topcongps com

Receiver model: ODYSSEY_E =
Feceiver ID: AEBQIPEZUO0
Firmware version: 2.4 Sep 02,2004
RTK support: yes
tainboard version: E_GGD_2
FAM size 2048KB
Power Board: =3, =42
Power supply (v) 11.9
Antenna input: ext
Ext. Ant DC status:  off
|

Savetofie |  Repot | Rehesh | ok |

[
Figure 3-54. About PC-CDU

* Software information — displays information for PC-CDU on
supported operating systems, version and build date, software
status, copyright and publisher, and the TPS website.

* Receiver information — displays a list of information about the
connected receiver. Table 3-6 gives a description of the items in

this list.

Table 3-6. Receiver Information List

Field

Description

Receiver model

The model of the connected receiver.

Receiver ID

The electronic identifier of the connected receiver.

Firmware version

The firmware version installed on the receiver board.

RTK support

Shows whether or not the receiver can work in RTK mode.

Mainboard version

The version of the GNSS board.

RAM size

The size of the receiver RAM in kilobytes.

Power Board

The hardware and firmware version of the power board.
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Table 3-6. Receiver Information List (Continued)

Field

Description

Power supply (V)

The voltage of the external power supply.

Antenna input

Shows whether the receiver uses an internal or external
antenna to acquire GNSS signals.

Ext. Ant. DC status

Indicates if an external antenna draws acceptable DC
current.

Power source

Shows the receiver’s power source.

Power cur.source

Displays the receiver’s current source of power.

Charger status

Displays the mode of a charger used to restore power to
internal batteries.

Charger cur.status

Displays the current mode of a charger.

Battery A(V) Shows the voltage of the battery A.

Battery B(V) Shows the voltage of the battery B.

On board (V) Displays the voltage that the receiver board draws.

Charger (V) Displays the output voltage of the internal charger during
battery charging.

On ports (V) Displays the output voltage on the first pin of each of the

receiver’s serial port.

Digital part 3.3V (V)

Displays the voltage across the digital part of the receiver
board.

Analog part 3.3V (V)

Displays the voltage across the analog part of the receiver
board.

Digital part 5V (V)

Displays the voltage across the digital part of the receiver
board.

Analog part 5V (V)

Displays the voltage across the analog part of the receiver
board.

Temperature (°C)

Displays the current temperature of the receiver board.

Flash memory size

Displays the amount of available memory in the receiver for
raw data storage.

Flash memory free

Displays how much receiver memory is free.

Number of files

Shows the number of raw data files in the receiver memory.

Bad blocks

Displays the number of bad blocks (if any) in the receiver
memory.

Write verity

Displays the state of the “write verify” feature.

Block size

Displays the block size of the receiver’s memory.
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Table 3-6. Receiver Information List (Continued)

Field

Description

Blocks for files

Displays the total amount of the receiver’s physical memory
in blocks.

Physical memory

Displays the total amount of the receiver’s physical memory
in bytes.

Current port

Shows the port the receiver currently uses for
communication with PC-CDU.

Speed Shows the baud rate at which the receiver communicates
with the computer.

Parity Shows whether or not parity checking is being used. If used,
displays the form of parity checking.

Stop bits Shows the number of bits used to mark the end of a byte.

RTS/CTS Shows whether or not hardware handshaking is being used.

Infrared Shows the status of the infrared port.

Time from last reset

Shows the time elapsed since the last receiver reset.

Hardware version

Shows Topcon specific information.

Boot loader version

Shows Topcon specific information.

Wait states

Shows the flash memory access time expressed in wait
states.

* Save to file — records the receiver’s configuration information to a
text file to the computer. This information is useful when
contacting TPS for troubleshooting and service.

» Report — records the contents of this dialog box and the status of
the receiver’s options to a text file on the computer. This
information is useful when contacting TPS for troubleshooting

and service.

» Refresh — updates the receiver information list.

* Ok — closes the dialog box.
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Chapter 4

Troubleshooting

This chapter provides information on how to identify and remedy
minor software problems.

Check This First!

Before contacting TPS Customer support about any problems with
the PC-CDU software, refer to the following list of basic suggestions
that may help:

Check all external receiver connections carefully and make sure
they are securely and properly connected.

Double-check all cables; cables become defective more often
than the devices do.

See the section below for solutions to various error messages.
Reset the receiver using PC-CDU (Tools » Reset receiver).

Restore factory default settings using PC-CDU (click
Configuration » Receiver, then Set all parameters to defaults).

Clear the NVRAM.

Initialize the file system using PC-CDU (click Tools » Initialize
file system; this will erase all files inside the receiver).
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Error and Warning Messages

Table 4-1 lists some of the error messages and warning dialog boxes

that PC-CDU may display, along with possible causes and corrective
actions. Error messages usually display in the status bar of the current
dialog box or screen.

Table 4-1. Error and Warning Messages

Message

Possible Cause

Corrective Action

Can't find receiver

The receiver is turned off.

Apply power and turn
the receiver on.

The wrong computer port
specified.

Select the correct
computer port.

The receiver port you are
trying to connect to is not
in command mode.

Use another free receiver
port to connect with a
computer.

Can't connect to the
server

PC-CDU Internet Server is
not started.

Configure and run
PC-CDU in Internet
Server mode. For details,
see “Internet Server
Mode” on page 1-20.

PC-CDU Internet Server is
improperly configured.

Check the Internet
Server configuration. For
details, see “Internet
Server Mode” on

page 1-20.

PC-CDU Internet Client is
improperly configured.

Check the Internet Client
configuration. For
details, see “Internet
Client Mode” on

page 1-22.

4-2
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Error and Warning Messages

Table 4-1. Error and Warning Messages (Continued)

Message Possible Cause Corrective Action
* Can't set PC-CDU and the receiver Check the cable
<parameter> are disconnected. connection between the

* Can't set <value>
for <parameter>

* Incorrect
<parameter> value

¢ Invalid <parameter>

e Invalid value for
<parameter>

receiver and computer
and restore the
connection. For details,
see “Starting PC-CDU”
on page 1-5.

The parameter value is out
of acceptable range.

Specity the value within
the range of the selected
parameter.

Converter application
file not found!

PC-CDU cannot locate the
tps2rin._exe file in the
specified path.

Make sure you have this
file on the computer and
double-check the file
location.

Modem not found

The wrong receiver port is
being used for connection.

Select the correct
receiver port. For details,
see “Radio > RFM96” on
page 3-69.

The receiver does not have
a radio modem installed.

Open COMX port
failed: Access is
denied

(where x — 1, 2, 3,
4,.)

Another application uses
the computer port
dedicated for connection

Close the application,
then re-connect.

Alternatively, connect
the receiver via another,
unused computer port.
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Troubleshooting

Table 4-1. Error and Warning Messages (Continued)

Message

Possible Cause

Corrective Action

Unable to create file

The receiver has no free
space for files.

Download receiver files
to a computer and then
delete unnecessary files
from the receiver. For
details, see “How to
Download Files to a
Computer Using File
Manager” on page 2-6.

The receiver has no
memory.

Contact your dealer to
equip the receiver with
memory.

The receiver has already
logged 512 files into the
internal memory.

Delete unnecessary files.

File name contains
not allowed characters

Certain characters cannot
be used in the name of the
log file.

Rename the log file
using only allowed
characters. The
following characters
cannot be used in the
name of the log file:
space, comma, { }, (), @,
&, ", I\

The <filename.tps>
already exists. Do you
want to overwrite the
file or append to it?

During file download,
PC-CDU has detected that
a file with the same name
already exists in the
destination folder.

Note that PC-CDU keeps
the same file names and
extensions during a
download.

Click Overwrite to
replace the file.

Click Append to add data
from the new file to the
current file. Only select
this option when
continue the process
after an interruption.
Click Cancel to stop the
download. To keep new
and old files separate.
select a different folder
in which to download
data file.

4-4
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Table 4-1. Error and Warning Messages (Continued)

Message

Possible Cause

Corrective Action

Last warning: Waiting
for 1st block

During a file download,
PC-CDU cannot retrieve
the next block of data from
the receiver.

Usually, a larger block size
will assist with efficient
data transfer. However, if
the connection between the
computer and receiver is
unreliable, reducing the
block size can minimize
communication errors.

Select a higher baud rate
for transferring data.
Select a smaller block
size for retrieving data.
Use another
communication port at
the computer.

All files with such
names as <file
name(s)> etc. residing
in the folder <folder
name> will be
overwritten without
warning. Continue?

The “Overwrite existing
files” field has been
enabled on the Real-Time
Logging tab. This message
will display after clicking
Start.

To pick the files to
overwrite, click No and
disable this field. After
clicking Start, the names
of recorded files will
increment starting from
the first unused value,
not necessarily from
0000.

Click Yes to perform this
action.
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Troubleshooting

Obtaining Technical Support

If the troubleshooting hints and tips in this manual fail to remedy the
problem, contact TPS Customer Support.

Phone

To contact TPS Customer Support by phone, call:

1-866-4TOPCON (1-866-486-7266)
Monday through Friday, 8am to 8pm, Eastern Standard time

To contact TPS Customer Support via e-mail, use the following
electronic mail addresses (Table 4-2).

Table 4-2. Technical Support E-mail

For Questions Related To... Use...
PC-CDU pccdu@topcon.com
GPS+ and 3DMC psg@topcon.com

If in doubt about which e-mail address to use for your particular
question, send your question to support@topcon.com.

N To provide you with quick and effective support,
provide a detailed description of the problem.

When emailing TPS customer support, provide the following
information for more efficient service:

1. The receiver model and configuration settings.

In PC-CDU, click Help » About and click Save to file. Enter a
name for the file and save it to your computer. Attach this file to
the email.

2. The system/hardware specifications for the computer running
PC-CDU; such as, operating system and version, memory and
storage capacity, processor speed, etc.
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Obtaining Technical Support

3. The symptoms and/or error codes/messages that precede and
follow the problem.

4. The activities being tried when the problem occurs. If possible,
include the exact steps being taken up to when the error message
or other problem occurs.

5. How regularly the problem occurs.

Generally, a customer support representative will reply within 24
hours, depending on the severity of the problem.

Web Site

The Topcon Positioning Systems website provides current
information about Topcon’s line of products. The support area of the
website provides access to various support information, including
contact details, dealer locations, service, etc.

To access the TPS website home page, use:

wWwWw.topconpositioning.com
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Notes:
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Appendix A

PG-GDU Scripts

This appendix will help you write PC-CDU scripts and describes
following:

* the script language components, including variables and
commands

* the syntax of the commands, their function and usage

Introduction to Scripting

Script is a plain text file where each line is either a receiver command,
a PC-CDU command, or a comment. Scripts allow you to save a set
of manual commands into one file. You can then load this single
script instead of typing each individual command.

Variables

Variables are special character sequences that allow you to store some
specific values’ in scripts. They can then be used in place of the
values they store while running the script.
Currently PC-CDU supports the following ten variables:

@], @2, @3, @4, @5, @6, @7, @8, @9, @0

The first nine of these variables initially contain the values of the
script's command line arguments.

The “@0” is read-only and initially contains the script name specified
in the command line. In the course of script execution, it will either
contain the last of the receiver's positive acknowledgements (that is,
the most recent of the RExXXX replies), or remain empty.

3. Specified by the user and stored by PC-CDU.

P/N 31-000004-01 A-1



PC-CDU Scripts

After getting a “REXXX” reply from the receiver, PC-CDU will
search the received sequence for the last «%» symbol it contains.
PC-CDU will assign to the variable @0 only the characters following
immediately after the last «%» symbol (until the end of this sequence
is found). Leading and trailing spaces are trimmed.

Other commands include the following:

* The command “@default” assigns default values to these
variables unless the corresponding arguments have already been
specified through the script command line.

* The “@set” command changes the value associated with a
variable. The @set command also assigns the value of @0 to
other variables.

PC-CDU Commands

Essentially, a PC-CDU command is a single word that instructs the
receiver to perform a certain function.

Any line starting with the “@” character is interpreted as a PC-CDU
command with optional arguments separated by commas or spaces.
Table A-1 describes the supported commands.

Table A-1. List of PC-CDU Commands

Command Arguments Description
:<label Specifies a label to have the PC-CDU’s
name> command interpreter jump to.

Label names should not contain spaces
or commas. See the “goto” command
on page A-3 for how to use labels.

call <script name> Executes another script from within the
[<arguments>] current script.

The maximum number of recursive
calls is 200.

clear Removes issued commands and
receiver replies from the Manual Mode
dialog box.
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Table A-1. List of PC-CDU Commands

Command Arguments

Description

default <variable> <default value>

Defines the default values for those
script arguments not explicitly specified
in the command line.

For example,
@default @1 a

assigns the value “a” to the variable @1,
unless this argument is already defined
in the command line.

disconnect

Stops script execution, disconnects
PC-CDU from the receiver, and closes
the Manual Mode dialog box. This is
the same clicking Disconnect.

echo on
off

any character sequence

Turns echo on and off, or displays its

arguments.

e If echo is turned on, PC-CDU will
display all non-empty lines entered in
the script, specifically, PC-CDU
commands, receiver commands, and
the corresponding reply messages.

e If echo is turned off, PC-CDU will
display only replay messages with the
“>” preceding character.

PC-CDU will not show @echo off and

@echo on commands.

Default is “on”.

exit

Stops script execution, disconnects
PC-CDU from the receiver, and exists
PC-CDU.

goto <label name>

Jumps to the line following
immediately after @:<label name>.

If PC-CDU cannot find such a label in
the script, this command is ignored and
PC-CDU continues with the script.
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Table A-1. List of PC-CDU Commands

Command

Arguments

Description

send

<bytes to send>

Sends the argument to the receiver as is,
without making any substitutions. This
string may contain escape sequences in
a C-like style to represent non-printable
characters.

Sequence | Value |Character

\a 0x07 |BEL

\b 0x08 |BS

\f 0x0C |FF

\n 0x0A |LF

\r 0xO0D |CR

\t 0x09 |HT

\v 0x0B |VT

\ 0x5C | Backslash

\" 0x22 | Double quote

\O any O (octal character
code)

\xH any H (hexadecimal
character code)

Example:
@send "#OFF#\r\n"
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Table A-1. List of PC-CDU Commands

Command

Arguments

Description

set

¢ rate <new baud rate>
¢ rtscts [on,off]
e <variable> <value>

These commands assign both serial port
parameters and PC-CDU's internal
variables.

Example 1: a script has the following
commands:

@set @1 "a text"
@echo @1

When the script interpreter reaches the
echo command, the following reply
displays:

>a text

Example 2: assign the current
terminal's baud rate to @2:
%%print,/par/cur/term/rate
@set @2 @O0

sleep

integer number of
milliseconds

PC-CDU interrupts script execution for
a specified number of milliseconds.

stop

Stops script execution.

stoponerrors

on
off

Enables/disables PC-CDU’s stop-on-
error option. This indicates whether
PC-CDU will stop script execution
after getting an ERxxx message from
the receiver. Default is “on”.
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Table A-1. List of PC-CDU Commands

Command Arguments Description
timeout integer value in If a receiver command starts with a “%”
milliseconds, default is symbol, PC-CDU will wait for the
5000 receiver to reply within the specified

timeout interval.

e If a reply is received during this time,
it will be saved to the variable @0.

* If no reply is received over the
timeout interval, if after receiving a
few bytes PC-CDU gets no more data
for 100+ milliseconds, or if PC-CDU
receives continuous data for more
than 100 milliseconds, @0 will be
undefined (however, script execution
will continue). In this case, you may
need to adjust the timeout interval to
be sure that the variable @0 contains
correct information.

Receiver Commands

Scripts can specify arguments for receiver commands, either
explicitly or through variables.

When using variables to specify arguments, PC-CDU will substitute
the variable for some specific value before sending the command to
the receiver. If sending a receiver command that starts with “%”
(command label), PC-CDU will wait for the receiver to reply and, if a
reply is received, will save the reply to the variable @O.

Currently the character “@” is used in GRIL commands to delimit the
command checksum. This character should not cause any problems
since PC-CDU automatically adds a checksum for every command
sent to the receiver.

PC-CDU does not interpret receiver commands. For example, if using
receiver commands that change the baud rate and/or handshaking for
the current receiver port (that is, the port to which PC-CDU is
connected), use the appropriate @ set commands immediately after
the receiver command, as shown on the next page.
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%%set,/par/cur/term/rtscts,off

@set rtscts,off

%%set,/par/cur/term/rate, 9600

@set rate,9600

Or specify these types of receiver commands at the end of the script,

immediately before @disconnect or @exit. Otherwise, PC-CDU may
be locked up waiting for the receiver to reply.

The following examples illustrate various script applications.

* The following script configures the TPS receiver with a third
party beacon receiver for serial port output. described in the
article Using the Coast Guard Beacon for Differential
Corrections (http://www.topcongps.com/support/how-to/
beaconsetup.html).

@default @1,c
%hset,dev/ser/@1/imode, rtcm
%Whset,dev/ser/@l/rate, 9600
%%set,/par/pos/mode/cur,cd
%%em, ,/msg/nmea/GGA: 1
@exit
After saving these lines to a file (for example, beacon. jpc),
type in the command line @beacon and click Enter to instruct
the receiver to input RTCM corrections from serial port C and

output NMEA messages to the current terminal. To use serial port
B for inputting corrections, type @beacon b and press Enter.

* The following script illustrates how the goto command and
labels are used in scripts intended to work with different receiver
models.

%/par/rcv/model%print,/par/rcv/model
@goto 1s@0

@echo Unknown receiver model.

@stop

@:1sOdyssey

@echo Receiver is Odyssey!

@goto end
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@:IsLegacy

@echo Receiver is Legacy!
@goto end

@: IsEurocard

@echo Receiver i1s Eurocard!
@: IsHIPER

@echo Receiver is HIPER!
@goto end

@:-end

@stop

Writing and Editing Scripts

You can create and edit scripts directly in the PC-CDU’s Manual
Mode dialog box or in any text editor, such as Notepad.

To create a script:

1. Navigate to the Manual Mode dialog box and click Edit
script.

Enter the name of a new script in the File name field.
Click Open.

Type the script commands.

ANl

Click the Save script button.

~, . . . 13 ’
% Save scripts using the extension “.tpc”.

To edit an existing script:

1. Navigate to the Manual Mode dialog box and click Edit
script.

2. Navigate to a list of available scripts, select the desired script
name, and click Open.
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3. Make the necessary changes in the script and click Save
script.

4. Click Close editor.

For easy access to scripts, keep them all in one
% directory, for example in PC-CDU’s working

directory.

Running Scripts via PC-CDU

In PC-CDU, the Manual Mode dialog box loads and runs scripts.

1.

3.

Type @ and enter the script name (for example, @my_script)
in the command line.

OR

Click the Load script button and select the required script from
the Script file dialog box.

Specify script arguments, if required.

Delimit script arguments using either spaces or
commas. If an argument in the command line
contains separators (spaces and/or commas), put
quotes around the argument; for example,
@myscript “This is one argument”.

Click Send command.

After clicking Send command, PC-CDU will read the script file line
by line andy carry out the following operations, if necessary:

skipping empty and comment lines

replacing variables with their specific values

echoing non-empty lines to the screen (if echo is enabled)
interpreting PC-CDU internal commands

sending commands to the receiver and (optionally) waiting for
receiver replies

To abort a script execution, click Stop script.
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Running Scripts via Windows
Explorer

Files with the extension “.tpc” are automatically associated with
PC-CDU, meaning that clicking on a scrip file from Windows
Explorer will launch PC-CDU in Manual mode.

When the Connection Parameters dialog displays, click Connect to
open the Manual Mode dialog box.

Note, however, that the selected script will not automatically start.
The name of the script must be entered into the command line and
Load script clicked.

After exiting Manual mode, you can continue working with PC-CDU
in the usual way.
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Appendix B

Settings List

This appendix provides a complete list of PC-CDU settings including
their values and ranges (if applicable), units (if applicable), and dialog
boxes/windows/panes on which these parameters are described in
detail.

Connection Parameters

Table B-1 provides a list of settings that are available in the
Connection Parameters dialog box. If applicable, the default value
for a setting is shown in italics.

Table B-1. Connection Parameters Settings

Parameter Values/Range Units Wheret.o F|nd
Description
* Direct
Connection Mode | e Internet Client - page 1-5
* Internet Server
Port settings Area
* COM#’s page 1-8,
* USB page 1-9,
Port * LPT - page 1-12,
* ETHR page 1-15,
page 1-19
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Table B-1. Connection Parameters Settings (Continued)

Parameter Values/Range Units Wheret_o '.:md
Description
* 4800
* 9600
* 19200
* 38400
Baud rate . 57600 bps page 1-8
¢ 115200
* 230400
* 460800
* enabled
Infrared port « disabled - page 1-6
RTC/CTS * enabled 3 ace 1-6
handshaking e disabled pag
TCP port 1-15
(for Ethernet 1...8002...65536 - page 222
. page 1-19
connection only)
Host name * 0.0.0.0 ... 1215
(for Ethernet 255.255.255.255 - page 1-1>,
. : page 1-19
connection only) * not specified
Password eupto 15 a/n
page 1-15,
(for Ethernet characters -
. page 1-20
connection only) * no password
Program Settings Area
. * enabled
Passive mode « disabled - page 1-7
* enabled
Manual mode only | disabled - page 1-7
* 500
* 1000
* 2000
Timeout * 3000 milliseconds page 1-7
* 4000
* 5000
* 10000
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Connection Parameters

Table B-1. Connection Parameters Settings (Continued)

Whereto Find

Parameter Values/Range Units L
Description
Restore the * enabled
receiver’s original | e disabled ave 17
baud rate on B bag
Disconnect
Internet (Client - Server) settings Area
¢ localhost
* 0.0.0.0 to page 1-7,
Host name 255.255.255.255 - page 1-22
* DNS addresses
TCP port 1...8000...65536 - page 17,
p page 1-22
e upto 128 a/n page 17,
Password characters -
page 1-22
* no password
Display data on * enabled
server * disabled - page 1-7
* enabled
Log server events | disabled - page 1-8
* enabled page 1-8,
DNS lookup « disabled - page 1-22
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File Manager

Table B-2 provides a list of settings that are available in the File
Manager dialog box. The default value for a setting is shown in

italics (if applicable).

Table B-2. File Manager Settings

Parameter

Values/Range

Units

Where to Find

Description
Download files Tab
Exclusive mode : grizﬁ{;d - page 3-12
* 512
Block size * 1024 bytes page 3-12
* 2048
Current log file Tab
File name : igi] sS}El:(I:Ii%e J - page 3-14
Recording interval 0...1...86400 seconds page 3-14
Elevation mask -90...5...90 degrees page 3-14
Download path Tab
New folder any string - page 3-16
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Real-Time Logging

Table B-3 provides a list of settings that are available in the Real-
Time Logging dialog box. The default value for a setting is shown in
italics (if applicable).

Table B-3. Real-Time Logging Settings

Parameter Values/Range Units V\/Dh:sfrtigt::ci)rr:d
Single file Tab
Save to ufh:;azciei/sn - page 3-19
Recording interval 0...1...86400 seconds page 3-17
Elevation mask -90...5...90 degrees page 3-18
Multiple files Tab
Prefix ufh;(;alc?ei/sn - page 3-20
Numbering . ng:r;h%gmiount - page 3-20
* minutes
New file every any integer number ¢ hours page 3-21
e days
Autoconvert to * enabled
RINEX - disabled - page 3-21
Start Count 0...999999 - page 3-21
Overwrfl‘ltlee :x1st1ng : Zril:gleecii _ page 3-21
Recording interval 0...1...86400 seconds page 3-17
Elevation mask -90...5...90 degrees page 3-18
Select output path Tab
New folder * any string - page 3-24
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Receiver Configuration

Table B-4 through Table B-11 on page B-26 provide a list of settings
that are available in the Connection Parameters dialog box. The
default value for a setting is shown in italics (if applicable).

Table B-4. Connection Parameters Settings — General Tab

Where to Find

Parameter Values/Range Units o
Description
Elevation mask Area
Terminal Elevation
Mask -90...5...90 degrees page 3-28
e Internal
Antenna * External - page 3-28
* Auto
Antenna Status Area
e int
Current Input . ext - page 3-29
e off
Ext. DC Status * normal - page 3-29
* overload
Temperature Area
Board temperature a numeral oC page 3-29
Power management Area
* Auto
* Mix
Power->Mode * Battery A - page 3-29
* Battery B
* External
* mix
Power->Current * ext
Mode ca - page 3-29
*b
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Table B-4. Connection Parameters Settings — General Tab (Continued)

Parameter Values/Range Units Where t'o F'nd
Description
» Off
* Charge A
Charger->Mode « Charge B - page 3-30
* Auto
* normal
Charger->Speed . fast - page 3-30
Charger->Current : fo _ ace 3-30
Mode page >
*b
Charger->Current * a numeral Amperes page 3-30
Power output * enabled
modes->Ports A,B * disabled - page 3-30
(for Odyssey only)
Power output * enabled
modes->Port C (for | e disabled - page 3-30
Odyssey only)
Power output - Off
pu * On - page 3-30
modes->Ports
* Always
Power output = Off
modes->Slots * On - page 3-30
* Always
Voltages->
float values Volts page 3-31
External
Voltages->
float values Volts page 3-31
On Board
Voltages->
float values Volts page 3-31
Battery A
Voltages->
float values Volts page 3-31
Battery B
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Table B-4. Connection Parameters Settings — General Tab (Continued)

Parameter Values/Range Units Where t'o Find
Description
Voltages->
float values Volts page 3-31
Charger
Voltages->
On Port float values Volts page 3-31
n Ports
Turn on/off Slots -  enabled 3 ace 331
>Slot 2 (C)  disabled pag
Turn on/off Slots - * enabled 3 ace 331
>Slot 3 (B) « disabled pag
Turn on/off Slots - * enabled 3 ace 331
>Slot 4 (D) « disabled pag
Enable Low Power e enabled 3 ace 331
Mode « disabled pag

Table B-5. Connection Parameters Settings — MINTER Tab

Where to Find

Parameter Values/Range Units S
Description
Recording Interval 0...1...86400 seconds page 3-31
Elevation mask for
Log file -90...5...90 degrees page 3-32
* log
File name prefix e up to 20 a/n - page 3-32
characters
Always append to up to 20 a/n
the file characters - page 3-32
. * Log file
Flle Creation mode | AFRM - page 3-32
Automatic File Rotation Mode (AFRM) parameters Area
Period 60...3600...86400 seconds page 3-32
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Table B-5. Connection Parameters Settings — MINTER Tab (Continued)

Parameter

Values/Range

Units

Where to Find

Description
Phase 0...86400 - page 3-32
Files (total) 0...2311 - page 3-32
Files (remain) integer values - page 3-32
Automatically * enabled
remove old files * disabled - page 3-32
FN key mode Area
* LED blink mode
switch
FN key mode * Occupation mode - page 3-33
switch
Initial data collection dynamic mode Area
Initial data * Static
collection dynamic | * Kinematic - page 3-33
mode
Data recording auto-start Area
.  Off
Data recording auto- | On _ page 3-33
start
* Always

Table B-6. Connection Parameters Settings — Positioning Tab

Parameter

Values/Range

Units

Where to Find
Description

Positioning Mode Area

Positioning Mode

 Standalone

* DGPS (Code
Differential)

¢ RTK Float

¢ RTK Fixed

page 3-35
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Table B-6. Connection Parameters Settings — Positioning Tab (Continued)

Where to Find

Parameter Values/Range Units S
Description

Positioning Masks Area

Elevation mask -90...5...90 degrees page 3-35

PDOP mask 0...30...500 - page 3-35

RAIM Enabled Area

* enabled
RAIM Enabled « disabled - page 3-35

* Manual
* Non-precision
Alarm « Terminal - page 3-35

¢ En route

Alarm limit 10...555.6...10000 meters page 3-35

e datum IDs list
Current Datum .« W84 - page 3-35

Enable Solutions Area

* Standalone
. * DGPS
Enable Solutions « RTK Float - page 3-36

* RTK Fixed

Positioning System Area

e enabled
GPS + disabled - page 3-36

* enabled
GLONASS « disabled - page 3-36

Measurements Used Area

* CA/LL
* P/L1
Measurements Used | PIL2 - page 3-36

¢ Jono-Free
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Receiver Configuration

Table B-6. Connection Parameters Settings — Positioning Tab (Continued)

Where to Find

Parameter Values/Range Units S
Description
. * enabled
Tono-Correction « disabled - page 3-36
. * enabled
Topo-Correction « disabled - page 3-37
Satellite management Area
Satellites tracked * enabled 337
>GPS * disabled B page -
Satellites tracked e enabled age 337
>GLONASS * disabled - page -
Satellites used in * enabled ace 3-37
pos.->GPS « disabled - bag
Satellites used in * enabled ace 3-37
pos..>GLONASS |  disabled - bag
GPS Subtab
* enabled
lock « disabled - page 3-37
* enabled
use « disabled - page 3-37
GLONASS Subtab
* Frequency
Satellite Numbering Channel Number - page 3-37
* Slot Number
lock * enabled
 disabled - page 3-37
use * enabled
 disabled - page 3-37
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Settings List

Table B-6. Connection Parameters Settings — Positioning Tab (Continued)

Parameter

Values/Range

Units

Where to Find

Description
WAAS Subtab
Channel 1 * enabled
or * disabled - page 3-38
Channel 2
Set WAAS 120...138 - page 3-38
as GPS 1..32 - page 3-38
Interpret message #0 0..99 : page 3-38
as message: #
Use Iono : Neve.r
. o If exist - page 3-38
Corrections
* Only
Enable output of * enabled
«true» WAAS PRN | e disabled - page 3-38

numbers

Table B-7. Connection Parameters Settings — Base Tab

Where to Find

Parameter Values/Range Units -
Description
Base Station Coordinates Area
* enabled
Phase Center L1 « disabled - page 3-40
AntennaReference | ¢ enabled _ ave 3-40
Point + disabled pag

Antenna type * antenna types list - page 3-41

e unknown
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Receiver Configuration

Table B-7. Connection Parameters Settings — Base Tab (Continued)

Parameter Values/Range Units Where FO Fmd
Description
90°00’00.000000” N
DD MM
0, ’ » -
Lat 0°00°00.000000 SS ss85S page 3-40
90°00°00.000000”S
180°00°00.000000”
E
DDD MM
0 ) ”» _
Lon 0°00°00.000000 SS ssssss page 3-40
180°00°00.000000™
w
-20000.000
Alt ..0.0... meters page 3-41
+20000.000
RTCM Settings Area
Station ID 0...1023 - page 3-41
Max. number of
Satellites 0-.. - page 3-41
* Good
Health * Bad - page 3-41
* Unknown
Pseudo-range * enabled
smoothing e disabled - page 3-41
Antenna Area
* not specified
Serial # eupto 3l a/n - page 3-41
characters
Setup ID 0..255 - page 3-41
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Settings List

Table B-7. Connection Parameters Settings — Base Tab (Continued)

Where to Find

Parameter Values/Range Units S
Description
Measurements Sent Area
* enabled
CA/L1 « disabled - page 3-42
* enabled
P/L1 « disabled - page 3-42
* enabled
P/L2 « disabled - page 3-42
System Used Area
e enabled
GPS + disabled - page 3-42
e enabled
GLONASS « disabled - page 3-42
CMR Settings Area
Station ID 0..31 - page 3-42
¢ Unknown
Motion * Static - page 3-42
¢ Kinematic
Measurements Sent Area
¢ enabled
CA/L1 « disabled - page 3-42
¢ enabled
P/L1 « disabled - page 3-42
¢ enabled
P/L2 « disabled - page 3-42
GLONASS 3..5..7 - page 3-42
message
* not specified
Short ID eupto 8a/n - page 3-42
characters
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Receiver Configuration

Table B-7. Connection Parameters Settings — Base Tab (Continued)

Parameter Values/Range Units Where FO Fmd
Description
* not specified
COGO eupto 16 a/n - page 3-42
characters
* not specified
Long ID e up to 50 a/n - page 3-42
characters

Table B-8. Connection Parameters Settings — Rover Tab

Parameter Values/Range Units Where FO Fmd
Description
Positioning Mode Area
¢ Standalone
* DGPS (Code
Positioning Mode Differential) - page 3-43
¢ RTK Float
¢ RTK Fixed
DGPS Parameters Area
. * enabled
Multi-base « disabled - page 3-43
Corrections usage Area
* enabled
Nearest « disabled - page 3-43
. * enabled
Mix « disabled - page 3-43
Corrections (only * enabled
if Mix enabled) |  disabled - page 3-43
Positions (only if ¢ enabled
Mix enabled) | * disabled - page 3-43
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Settings List

Table B-8. Connection Parameters Settings — Rover Tab (Continued)

Parameter Values/Range Units Where FO Fmd
Description
* enabled
Best « disabled - page 3-43
CD Corrections 1...30...1200 seconds page 3-44
max. age
fono Corrections 1...300...1800 seconds page 3-44
max. age
Use Iono * enabled ave 3-44
Corrections « disabled B bag
* Any
e Serial A
Source e Serial B - page 3-44
* Serial C
* Serial D
Enable Solutions Area
« Standalone
. * DGPS
Enable Solutions « RTK Float - page 3-44
¢ RTK Fixed
RTK Parameters Area
« Extrapolation
RTK mode  Delay - page 3-44
. « Static
Dynamics « Kinematic - page 3-44
.. . * Low
Ambiguity fixing | | Medium - page 3-44
level .
* High
Measurements Used Area
* enabled
CA/L1 « disabled - page 3-45
* enabled
P/L1 « disabled - page 3-45
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Receiver Configuration

Table B-8. Connection Parameters Settings — Rover Tab (Continued)

Parameter

Values/Range

Units

Where to Find

Description
* enabled
P/L2 « disabled - page 3-45
Base Corrections 0.05...1...100 seconds page 3-45
period
Use old ref. * enabled ace 3-45
coordinates e disabled - pag
* Any
e Serial A
Source e Serial B - page 3-45
e Serial C
e Serial D
CMR Settings Area
GLONASS 3..5..7 - page 3-45
message

Table B-9. Connection Parameters Settings — Ports Tab

Parameter

Values/Range

Units

Where to Find
Description

Serial Subtab

Serial A, Serial B, Serial C, Serial D

Input

* None

e Command
¢ Echo

* RTCM 2.x
* RTCM 3.x
* CMR

* TPS

e Omni

page 3-46
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Settings List

Table B-9. Connection Parameters Settings — Ports Tab (Continued)

Parameter

Values/Range

Units

Where to Find
Description

Output

* None

* DGPS RTCM
{1,31,3}

« DGPS RTCM
{9,34,3}

* RTK RTCM
{18,19,22,3}

e RTK RTCM
{20,21,22,3}

« RTK RTCM
{18,19,23,24}

e RTK RTCM
{20,21,23,24}

« RTK RTCM3 GD
min

¢ RTK RTCM3 GD
full

* RTK RTCM3 GGD
min

e RTK RTCM3 GGD
full

* RTK CMR {10,0,1}

e RTK CMR+
{10,0,9}

¢ RTK TPS min

e RTK TPS max

¢ User Defined

page 3-47

Period

1...86400

seconds

page 3-48

Baud rate

* 4800

* 9600

* 19200
* 38400
* 57600
* 115200
* 230400
* 460800

bps

page 3-48

RTS/CTS

e enabled
* disabled

page 3-48
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Receiver Configuration

Table B-9. Connection Parameters Settings — Ports Tab (Continued)

Parameter

Values/Range

Units

Where to Find
Description

Infrared

* enabled
* disabled

page 3-48

Parallel Subtab

Input

* None

e Command
* Echo

* RTCM 2.x
* RTCM 3.x
* CMR

* TPS

e Omni

page 3-46

Output

* None

* DGPS RTCM
{1,31,3}

« DGPS RTCM
{9,34,3}

e RTK RTCM
{18,19,22,3}

* RTK RTCM
{20,21,22,3}

« RTK RTCM
{18,19,23,24}

e RTK RTCM
{20,21,23,24}

* RTK RTCM3 GD
min

« RTK RTCM3 GD
full

e RTK RTCM3 GGD
min

* RTK RTCM3 GGD
full

* RTK CMR {10,0,1}

* RTK CMR+
{10,0,9}

¢ RTK TPS min

e RTK TPS max

¢ User Defined

page 3-47
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Settings List

Table B-9. Connection Parameters Settings — Ports Tab (Continued)

Where to Find

Parameter Values/Range Units .
Description

Period 1...86400 seconds page 3-48

Modem Subtab

* None

e Command
* Echo
Input . iigﬁ ii - page 3-46
* CMR

* TPS

e Omni

* None

¢ DGPS RTCM
{1,31,3}

¢ DGPS RTCM
{9,34,3}

« RTK RTCM
{18,19,22,3}

* RTK RTCM
{20,21,22,3}

e RTK RTCM
{18,19,23,24}

* RTK RTCM
{20,21,23,24}

Output * RTK RTCM3 GD - page 3-47
min

« RTK RTCM3 GD
full

* RTK RTCM3 GGD
min

* RTK RTCM3 GGD
full

* RTK CMR {10,0,1}

* RTK CMR+
{10,0,9}

¢ RTK TPS min

e RTK TPS max

e User Defined
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Receiver Configuration

Table B-9. Connection Parameters Settings — Ports Tab (Continued)

Parameter

Values/Range

Units

Where to Find
Description

Period

1...86400

seconds

page 3-48

Type

* Receiving
* Transmitting

page 3-50

Mode

 Off
* FHSS
* DSS

page 3-50

Antenna

e Int
* Ext

page 3-50

Power

* High
e Low

page 3-50

USB Subtab

Input

* None

e Command
* Echo

* RTCM 2.x
* RTCM 3.x
* CMR

* TPS

e Omni

page 3-46

Output

* None

e DGPS RTCM
{1,31,3}

« DGPS RTCM
{9,34,3}

* RTK RTCM
{18,19,22,3}

e RTK RTCM
{20,21,22,3}

e RTK RTCM
{18,19,23,24}

* RTK RTCM
{20,21,23,24}

e RTK RTCM3 GD
min

page 3-47
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Settings List

Table B-9. Connection Parameters Settings — Ports Tab (Continued)

Parameter Values/Range Units Where Fo Find
Description
* RTK RTCM3 GD
full
* RTK RTCM3 GGD
min
* RTK RTCM3 GGD
Output full
(continued) * RTK CMR {10,0,1}
* RTK CMR+
{10,0,9}
* RTK TPS min
* RTK TPS max
* User Defined
Period 1...86400 seconds page 3-48
Ethernet Subtab
IP Settings Area
0.0.0.0...
IP Address 192.168.2.2... - page 3-52
255.255.255.255
0.0.0.0...
IP Mask 255.255.255.192... - page 3-52
255.255.255.255
0.0.0.0...
Gateway 192.168.2.1... - page 3-52
255.255.255.255
Telnet Settings Area
TCP Port 1...8002...65535 - page 3-53
Timeout 1...600...2147483647 seconds page 3-53
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Receiver Configuration

Table B-9. Connection Parameters Settings — Ports Tab (Continued)

Parameter

Values/Range

Units

Where to Find
Description

Network
Password

e upto 15a/m
characters

e automatically
generated unique
value

page 3-53

FTP Settings Area

TCP Port

1...21...65535

page 3-53

Timeout

1...600...2147483647

seconds

page 3-53

TCP Subtab

TCP A, TCP B, TCP C, TCP D, TCPE

Input

* None

e Command
¢ Echo

¢ RTCM 2.x
* RTCM 3.x
* CMR

* TPS

e Omni

page 3-46

Output

* None

« DGPS RTCM
{1,31,3}

* DGPS RTCM
{9,34,3}

* RTK RTCM
{18,19,22,3}

* RTK RTCM
{20,21,22,3}

e RTK RTCM
{18,19,23,24}

* RTK RTCM
{20,21,23,24}

« RTK RTCM3 GD
min

* RTK RTCM3 GD
full

page 3-47
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Settings List

Table B-9. Connection Parameters Settings — Ports Tab (Continued)

Parameter

Values/Range

Units

Where to Find
Description

Output

(continued)

* RTK RTCM3 GGD
min

¢ RTK RTCM3 GGD
full

* RTK CMR {10,0,1}

* RTK CMR+
{10,0,9}

¢ RTK TPS min

¢ RTK TPS max

¢ User Defined

Period

1...86400

seconds

page 3-48

Table B-10. Connection Parameters Settings — Events Tab

Where to Find

Parameter Values/Range Units S
Description
Events Tab
PPS A Enabled and PPS B Enabled Areas
PPS A Enabled * enabled
or * disabled _ page 3-55
PPS B Enabled
. 10...1000 .
Period milliseconds page 3-55
...1000000000
-500000000... .
Offset milliseconds page 3-55
0...500000000
Offset -500000...0...500000 nanoseconds page 3-55
_ Periodof 0...20...1000000000 | milliseconds page 3-55
marked’ pulses
* Rise
Edge « Fall - page 3-55
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Receiver Configuration

Table B-10. Connection Parameters Settings — Events Tab (Continued)

Parameter Values/Range Units Where FO !:md
Description
* GPS
. * GLO
Ref. Time « UTCus - page 3-55
e UTCus
Tied with Ref. e enabled : ace 3-55
Time « disabled page 5
Event A Enabled and Event B Enabled Areas
Event A Enabled  enabled
or * disabled _ page 3-56
Event B Enabled
Clock e enabled _ ace 3-56
Synchronization * disabled pag
*on
Status o off - page 3-56
* Rise
Edge « Fall - page 3-56
* GPS
. * GLO
Ref. Time « UTCus - page 3-56
e UTCsu
Tied with Ref. * enabled 3 ace 3-56
Time * disabled pag
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Settings List

Table B-11. Connection Parameters Settings — Advanced Tab

Where to Find

Parameter Values/Range Units -
Description
Anti-Interference Subtab
» Off
* GPSLI1/12
. * GLONASS L1/L2
Anti-Interference | | GPS/GLONASS L1 - page 3-58
* GPS/GLONASS L2
* Auto
Multipath Reduction Subtab
Code multipath * enabled
reduction * disabled - page 3-59
Carrier multipath | ¢ enabled
reduction * disabled - page 3-59
Loop Management Subtab
PLL bandwidth 2..25..50 Hz page 3-60
2
PLL order o3 - page 3-60
Guided loop
bandwidth 0.1..0.5...10 Hz page 3-60
C/A code guided
loop bandwidth 0.1...0.8...50 Hz page 3-60
Enable Adaptive | ¢ enabled
Guided Loops | * disabled - page 3-60
Enable Co-Op Tracking Loop Area
Enable Co-Op * enabled 3 ace 3-61
Tracking Loop * disabled pag
. * enabled
Static Mode « disabled - page 3-61
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Receiver Configuration

Table B-11. Connection Parameters Settings — Advanced Tab (Continued)

Parameter

Values/Range

Units

Where to Find

Description
Bandwidth of
individual PLL 2..5..20 Hz page 3-61
Bandwidth of
common PLL. 2..25..50 Hz page 3-61
Enable Common | e enabled 3 ace 3-61
Loop for L2 ¢ disabled pag
External Frequency Subtab
Frequency Source Area
* Internal
Source « External - page 3-62
Ext. frequency 2..10..40 MHz page 3-62
value
* off
Ext. frequency . wait 3 page 3-62
source status
* locked
. e off
Ext. freq. signal « low _ page 3-63
amplitude
* ok
Oscillator Offset Reduction Area
* Off
Oscillator Offset * Freq. Locked 3 ace 3-63
Reduction * Freq. and Time pag
Locked
Raw Data Management Subtab
Raw Measurement Update Rate
Update Rate 10...100...5000 milliseconds page 3-64
Current Update any integer value -
Rate between 10 and 5000 milliseconds page 3-64
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Settings List

Table B-11. Connection Parameters Settings — Advanced Tab (Continued)

Parameter

Values/Range

Units

Where to Find

Description
Position Update Rate
Update Rate 10...100...5000 milliseconds page 3-64
Current Update any integer value -
Rate between 10 and 5000 milliseconds page 3-64
Code smoothing 0...300...900 seconds page 3-64
interval
Doppler
smoothing 0,1,2 - page 3-65
method
Nominal Iono
smoothing 0...60...900 seconds page 3-65
interval
Minimum Iono
smoothing 0...30...900 seconds page 3-65
interval
Options Subtab
. * On
Cinderella o Off - page 3-66
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Site Configuration

Site Configuration

Table B-12 provides a list of settings that are available in the Site
Configuration dialog box. The default value for a setting is shown in
italics (if applicable).

Table B-12. Site Configuration Settings

Parameter Values/Range Units Where FO Fmd
Description
Site Parameters Area
Site Name up to 20 a/n characters _ page 3-15,
page 3-67
* Fixed page 3-15,
Antenna Status « Moving - page 3-67
Antenna Parameters Area
Antenna Height 0.0...100.0 meters page 3-15,
page 3-67
* enabled page 3-15,
Slant ¢ disabled - page 3-67
list of antenna types page 3-15,
Antenna Type - page 3-67
Send parameters * enabled 3 page 3-15,
automatically * disabled page 3-67
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Settings List

Target Position

Table B-13 provides a list of settings that are available in the Target
position dialog box. The default value for a setting is shown in italics
(if applicable).

Table B-13. Target position Settings

Parameter Values/Range Units Where FO Find
Description
90°00°00.000000”N
DD MM
0, ’ »» =
Lat 0°00°00.000000 SS.ssssss page 3-68
90°00°00.000000”S
180°00°00.000000”E
DDD MM
0, 2 »” -
Lon 0°00°00.000000 SS ssssss page 3-68
180°00°00.000000”W
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RFM96 Configuration

Table B-14 provides a list of settings that are available in the RFM96
Configuration dialog box. The default value for a setting is shown in
italics (if applicable).

Table B-14. RFM96 Configuration Settings

RFM96 Configuration

Parameter

Values/Range

Units

Where to Find
Description

Connect Tab

Modem connected
to port

*B
C
D

page 3-69

Connect to
modem at bitrate

* Auto
* 38400
* 19200
* 9600
* 4800
* 2400

bps

page 3-70

Connection type

* Search for modem
* Power cycle

page 3-70

Configuration Tab

RF Channel

e list of enabled
channels
0

MHz

page 3-70

DTE-DCE Serial Interface Area

Baud rate

* 38400
* 19200
* 9600
* 4800
* 2400

bps

page 3-70

Parity

* None
* Even
e Odd

page 3-70

EOT

0...10..255

page 3-70
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Settings List

Table B-14. RFM96 Configuration Settings (Continued)

Where to Find

Parameter Values/Range Units .
Description
Radio Link Settings Area
. * 4800
Link rate « 9600 bps page 3-71
Retries 0...3..255 - page 3-71
» Off
FEC «On - page 3-71
. * Off
Scrambling «On - page 3-71
* High
. * Moderate
Digisquelch . Low - page 3-72
» Off
. * Off
CSMA monitor . On - page 3-72
DTE-DCE protocol mode Area
* Transp. w/EOT time
out
DTE-DCE e Transp. w/EOT
rotocol mode character - page 3-72
p * Packet
* Auto-repeater
* Fast async
BREAK to * enabled 3 ace 372
Command * disabled pag
Addresses Area
Local 0..254 - page 3-73
Destination 0..255 - page 3-73
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Plots Configuration

Plots Configuration

Table B-15 provides a list of settings that are available in the Plots
Configuration dialog box. The default value for a setting is shown in
italics (if applicable).

Table B-15. Plots Configuration Settings

Parameter

Values/Range

Units

Where to Find

Description
Point colors Area
Standalone color palette - page 3-94
Code differential color palette - page 3-94
RTK float color palette - page 3-94
RTK fixed color palette - page 3-94
Position Area
Time interval 1...360...99999999 seconds page 3-95
Max. deviation 0.0...99999999.0 meters page 3-95
. * enabled
Show grid « disabled - page 3-95
Time step 1...30...99999999 seconds page 3-95
L. 0.0001...0.5...
Deviation step 99999999 0 meters page 3-95
Scatter Area
. 0.0001...10.0...
Plot width 99999999 0 meters page 3-94
o 0.0001...1.0...
Tick interval 99999999 0 meters page 3-94
. * enabled
Show grid « disabled - page 3-94
. * enabled
Connect points « disabled - page 3-94
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Settings List

Table B-15. Plots Configuration Settings (Continued)

Where to Find

Parameter Values/Range Units .
Description
* enabled
Standalone « disabled - page 3-94
. . * enabled
Code differential « disabled - page 3-94
* enabled
RTK float « disabled - page 3-94
* enabled
RTK fixed « disabled - page 3-94
General Area
Values to keep 3600...2678400 - page 3-95

Converter to RINEX Setup

Table B-16 provides a list of settings that are available in the
Converter to RINEX Setup dialog box. The default value for a setting
is shown in italics (if applicable).

Table B-16. Converter to RINEX Setup Settings

Where to Find

Parameter Values/Range Units Description
Properties Area

Run by any a/n characters - page 3-22
Observer any a/n characters - page 3-22
Agency any a/n characters - page 3-22
Antenna # any a/n characters - page 3-23
Antenna type any a/n characters - page 3-23
Comment any a/n characters - page 3-23
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Converter to RINEX Setup

Table B-16. Converter to RINEX Setup Settings (Continued)

Parameter Values/Range Units Where Fo Fmd
Description
Marker name any a/n characters - page 3-23
Marker number any a/n characters - page 3-23
Converter Area
Application path to converter - page 3-23
* enabled
Exclude GPS « disabled - page 3-23
Exclude * enabled _ ace 3-23
GLONASS  disabled page >-
* enabled
Exclude L1 « disabled - page 3-23
* enabled
Exclude L2 « disabled - page 3-23
Delete source JPS | ¢ enabled
files after e disabled _ ace 3-23
successful pag
conversation
Additional list of switches
. - page 3-23
options
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Settings List

<Datum ID> Datum Parameters

Table B-17 provides a list of settings that are available in the <Datum
ID> Datum Parameters dialog box. The default value for a setting is
shown in italics (if applicable).

Table B-17. Datum Settings

Parameter

Values/Range

Units

Where to Find

Description
e datum IDs list
Current Datum . W84 - page 3-39
Reference Ellipsoid parameters Area
Ellipsoid ID two-letter IDs - page 3-39
6300000.0...
Semi-major axis 6378137.0000... meters page 3-39
6500000.0
280.0...
Inverse flattening 298.257223563... - page 3-39
310.0
Transformation parameters Area
* W84
Reference Datum | P90 - page 3-39
-10000.0...
Translation dX 0.0... meters page 3-39
+10000.0
-10000.0...
Translation dY 0.0... meters page 3-39
+10000.0
-10000.0...
Translation dZ 0.0... meters page 3-39
+10000.0
. seconds of
Rotation Rx -60.0...0.0...60 arc page 3-39
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<Datum ID> Datum Parameters

Table B-17. Datum Settings (Continued)

Parameter Values/Range Units Where Fo Fmd
Description
. seconds of
Rotation Ry -60.0...0.0...60 arc page 3-39
. seconds of
Rotation Rz -60.0...0.0...60 arc page 3-39
Scale -1000.0...0.0...1000 ppm page 3-40
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Notes:
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Appendix C

Installing and Updating
the TPS USB Driver

To connect a USB equipped TPS receiver with the computer’s USB
port, the USB port option must be enabled in the receiver and the TPS
USB driver must be installed on the computer.

Newer receivers, or receivers with the latest firmware, may require
the TPS USB driver to be updated. The TPS USB driver is available
on the TPS website. For details on downloading the driver, see
“Installing the TPS USB Driver” on page 1-11.

Installing the TPS USB Driver

The following sections describes first-time installation procedures for
the USB driver version 2.0.0.2 (build date November 24, 2003) or
newer on various operating systems.

If you have a previous version of the USB driver (as of 1.0.1.0,
October 25, 2002) installed, refer to your operating system’s section
in “Updating the TPS USB Driver” on page C-11.

Installing the USB Driver on
Windows 98 SE

1. Using the USB cable, connect the receiver and computer. Click
Next on the Add New Hardware Wizard dialog box.

2. Select Search for the best driver for your device. (Recommended).
and then click Next (Figure C-1 on page C-2).
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Installing and Updating the TPS USB Driver

Add New Hardware Wizard

This wizard searches for new drivers for

HIPER

& device fi that mak 3 3
s dorics o Pregam inat mases 2 & Search for the best driver for your device)
[Recommended].

‘wihat do you want Windows to do’?

& Search for the best driver for your device.
[Fiecommended).

€ Display a list of all the divers in 2 spacific
lacation, so you can select the diiver yau want,

<pack [ Nexl>§ Concel |

Figure C-1. Windows 98 SE — Add New Hardware Wizard and Select the Driver
Search Method

3. Inthe next dialog box, select Specify a location and click Browse.

4. Select the folder on the computer drive in which the driver resides
and click OK.

‘Add New Hardware Wizard

v Specify a location: windows will search for new diivers in its diiver datahase
- on your hard diive, and in any of the following selected
B

lacations. Click Next to start the search
- I
I Floppy disk diives

™ CO-ROM dive

m_ f ] Edale

¥ Specify ajocation:
=

Browse for Folder

L

Select the folder that contains driver information [INF
this device.

{1 Loader B
00 Md

L] Mew <Back New> |
&1 Modem-TPS

(2] Msdownld tmp

B2 My Documents

{1 Medhres

] Miest

&1 Pradds

=] Poedu

{71 Tps_usb
i 320

Concel |

. Prare - =

Figure C-2. Windows 98 SE — Locate Driver Files
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Installing the TPS USB Driver

5. Make sure you have selected the correct driver location and then
click Next.

Add New Hardware Wizard

“wfindows will search for new drivers in its driver database

an your hard dive, and in ary of the following selected
Iocations. Click Nest to start the search Check for

I Floppy disk drives correct driver
™ CD-ROM diive location

™ Miciosoft Windows Update
V' Specify a location:
|E “PCCOUNTPS_USE_20 -
Browse...
<Back [ Hieas E Concel |
Figure C-3. Windows 98 SE — Driver Location Specified

6. Make sure that TPSUSBI10O. INF has been detected and then
click Next.

Add New Hardware Wizard

“Windows diiver file search for the device:

Location of driver:

Euwra-112 GGD Receiver [USEID Device: YID=0C36
FID=0028)

CAPCCOUSTRS_US~1NTPSUSEID.INF

Windows is now ready t install the best diiver for this
device. Click Back to select a different driver, or click Nest
to continue,

Location of diiver:
CAPCCOUATPS_US™14TPSUSBIO INF

< Back

Cancel

Figure C-4. Windows 98 SE — Ready to Install Driver

7. When driver installation completes, click Finish.

Add New Hardware Wizard

Euro-112 GED Receiver (USBI0 Devies:
S%=F  VID-CE FID-0028)

Windows has finished installing the softwars that your new
hardware deviee requires.

CBAR Cancel |

Figure C-5. Windows 98 SE — USB Driver Installation Complete
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Installing the USB Driver on
Windows ME

1. Use the USB cable to connect the receiver and the computer. The
Add New Hardware Wizard dialog box displays. Select Specify
the location of the driver (Advanced) and click Next.

Add New Hardware Wizard

‘Windows has found the following nesw hardware:

EGEDT I & Specify the location of the driver [Advanu:edEI

Windows can automaticall search far and install software

that supports your hardwars. [f your hardwars came with

installaion media, inset it now and click Nest.

‘What would you like ta do?

© futomatic search for a better diver [HecummM

I(-‘ B paciy he location of the driver [Advancedil
1

cpeck [ News | Cancel |

Figure C-6. Windows ME — Select the Driver Search Method

2. Select Search for the best driver for your device. (Recommended).
and Specify a location. Click Browse and select the folder on the
computer drive in which the driver resides. Click Next.

Add New Hardware Wizard

‘Windows will search for new drivers in its driver database
on your hard diive. and in any of the: following selected

' Search for the best diiver for your device
[Fiecommended).

I~ Removable Media (Flappy, CO-ROM..)
[¥ Specity alocation

G:hmstal\TPSWISBYZ 20+ Browse

" Display a list of all the divers in & specific lacation, 50
vau can select the diver you want.

<Beck  [[Wests ||  Cancel |

Figure C-7. Windows ME — Locate Driver Files
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Installing the TPS USB Driver

3. Make sure you have selected the correct driver location and then
click Next.

Add New Hardware Wizard

“wfindows driver file search for the device:

Check for
Euro-160 Turbo GGD Receiver [USBIO Device: i
ID=0C35 PID=0050) correct driver
location
“wiindowes is now ready to install the best driver far this
dewice. Click Back to select a different driver, or click Next
b contine.

Location of driver

= GAMSTALLATPSAUSENZ_20_0_TWTPSUSE

<Back [[Wews | cancel |

Figure C-8. Windows ME — Ready to Install Driver

4. When driver installation completes, click Finish.

Add New Hardware Wizard

Eura-160 Turba GGD Recaiver [USBID Device:
WID=0C36 FID=0050)

Windows has finished instaling the new hardware device,

cBeck [CoFmeh | | Cancell |

Figure C-9. Windows ME — USB Driver Installation Complete
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Installing the USB Driver on
Windows 2000

1. Use the USB cable to connect the receiver and the computer. The
Found New Hardware Wizard dialog box displays. Click Next.

2. On the next dialog box, select Search for a suitable driver for
my device (recommended) and then click Next.

Found New Hardware Wizard

‘Welcome to the Found New Hardware
Wizard

Thizwizard halps you install & device diver ioe o hardeses

Found New Hardware Wizard

Install Hardware Device Drivers
A denvi

satware program thet enablies a handwere dendce 1o work with an

@ ODYSSEY_E - - -
If: Search for a suitable driver for my device [recommended)
A dirvice dib. s

- - T T T
cenvar fles fo yaur Hos 1
‘Wh ey yoes wean the wizard to do?

1
Foee |

" Display =0 Tt |

<Bnck Mt [ concel |

Figure C-10. Windows 2000 — Found New Hardware Wizard and Install Hardware
Device Drivers
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Installing the TPS USB Driver

3. Select Specify a location and click Next, then click Browse.

Locate Drver Files
Whare do you want Windows to search for drver Slas?

h bor for B followang hiardwars dinac:

¥

Specify a location

el ODYSSEY.E

The wizard searches for suitnble dvers in its driver database on your computer and in amy of

9 op! yOu Specily.

To start the search, chck Nmd. Byou am searching on a lopgy disk or COSROM dma, nsd the
flappry disk or CO bodore clicking hlaue

Optional search locations:
I” Floppy disk drives

Found New Hardwnre Wizard

o P i T i =
J selected, and then click OF. I

™ Mecrosoft Windows Updote
Copry manutachrer's es nom:
= = | amm

Figure C-11. Windows 2000 — Locate Driver Files and Click Browse
4. Select the folder on the computer drive in which the driver resides
and click Open.

5. Make sure you have selected the correct driver location and click
OK.

3 TPEUSEX »] «@cyOr
Hama |
| TRSUSBIO IF

31 :mu;d.wnwnuickék ekl e
|

Copry manutachrer's es nom:
[ciTopcantTrsUSB20 k =] | Browse
R fresusecmne =l Open [ \ Check for
Fesage | o =] correct driver
location

Figure C-12. Windows 2000 — Browse for Folder and Driver Location Specified

6. Make sure that TPSUSBIO. INF has been detected and click
Next.

P/N 31-000004-01 c-7



Installing and Updating the TPS USB Driver

7. When driver installation completes, click Finish.

Found How Hardware Wizard

Driver Files Search Results
The wzeed hiers hrushed searchg lor dinver hles for yaur herdware device j

divarfor

@. OOVSSEY_E .
|

Wintdows Sound a diver for this devce. To install the drver Windows found. chick Meod
leting the Found New Hardware

d
= chapcanipsushpaushio il
peotiip e Eurce1 60 GG0 Flecener (USBI0 Device VD=0
FID=00TE)
s finishiedd ingtalling the saftware for this device

<Back Nest > [ Cancal

To dose this wizerd chek Finish.

[ Fongy | |

Figure C-13. Windows 2000 — Ready to Install Driver and USB Driver Installation
Complete

Installing the USB Driver on
Windows XP

1. Use the USB cable to connect the receiver and the computer. The
Found New Hardware Wizard dialog box displays. Select No,
not this time and click Next.

2. Select Install from a list or specific location (Advanced) and click
Next (Figure C-14 on page C-9).
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Installing the TPS USB Driver

Found New Hardware Wizard

‘Welcome to the Found New
Hardware Wizard

Windows will search far cunent and updated saftware by
laoking an paur computar, on the -
[ el Found New Hardware Wizard

Fiead ow privacy policy

CanWindows connect to Windo

7 -
softiars’ This wizard helps you install software for.

HIFER

(O Yes, this time only
(O s, now and every time |
(3) No, net this time

() 1f your hardwate came with an installation CD
2 or flappy disk. insert it now.

Click Mext to continue.
“w/hat do pou want the wizard to do?

() Install the software automatically [Aecommended)
@instalfrom 3 st o speciic Incation (Advanced

Click Mext to continue.

[ <Back J[ Hews [ [ Cancel |

Figure C-14. Windows XP — Found New Hardware Wizard and Select Installation
Method

3. Select Search for the best driver in these locations. and Include
this location in the search. Click Browse.

4. Select the folder from which to install the driver and click OK.

Found New Hardware Wizard

Please choose your search and installation options.
Browse For Folder

Select the Folder that contains drivers For your hardwars.

() Search for the hest driver in thess locations.

Use the check bowes below to limit or expand the default search, which includes local

paths and removable media. The best diver found wil be installzd o TEQC e
12 tmp
[ Search remavable media [floppy, CD-ROM...) ® [3) TopconToolsAntennaFilsEditor
Includs this lncation in the search: =] TPSLSEZ0
— () Trash tool
H: 4 M ® (&) YALD_SHARED_DIR.
Dvaz
(2 Dot search, | will chooss the diiver to install ) VIDED FOLDER
Chaose this option to select the device diiver from 3 list. Windows does not quarantes i () WFTW RealAudio TemporaryFolderonl
the driver you choose will be the best match for your hardware. (5 WFTWPrajectiain v
< >

Ta view any subfalders, click a plus sign above,

[ < Back ][ Nest > ][ Cancel

Figure C-15. Windows XP — Select Search Options and Navigate to Driver
Location
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Installing and Updating the TPS USB Driver

5. Make sure you have selected the correct driver location and then
click Next.

6. Click Continue Anyway.

Found New Har dware Wizard Check for
Please choose your search and installation options. correct driver
location

() Search for the best driver in these locations.

Use the check boxes below to limit or expand the default search, which inclyge
paths and removable media. The best diiver found will be installed

[[] 5earch removable media (Aoppy, CO-ROM.. ]
Include this location in the search:

DATPSUSBZ0 - Biriow:

3 Don't search. | will choose the driver to install

1 } The software you are installing for this hardware:
.
Euwrn-112 GGD Receiver [USBID Device: YID=0C36 PID=0028]

Choose this option ta select the device diver from a list, Windaws does not
the diver you chooss will bs the best match for your hardware

has not passed Windows Loga testing to veriy its compatibilty
with windows 5P (Tel me why this testing is important.

Continuing your installation of this software may impair
or destabilize the comrect aperation of your system
cither immediately or in the future. Microsoft strongly
{ e e A e e o
cantact the hardware vendor for software that has
passed Windows Logo testing.

[-Continue frpway | [ STOP Instalation |

Figure C-16. Windows XP — Driver Location Specified and Continue Installation

7. Wait while the driver installation completes.

8. When driver installation completes, click Finish.

Found New Hardware Wizard

Please wait while the wizard installs the software...

% Euro-112 GGD Receiver (USBI0 Device: ¥ID| T —

Completing the Found New
Hardware Wizard
_J The wizard has finished installing the software for:

Setting  system restors point and backin
case pour spstem needs to be restored in

g

Eura-112 GGD Receiver (USBIO Device: VID=0C38
= FiD-002e)

Click Finish to close the wizard.

Figure C-17. Windows XP — Driver Is Being Installed and USB Driver Installation
Complete
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Updating the TPS USB Driver

Updating the TPS USB Driver

To properly use PC-CDU version 2.1.13 or later using a USB
connection with the receiver, update the TPS USB driver to version
2.0.0.2 or newer.

Updating the USB Driver on
Windows 98 SE

1. Use the USB cable to connect the receiver computer. Right-click
the My Computer icon on the desktop. Click Properties and
then Device Manager.

2. On the Device Manager dialog box, double-click Universal
Serial Bus controllers, right-click your receiver, and then click
Properties.

3. On the Receiver Properties dialog box, click the Driver tab and
then click Update Driver.

System Properties
General Device Manager | Hardware Profies | Performance |

& View devices by wpe ™ View devices by connection

-2y Hard disk controllers B
&2 Keyboard TPS Euro-112 GGD Receiver Properties HE

Moritors
Mouse General Diver |
o Moxa Smartio/ndustio multipart board
BB Network adapters o TP Euot1266D fscaiver
Ports [COM & LPT]
Sound, viden and game cortilers Provider o
@ System devices Date: 10252002
S-S Uiiversal Serial Bus controllers

Intel(R] 82801BA/BAM USB Urniversal Host Contraller - 24
Imtel(R] 82801 BA/BAI Universal Host Controlles - 24
TPS Euro-112 GRD

To view details about the: drives files lnaded for this device, click
Driver File Details. To update the driver files for this device, click.

LUSB Rost Hub Refrash Updste Drver
LISB Rost Hub — —
4] Print ¥
Propetties Fehesh | MPI@ |

Driver File Details..
0K Cancel

Figure C-18. Windows 98 SE — Device Manager and Click Update Driver
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Installing and Updating the TPS USB Driver

4. Click Next on the Upgrade Device Driver Wizard dialog box.

5. Select Display a list of the known drivers for this device so that I
can choose a specific driver and click Next.

Update Device Driver Wizard ‘

This wizard searches for updated drivers for:

&+ Display a list af all the dnvers in a specific

TPS Euro-112 GED Receiver f : i ]
{ocation, =0 you can select the driver you want

A device diver is a softwars program that mebas = |
hardware device work Update Device Driver Wizard

Uparading to & newer wersion of & device what da pou want Wwindaws to do?
imprave the performance of your hardware

functionality. € Search for a better driver than the one yaur

devics is using now. [Recommended]

& Display a list of all the: drivers in a specific i
Iocation, 30 you can select the driver you want}

<Bak [ News [ Cancd |

Figure C-19. Windows 98 SE — Driver Upgrade Wizard Welcome and Update
Hardware Device Drivers

6. On the next dialog box, choose the desired receiver and click
Have Disk.

7. On the Open dialog box appears, select the driver and folder from
which to install the driver (TPSUSBIO . INF) and click OK.

Update Device Driver Wizard

Select the manufacturer and model of your hardware device, If you have @
55 ik thal contains the updated driver, click Have Disk. To intall the Updated
diiver, click Finish

Mogdels:

& Show compatitle hardware T ave Dk
£ Show all hardware — 3

< Back | Next > | Canc  File pame: Folders:
[tpsustio int cA\PCCOUNTPS_USB_20

T

£3 pocdu
3 tps_ush_20

Cancel
Mgtwork..

J |

Drives

= o local disk >

Figure C-20. Windows 98 SE — Select a Device Driver and Browse for the Driver
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Updating the TPS USB Driver

8. Click OK on the Install From Disk dialog box.

9. On the next dialog box, select your receiver model and click
Next.

Install From Disk [<]

Insert the manufacturer's installation disk into
the drive selected, and then click OK.

Update Device Driver Wizard

Cancel

Select the manufacturer and model of your hardware device. If you have &
g%“ disk that contains the updated driver, click Have Disk. Toinstall the updated
driver, click Finish.

Copy manufacturer's fles from:

cAPCCDUNTPS_USE_20 | Browse.

IC36 PID=0028)

' Show compatible hardware:
" Show all hardware.

<Back Concel |

Figure C-21. Windows 98 SE — Install From Disk and Select Receiver Model

10. On the Ready to install dialog box, click Next to begin
installation process.

11. When the USB driver update completes, click Finish to close the
installation wizard.

Update Device Driver Wizard
Euro-112 GGD Receiver (USBIO0 Device:
%“ WID=0C36 FID=0028)

Windaws has finished instaling the diiver you selected for
your hardware device

0 FwshE‘ Concel |

Figure C-22. Windows 98 SE — USB Driver Update Complete
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Updating the USB Driver on
Windows ME

Use the USB cable to connect the receiver and computer.

2. Right-click the My Computer icon on the desktop. Click
Properties then Device Manager.

3. On the Device Manager dialog box, double-click Universal
Serial Bus controllers, right-click your receiver, and then click
Properties.

4. On the Receiver Properties dialog box, click the Driver tab and
click Update Driver.

[orion Posciies 21
| General Davice Manager | Hardware Profies | Perfamance
|
|
| & Viewdevicesbytyps (" Visw dvices by connaction
2 System devices By Euio-160 Turbo GED Receiver (USE! 2l
5 6% Uriversal Serial Bus contiollers
#isustek USB Enhanced Host Contoller General Diver |

Ewo-112 GGD Receiver (U$BI0 Device: YID=0C36 FID=

Euro-160 Tubo GGD eiver [ISEIL OCK Eura-160 Turba GGD Recaiver [USBID Device:
WID=0C36 FID=0050)

Gereral puipos. Riefresh

Inteli) 52807E¢ Figmave ol Host Controller 1

Driver Provider. TP

el 28018 g al Host Contioller 2 "
NEC s Dpo] IIAT Dive Dot 01/24/2005
NeE UsE Ope T Digital Signer. Mot signed
TFS Euo160 G&D Fecever
ISE Roal Hub To view detais shout the criver Fes Inaded for this device, click

 view detais shout the: civer fiss Inared for this device, clic

USE Root Hub Diiver File Detalk. Ta update the diver les far this device, click
USE Root Hub Update Driver
USE Root Hub -

4| | »

Fopeties | Refsh | Remove | Pint.

Cane:
OK Cancel

Figure C-23. Windows ME — Device Manager and Update Driver

5. Select Specify the location of the driver (Advanced) and click
Next (Figure C-24 on page C-15).

6. Select Search for a better driver than the one your device is using
now. (Recommended) and Specify a location. Click Browse and

select the folder on the computer drive in which the driver resides.
Click Next (Figure C-24 on page C-15).
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Updating the TPS USB Driver

Update Device Driver Wizard

This wizard searches for updated diivers for

Euro-160 Turbo GGD Receiver (USBIO Device:
WID=0C3E PID=0050]

“wiindows can search for and install an undsted driver b

(L= EEEELERNE LRI I Update Device Driver Wizard

you can specify the location of anather

“Windows will now search for updated drivers in its driver

“wihat would you like to do? database and in any of the following locations,

™ Automatic search for a better driver % Search for & better driver than the one pour device is

using now. (Recommended)

[~ Removable Media [Floppy. CO-ROM...]

[V Specify a location
IE'\Ir\slaH\TF‘S\USE\VjZj

" Display a list of all the divers in & specific lacation, 50
vau can select the diver you want.

<Beck | New> | Cancel |

Figure C-24. Windows ME — Select Driver Search Method and Locate Driver Files

7.

P/N 31-000004-01

Make sure you have selected the correct driver location and then
click Next.

When the USB driver update completes, click Finish to close the
installation wizard.

Update Device Driver Wizard Check f(? r
Windows diver fie search far the device correct d river
location

Eura-160 Turba GGD Recaiver [USBID Device:
WID=0C36 FID=0050)

Windows is now ready to install the best,
device. Click Back to select a diffen
to continue.

e for this

Update Device Driver Wizard

Location of driver.
Eura-160 Turba GGD Recaiver [USBID Device:

- ID=0C55 PID=0050)
GAINSTALLATPSAUSBAY_2200-1
= -

“Windows has finished instaling an updated driver for your
hardware device

cBeck [CoFmeh | | Cancell |

Figure C-25. Windows ME — Ready to Install Driver and USB Driver Update
Complete
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Installing and Updating the TPS USB Driver

Updating the USB Driver on

Windows 2000

1. Use the USB cable to connect the receiver and the computer. On
the Device Manager dialog box, double-click Universal Serial
Bus controllers, right-click your receiver, and click Properties.

2. On the Receiver Properties dialog box, select the Driver tab and

then click Update Driver.

Display adapters

%) DVD/CD-ROM drives
2 Floppy disk controllsrs
= Floppy disk drives
2 IDE ATA/ATAP] controllers
3 Keyboards
T Mice and other pointing devices
@ Moritars
BB Network adapters
5 Poits [COM & LPT)
ound, viden and game cantiollers
yatem devices
% Universal Serial Bus controllers
Generic USB Hub
Intel(R) 828071BA/BAM USB Uriversal Host Controller - 2442
Intel[R) 828071 BA/BAM USB Uriversal Host Controller - 2444

TPS Euro-112 GGD VEr
USB Root Hub Disable:
USB Root Hub Uninstall

Scan for haidware changes

Properties

—

| S

|
B, Device Manager _[O[x]
Computer
3 Disk drives

TPS Euro-112 GGD Receiver Properties

General Diiver |

“@ g, TPS Euro-112 GED Receiver

Driver Prowider: ~ TPS

Driver Date: Not available
Driver Wersion: 1010
Digital Signer: Mot digitally signed

To view details about the: driver files loaded for this device, click Driver
Details. T uninstall the driver files for this device, click Uninstall To update
the driver files for this device, click Update Driver.

| Update Driver ﬂ
oK Cancel

Driver Detalls... Uninstall

Figure C-26. Windows 2000 — Select Receiver and Update Driver

3. On the Upgrade Device Driver Wizard dialog box, click Next.

Select Display a list of the known drivers for this device so that I
can choose a specific driver and click Next (Figure C-27 on

page C-17).
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Updating the TPS USB Driver

Upgrade Device Diiver Wizard

Install Hardware Device Drivers
& device diiver is & softwars program that enables a hardware device ta work with

an operating spstem.

This wizard upgrades diivers for the following hardware device:
2 TFS Ewo112 GGD Receiver

Upgrading to & newer version of & device diiver may add functionality to or improve the
perfomance of this device.

“wihat do pou want the wizard to do?

£ Search for a suitabls diiver for my devics [iscommendsd)

I & Display a list of the knawn divers for this devics so that | can chaoss & spa:mcl
diver

¥ Dizplay a list of the known drivers for this device so that | can choose a specific
drivl?ar § |:| Nest > Cancel

Figure C-27. Windows 2000 — Install Hardware Device Drivers

5. On the Select a Device Driver dialog box, choose the desired
receiver and click the Have Disk button.

Upgrade Device Diiver Wizard

Select a Device Driver "
“wihich drivar do you want to install for this device?

Select the manufacturer and model of your hardware device and then click Nest. IF you
g%“ have a disk that contains the driver pou want ta install. click Have Disk.

odets:
Euro-112 GGD Receiver [USEID Device: YID=0C36 PID=0028]
TPS Ewrc-112 GGD Receiver

' Show compatible hardware Have Disk.. R

" Show all hardware of this device class

<Back | New> | Cancel |

Figure C-28. Windows 2000 — Select a Device Driver

6. The Install From Disk dialog box appears. Click the Browse
button and select the folder from which to install the driver

(TPSUSBIO. INF).

Install From Disk

Insert the manufacturer's installation disk into the diive oK
selected, and then click OK.
Cancel

Copy manufacturer's files from:

Jer =] | Browse.. R

Figure C-29. Windows 2000 — Install From Disk->Browse
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Installing and Updating the TPS USB Driver

7. After locating the driver, click Open. Click OK on the Install
From Disk dialog box.

Install From Disk

Insert the manufacturer's installation disk into the dive
selected, and then click OK.
Cancel

Copy manufacturer's files from:

| B RN =] Browss

Figure C-30. Windows 2000 — Install From Disk->OK

8. On the next dialog box, select your receiver model and click
Next.

Upgrade Device Diiver Wizard

Select a Device Driver N
“wihich drivar do you want to install for this device?

Select the manufacturer and model of your hardware device and then click Nest. IF you
g%“ have a disk that contains the driver pou want ta install. click Have Disk.

odets:
Euwra-112 GGD Receiver [USEID Device: YID=0C36 PID=0028]
Euwro-160 GGD Receiver [USBID Device: WID=0C36 PID=001E]
HiPer Lite+ GGD Receiver (USBI0 Davice: ¥ID=0C36 PID=0029)

Have Disk.

<Back [ Hews [ Concel |

Figure C-31. Windows 2000 — Select the receiver model->click Next

9. On the Start Device Driver Installation dialog box, click Next to
begin installation process.

10. When the USB driver update completes, click Finish to close the
update wizard.
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Updating the USB Driver on
Windows XP

1. Right-click My Computer on your desktop and click Properties.

2. On the System Properties dialog box, click Hardware then click
Device Manager.

System Properties.

System Restars Autornatic Updates Flemots

General Computer Nams Hardware Advanced

Device Manager
% The Device Manager lists all the hardware devices installed

on your computer. Use the Dievice Manager to change the
propetties of any device:

Open
Explore Device Manager |

Search...

Manage Drivers

Map Hetwork Drive. . il Diver Sigring e you make sure tha iialed divers are
Biscorrstt Hetwork Drive £ compaible with Wwindows. windows Updats lets you set up

how Windows connects to ‘Windows Update for drivers.

Create Shorkcuk [

Delete Diiver Sigring ] [ windows Updte

Renarme
Hardware Profiles

Hardware profiles provide a way for you ta set up and stare:
different hardware configurations.

Hardware Profiles

Figure C-32. Windows XP — Open Properties and Device Manager

3. Double-click Universal Serial Bus controllers, right-click your
receiver, then click Update Driver.

File Action Views Help
S 2

+ @ Monitars

+ E@ Metwork adapters

# M Ports (COM & LPT)

+ #8% Processors

+ € SCS1 and RAID controllers

+ @, Sound, video and game controllers
+| “e# Storage volumes
=

System devices
2 Universal Serial Bus controllers
£2801FB{FEM USE Universal Host Controller - 2658 m
52801FE/FEM USE Universal Host Controller - 2659 Disablz
52801FE/FEM USE Universal Host Contraller - 2654 Uninstal
52801FE/FEM USE Universal Host Controller - 2658

3

Intel(R;
Intel(R;
Intel(R;
Intel(R;
Intel(R} 52801FE/FEM USEZ Enhanced Host Contraller - 265C | 5can for hardware changes
USE Mass Storage Device
USE Roat Hub

Properties

U3SB Root Hub
U3SB Root Hub
U3SB Root Hub
U3SB Root Hub

|

Launches the Hardware Update Wizard For the selected device.

Figure C-33. Windows XP — Update Driver
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Installing and Updating the TPS USB Driver

4. Select No, not this time and click Next.

Hardware Update Wizard

‘Welcome to the Hardware Update
Wizard

\wiindawss will ssarch for cunent and updated software by
lagking on your computer, on the hardware installation C0., ar on
the Windows Update Web site (with your permissian],

Fiead ow privacy policy

CanWindows connect to Windows Update to search for
software?

(O Yes, this time only
(O ves, now and every time | connect a device
(3) No, net this time

Click Mext to continue.

e )

Figure C-34. Windows XP — Hardware Update Wizard

5. Select Install from a list or specific location (Advanced). Click
Next.

6. Select Don’t search. I will choose the driver to install. Click
Next.

Hardware Update Wizand

This wizard helps you install software for:

Ewo-112 GGD Receiver (USEID Device: WID=0C36
PID=0028]

(*) 1t your hardwars cams with an installation CD
> or floppy disk. insert it now.

[IGEE sy Hardware Update Wizard

) Install the software 2] Please choose your search and installation options. S
@ Install from a lst or 3p

Click Next to continue. (7 Search for the best diiver in thess locations.

Use the check boves below ta limit or expand the default search, which inchides local
< Bac paths and remavable media. The best diiver found wil be installsd

(5 Dot search. | will choose the diiver to instal

Chonse this option to select the devie driver from a list. windows does not quarantee that
the diiver you choose will be the best match for your hardware.

[ <Back || Mew>p] [ cancel |

Figure C-35. Windows XP — Select Install Method and Select Driver Search
Method
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Updating the TPS USB Driver

7. Choose the desired receiver and click Have Disk.

Hardware Update Wizard
Select the device driver you want to install for this hardware. .

Select the manufacturer and model of your hardware device and then click Nest. IFyou
g%“ have a disk that contains the diiver you want to install, click Have Disk.

Show compatible hardware

Model
Ewg-112 GGD

/& This driver is not digitally signed! Have Disk. N

Tell e vahy driver siqring is impartant

[ <Back ][ Mew> | [ Cancel |

Figure C-36. Windows XP — Select the Receiver

8. Click Browse on the Install From Disk dialog box appears.
Select the folder from which to install the driver
(TPSUSBIO. INF).

9. Browse for and select the driver. Click Open.

Locate File

Look in: | 5 TPSU3820

Install From Disk

Insert the manufacturer's installation disk, and then
5 make sure that the correct diive is selected below,

Copy manufacturer's fles from

= v| [ Biowse..

File name: | TPsUsEI.NF v e

y s |[Fieseryes

Figure C-37. Windows XP — Install From Disk and Select USB Driver

10. Make sure the driver is selected and click OK.
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Installing and Updating the TPS USB Driver

11. Choose the desired receiver and click Next.

Install From Disk

Insert the manufacturer's installation disk, and then
¥R, make sure that the correct drive is selecied below. [y

ice driver you want to install for this hardware.

manufacturer and model of your hardware device and then click Next. If you
k that contains the: driver you want to install, click Have Disk.

Copy manufacturer's files from:

DATPSUSE2N v

Show compatible hardware
Model

A\ This driver is not digitally signed!

Tell me why driver signing is important

[ <Back ] Next)kl[ Cancel |

Figure C-38. Windows XP — Install From Disk and Select Receiver

12. Click Continue Anyway.

13. When the USB driver update completes, click Finish to close the
update wizard.

Hardware Installation

The software you are instaling for this hardware: Completing the Hardware Update

Euwrn-112 GGD Receiver (USBIO Device: ¥ID=0CS6 PID=0023) Wizard

has not passed Windows Logo testing to verify its compatibiliy The wizard has finished instaling the software for

with Ywindawes 3P [T el me why this testing is impartant ]

Continuing your installation of this software may impair
or destabilize the correct operation of your system
cither immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
cantact the hardware vendor for software that has
passed Windows Logo testing.

Ewo-112 GGD Receiver (USEID Device: WID=0C36
PID=0028]

Continue Anyway% [ STOF Installation

Click, Finish ta close the wizard,

Figure C-39. Windows XP — Continue Driver Installation and USB Driver Update
Complete
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Appendix D

Output Period Setup
Wizard

The Output Period Setup Wizard is a feature that helps you select and
set the correct values for generating raw data and updating the
receiver position.

PC-CDU will open this Wizard when specifying an incorrect
recording interval for the connected receiver. Once the Wizard starts,
follow the on-screen instructions to adjust the recording interval.

The following five figures, which are given here just for your
convenience, show how the Output Period Setup Wizard windows
look. These windows are listed in order of appearance.

1. Once the Output Period Setup Wizard starts, read the warning.
Click Cancel or click Next.

If clicking Next, continue below.

[ Dutput Period Setup Wizard B
Warning | The requested value of Output Period (Recording Interval) is
not supported by your receiver due to the limitations imposed by the
receiver's cunent settings.
Press "Cancel" 1o farce Output Period to be the requested value
anyway
Press "Newt” f pou want to adjust the requested value of Output Period
0 that it becomes consistent with the receiver's cunent settings.
Cancel L Henisy \ j

Figure D-1. Begin Output Period Setup
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Qutput Period Setup Wizard

2. Follow the on-screen instructions for selecting an appropriate
Output Period. Click Next.

Click Refresh to view the receiver’s current settings.

[# Dutput Period Setup Wizard ]

The requested valus of Dutput Period [Recording Interval) must bs
divisible by the: minimum Flaw Diata Update interval speciied by the
given receiver options,

Select an appropriate Output Period fiam the list of the pemitted walues

Press "pply” to maks the rsciver sccept the newly selected valuss

Press “Rafiesh’ to view the receiver's cument settings

Requested valus of Output Period 233 )

Parmitted values of Dutput Period : 230 -]

Cancel << Back Hext 35
I

Figure D-2. Select Output Period

3. Follow the on-screen instructions for selecting an appropriate
Raw Data Update. Click Next.

Click Refresh to view the receiver’s current settings.

[ Dutput Period Setup Wizard B

The euent Fiaw Data Update Interval must be a divisor of the
requested Output Period [Recording Interval).

Select an appropriate Fiaw Data Update Interval from the fist of the
pemilted valuss.

Warning | Care should be exercised when changing the Rlaw Data
Update Interval since this operation can adversely affect the oiher data
oulpul stieams that have been activated with different data 140 intervals.

Fiequested Output Period : 2.30 (5]
Current Raw Data Update Interval 010 (s)
Permitted Raw Data Update Intervals 010 hal G0}

Refresh Apply

Canel << Back
I

Figure D-3. Select Raw Data Update
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4. Follow the on-screen instructions for selecting an appropriate
Positioning Data Update. Click Next.

Click Refresh to view the receiver’s current settings.

[# Dutput Period Setup Wizard ]

The curent Pasitioning Data Update Interval must be a divisor of the
requested Output Period (Recording Interval).

Select an appropriate Positioning Data Update Intsrval from the list of
pemited values.

\wiarning ! Care should bs exercised when changing the Positioning Data
Update Interval since this operation can adversely affect the oiher data
output stieams that have besn activated with different dats 140 intervals

Requested Dutput Period - 230 sl
Current Positioning Data Update Interval -~ [0.10 )
Parmitted Positioning Data Update Intervals : [0.10 -]

Refiesh Epply

Figure D-4. Select Positioning Data Update
5. Click Finish.

[ Dutput Period Setup Wizard B

Bringing the receiver's selings into conespondence with the requested
Output Period (Recording Interval] is over.

Fiess "Finish' ta close the Recording Interval S etup Wizard and enable
the updated Dutput Period.

Cancel << Back
I

Figure D-5. Output Period Setup Complete

P/N 31-000004-01 D-3



Qutput Period Setup Wizard

Notes:

D-4 PC-CDU Reference Manual



Appendix E

Satellite Navigation
Status Godes

Table E-1 lists the codes seen in the SS column on the Main window
in the PC-CDU software.

Table E-1. Satellite Navigation Status Structure

Code Description

00 C/A data used for position computation

01 P1 data used for position computation

02 P2 data used for position computation

03 Ionosphere-free combination used for position computation

04 Measurements unavailable

05 Ephemeris unavailable

06 Unhealthy SV (as follows from operational (=ephemeris) SV health)

07 Time-Frequency parameters from the ephemeris data set may be wrong?

08 Initial conditions (position and velocity vectors) from the ephemeris data
set may be wrong?

09 Almanac SV health indicator unavailable for this satellite®

10 Unhealthy SV [as follows from the almanac SV health indicator]?

11 “Alert” flag (from the word “HOW?”) is set?

12 URA indicates the absence of accuracy prediction for this SvP

13 User excluded this SV from position computation

14 User excluded this SV with this frequency channel number from position
computation®

15 This SV is excluded from solution since its system number is unknown®

16 This SV has an elevation lower than the specified mask angle

17 Reserved

P/N 31-000004-01 E-1




Satellite Navigation Status Codes

Table E-1. Satellite Navigation Status Structure (Continued)

Code Description

18 Ephemeris data is too old

19 This SV does not belong to the constellation the user has selected

20 Differential data from Base Station unavailable for given satellite

(applicable only when receiver runs in DGPS)

21 Reserved

22 RAIM has detected wrong measurements

23 SNR below specified minimum level

24,25 |Reserved

26 DLL not settled

27 Ionospheric corrections are not received from Base Station

28 Coarse code outlier has been detected

29 Reserved

30 SV is not used in RTK processing (similar to code 20 but is used
specifically for RTK)

31 The same as 30

32-50 |Reserved
51 C/A slot used in RTK processing

52 P L1 slot used in RTK processing
53 P L2 slot used in RTK processing

54 P L1 & P L2 measurements used in RTK processing

55 C/A & P L2 measurements used in RTK processing

56-62 | Reserved

63 Satellite navigation status is undefined

a. GLONASS only
b. GPS only

Codes 0-3 and 45-62 will show for the given
satellite which raw data measurements have been
used in position computation. The rest codes will
indicate why this satellite has been excluded from
position computation.

[WARNING )
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